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Part 1: Using the Trunked 
Programming Application
This part describes the basic operation of the Trunked Programming 
Application.

Topics

� Getting Started

� The Application Interface

� Trunked Programming Application Basics

� Programming Sequence

� Specifications Form
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Getting Started

This application provides an easy way of changing settings 
and features of Tait Orca portable radios using a standard 
IBM-compatible PC. 

This manual is intended as an installation guide and reference 
for the Trunked Programming Application. It provides the 
following information:

� installation instructions and hardware setup

� an overview of the Trunked Programming Application

� reference guide to all parameters and settings

Minimum System Requirements
The application requires the following minimum configura-
tion:

� an IBM compatible PC with an 80486 microprocessor 
(or better)

� Windows® 95, Windows 98, Windows 2000 or Win-
dows NT® 4

� 16 MB of RAM

� a VGA colour graphics display

� a hard disk drive with 8 MB of free space (20 MB Rec-
ommended)

� CD-ROM drive

� a printer (if you intend to keep a hard copy of data)

� a Microsoft or compatible mouse and driver (if you wish 
to use the program with a mouse)

Equipment Supplied
� application CD-ROM

� radio programming lead with an RJ-11 telephone-style 
socket at one end and an accessory connector at the other 
(TOPA-SV-007)

� radio programming cable with a 9-pin or 25-pin serial 
connector at one end and an RJ-11 telephone-style plug 
at the other

Application Installation
To install the application:

1. Insert the CD-ROM into your CD drive.

2. If the autorun does not automatically start, double-click 
on My Computer.
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3. Double-click on the CD-ROM drive to view the CD’s 
contents.

4. Double-click on the file setup.exe.

The installation program will guide you through the installa-
tion process. Read the information presented on the screen 
carefully.

Connecting a Radio to the PC
To connect the radio to the PC:

1. Connect the programming cable to the programming 
lead.

2. Connect the accessory connector to the radio.

3. Connect the serial connector to the computer’s serial 
port.

Plug the serial connector into one of the COM ports. You 
can specify the COM port the application uses to communi-
cate with the radio using the File>Preferences command.

Once connected, the radio must be switched on before it can 
be programmed. To ensure the radio does not switch itself 
off during the session, use a fully-charged battery or a DC 
service adaptor (TOPA-SV-005).

If your serial connector is 25-pin and 
your computer has a 9-pin serial port, 
you will need an adaptor cable. This is 
available from your PC dealer. 
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Trunked Programming Application Basics

When you first start the Trunked Programming Application, 
the main window appears showing:

� Menus: A series of menus along the top of the window. 
See “Menu Commands” on page 15.

� Toolbar: A toolbar with a series of buttons. See “The 
Toolbar” on page 21.

� Forms tree: A list of forms. See “The Forms Tree” on 
page 21.

Before changing any radio settings you can:

� read a radio or

� open a radio programming database that has been saved 
to disk or

� create a new radio programming database file

Press the F1 key for context-sensitive help.

Reading a Radio
To read a radio, the radio must first be connected to the PC. 
Once the radio is connected:
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� select Radio>Read or

� select the Read button from the tool bar

As the programming database is read from the radio, the 
application indicates the radio type and tier, and the database, 
hardware and software version numbers. If you get an error 
indicating that the correct COM port is not selected, you can 
change the COM port by selecting the File>Preferences 
command. 

Once the radio’s programming database has been read, you 
can begin changing data. Click on the name of a form in the 
forms tree. See “The Forms Tree” on page 21 for more 
information.

Opening a Radio Programming 
Database
To open a radio programming database file saved to disk:

� select File>Open or

� select the Open button from the tool bar

Once the data has been loaded, you can begin changing data. 
Click on the name of a form in the forms tree. See “The 
Forms Tree” on page 21 for more information.

Creating a New Database
To create a new database when you first launch the applica-
tion, start changing the default data in the various forms. See 
“The Forms Tree” on page 21 for more information.

To begin a new database from an existing database, select 
File>New.
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The Application Interface

The application interface consists of:

� Menus: A series of menus along the top of the window. 
See “Menu Commands” on page 15.

� Toolbar: A series of buttons. See “The Toolbar” on page 
21.

� Forms tree: A list of forms. See “The Forms Tree” on 
page 21.

Menu Commands
The bar along the top of the main window shows the follow-
ing menus:

� File

� Radio

� Networks

� Tools

� Internet

� Help

Keyboard: Select a menu by pressing the Alt key, then the 
first letter of the menu’s name. Use the up and down arrow 
keys to scroll through the list of commands, and press the 
Enter key to select a command. Select another menu using 
the left and right arrow keys. Press the Esc key to close a 
menu; the menu bar remains selected. Press the Esc key again 
to return to the main window.

Mouse: Select a menu by clicking on it, then clicking on the 
required command.

File Menu
The commands available from the File menu are: 

� New

� Open

� Open (Append)

� Save Current Network

� Save All Networks

� Printer Settings

� Print

� Change Access Level

� Preferences

� Exit



16 The Application Interface   © Copyright Tait Electronics Ltd, 2004

New
Selecting the File>New command loads the application’s 
default data. Warning: default data should not be pro-
grammed to a radio.

Open
Selecting the File>Open command opens an existing file.

If a file was saved with comments, the comments will be dis-
played in the Comments window and the radio information 
will be displayed in the Radio Information window.

Open (Append)
Selecting the File>Open (Append) command opens an exist-
ing programming database file as an additional network. For 
example, if the programming application has two networks 
loaded, the new programming database will be added in as 
Network 3.

Save Current Network
Selecting the File>Save Current Network command opens 
the Save file window and saves the currently selected net-
work. 

If the programming application contains information for 
more than one network, then the File>Save Current Net-
work command will only save the programming database for 
the currently selected network. If you wish to save additional 
networks as individual files, you will need to switch to the 
required network and select File>Save Current Network 
again. However, if you wish to save all networks as one file, 
use the File>Save All Networks command.

Any comments you enter in the Comments window will be 
saved with the file, together with the information displayed 
in the Radio Information window.

Save All Networks
Selecting the File>Save All Networks command opens the 
Save file window and saves all networks in a single file. 

If you wish to save additional networks as individual files, 
you will need to switch to the required network and select 
the File>Save Current Network command. 

Any comments you enter in the Comments window will be 
saved with the file, together with the information displayed 
in the Radio Information window.

Printer Settings
Selecting the File>Printer Settings command opens the Print 
Setup dialog in which you can select the printer you wish to 
print to.
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Print
Selecting the File>Print command opens the Print Selections 
window. You can then select one or more forms using the > 
button (select highlighted form) or >> button (select all 
forms), and print data in those forms using the Print button.

If you wish to print data from the current form only, you can 
select the Print button at the bottom of that form.

Change Access Level
Selecting the File>Change Access Level command allows 
you to change to a different access level.

Preferences
Selecting the File>Preferences command opens the Prefer-
ences form. The options are:

� Select Application Language

� Communication Port

� WWW Addresses

Select the Advanced button to change Advanced Options, 
which are:

� Startup Mode

� Prompt to warn about losing data on read/write

� Highlight factory only fields as they become editable

Select Application Language
Select the language the application will be displayed in. 
Changing the application language will cause the default data 
file to be loaded, so ensure you save any data files before 
changing languages.

Communication Port
Select the port used for communicating with radios.

WWW Addresses
If you wish to change the URL used when the options in the 
Internet menu are selected, enter the new information in the 
appropriate WWW Address field.

� Tait World Address: The address used when the Inter-
net>TaitWorld command is selected

� Tait Support Address: The address used when the Inter-
net>Tait Support command is selected

� Tait Application Upgrade Address: The address used 
when the Internet>Tait Update command is selected

Startup Mode
The Startup Mode options determine whether the applica-
tion starts up in Customer or Factory mode. 

access level

The access level determines the fields 
and forms within the Trunked Pro-
gramming Application that are edit-
able. The access level depends on the 
password entered, where the lowest 
access level requires no password.
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If you wish to be prompted to run in Factory mode when 
you launch the application, tick the box. If not, untick the 
box and select a Default Startup Mode. There are three 
options:

� Save On Exit: The application starts in the mode in 
which it was last running.

� Customer: The application will always start in Customer 
mode.

� Factory: The application will always start in Factory 
mode. Note that a DBYXY Security Key must be 
attached to the PC’s Parallel Port to run the application 
in factory mode.

Prompt to warn about losing data on read/write
When this option is ticked, the application will warn you 
when:

� the Radio>Read command has been selected and the 
application’s current data will be overwritten

� the Radio>Program command has been selected and a 
radio’s programming database is about to be overwritten.

If you do not wish to be warned upon selecting these com-
mands, untick this box.

Highlight factory only fields as they become 
editable
When this option is ticked, factory only fields that can be 
edited will be displayed as white text on a black background.

Exit
Selecting the File>Exit command exits the application. You 
will be asked to confirm your decision.

Radio Menu
The commands available from the Read menu are:

� Read

� Program

Read
Selecting the Radio>Read command reads the radio’s pro-
gramming database and loads the relevant information into 
the application’s forms. If there are errors in the program-
ming database, the application will display a log of those 
errors, including the actions taken to correct the information.

Program
Selecting the Radio>Program command programs the 
radio’s programming database with the settings in the appli-
cation’s forms. 
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Networks Menu
The commands available from the Networks menu are:

� Add Network

� Delete Current Network

� Next Network

� Previous Network

For more information, see “Working with Multiple Net-
works” on page 25.

Add Network
Selecting the Networks>Add Network command adds a 
new network containing separate network, fleet and radio 
information.

You can also add a network saved as a file on disk by selecting 
the File>Open (Append) command.

Delete Current Network
Selecting the Networks>Delete Current Network com-
mand deletes the currently selected network.

Next Network
Selecting the Networks>Next Network command switches 
to the next network. If the network displayed is the last 
defined network, then selecting this command will switch to 
the first network.

Previous Network
Selecting the Networks>Previous Network command 
switches to the previous network. If the network displayed is 
the first defined network, then selecting this command will 
switch to the last network.

Tools Menu
Selecting another Tait application from the Tools menu 
launches the application. If the application cannot be found, 
you will be prompted to locate the executable (*.exe) file. If 
you browse for and select a new executable file, the path for 
that application will be updated and the application will be 
launched. Next time you select that application from the 
Tools menu the new path for the executable file will be used.

The other option in the Tools menu is Radio Messages. 
Selecting the Radio Messages command opens the Radio 
Messages form. In the Radio Messages form, you can change 
the display messages that the radio is programmed with. You 
must enter a password before you can change messages. If 
you do not have a password, contact your local Tait office.

Select the language for which you wish to change messages. 
The Description field tells you where the Radio Message is 
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used. Each message is restricted in length; you cannot enter 
more characters than permitted for a message.

Select the OK button to save the changed radio messages and 
exit the form or the Cancel button to discard changes and 
exit the form. Selecting the Restore Original Radio Mes-
sages button changes all radio messages to their default values.

Internet Menu
The commands available from the Internet menu are:

� TaitWorld

� Tait Support

� Tait Update

TaitWorld
Selecting the Internet>TaitWorld command launches your 
default browser and loads the TaitWorld web page. Enter the 
address used in the Preferences form (File>Preferences).

Tait Support
Selecting the Internet>Tait Support command launches 
your default browser and loads the Tait support request web 
page. Enter the address used in the Preferences form 
(File>Preferences).

Tait Update
Selecting the Internet>Tait Update command launches your 
default browser and loads the Tait technical issues web page. 
Enter the address used in the Preferences form (File>Prefer-
ences).

If you do not have a Username and Password, contact your 
local Tait office.

Help Menu
The commands available from the Help menu are:

� Contents

� Search For Help On... 

� About

For context-sensitive help, press the F1 key.

Contents
Selecting the Help>Contents command launches the online 
help, open at the Contents tab.

Search For Help On...
Selecting the Help>Search For Help On... command 
launches the online help, open at the Search tab.



© Copyright Tait Electronics Ltd, 2004  The Application Interface 21

About
Selecting the Help>About command displays information 
about the application.

The Toolbar
The toolbar commands are as follows.

The Forms Tree
The forms tree on the lefthand side of the main window lists 
the forms available. 

Keyboard: Scroll through the forms using the up and down 
arrow keys. Press the Enter key or the spacebar to open the 
form. 

Mouse: Click on the name of a form to open it and begin 
changing data.

The buttons along the bottom of each form are as follows.

� OK: Saves the form data and exits the form. Pressing the 
Esc key or Alt-O also saves data and exits the form.

� Cancel: Discards any changes made and exits the form. 
Pressing Alt-C also discards changes and exits the form.

� Print: Sends data from the current form directly to the  
printer selected in Printer Settings. Pressing Alt-P also 
prints current data. If you wish to print data in other 
forms, select File>Print.

� Help: Displays online help for the form. Pressing F1 or 
Alt-H also displays online help for the form.

Opens an 
existing radio 
programming 
database file
Equivalent to the 
File>Open 
command

Prints current data
You can select the 
forms you wish to 
print data for
Equivalent to the 
File>Print 
command

Adds a new 
network
Equivalent to the 
Networks>Add 
Network  
command

Programs a radio 
with the settings 
in the 
application’s 
forms
Equivalent to the 
Radio>Program 
command

Saves the current file
If the file has not 
previously been 
saved, the 
application uses the 
radio’s serial number 
to suggest a file 
name
Equivalent to the 
File>Save command

Reads a radio’s 
programming 
database and loads 
the relevant 
information into 
the application’s 
forms
Equivalent to the 
Radio>Read 
command

Allows you to change 
to a different 
access level 
Equivalent to the 
File>Change Access 
Level command.

Deletes the currently 
selected network
Equivalent to the 
Networks>Delete 
Current Network  
command

Switches to the 
previous network
Equivalent to the 
Networks>Previous 
Network  command

Switches to the 
next network
Equivalent to the 
Networks>Next 
Network  
command
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Changing Data
If a field’s data is greyed out, then that data is displayed for 
information only and cannot be changed. If a field name is 
greyed out, then that option is not available for the radio 
being programmed. For information on a field that is greyed 
out, select the Help button at the bottom of the screen, then 
select the name of the field you want information on.

Keyboard: Use the Tab key to move between fields.

Mouse: Click on a field.

How you change the data for each field depends on how that 
data is displayed. There are three options:

� text box

� combo box

� tick box

Where a range of possible numeric values is available for a 
field, then that range is shown in the bottom righthand cor-
ner of the form. 

Text Box
A text box is used for numeric and alphanumeric data.

Keyboard: Select a text box using the Tab key. Enter the 
required data.

Mouse: Select a text box by clicking on it with the mouse. 
Enter the required data.

Combo Box
A combo box is used for fields that have a range of possible 
values and appears as a box with an arrow at the righthand 
side.

Keyboard: Select a combo box using the Tab key. You can 
then display the options available by pressing the Alt key and 
the down arrow key at the same time. Use the up and down 
arrow keys to scroll through the options until the required 
value is displayed, then press the Enter key. 
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Mouse: Select a combo box by clicking on it, which displays 
the list of values. Select the required value from the combo 
box.

Tick Box
A tick box is used for fields that are either enabled or disa-
bled. If the box is ticked, the field is enabled; if the box is 
blank the field is disabled.

Keyboard: Select a tick box using the Tab key. Use the 
spacebar to enable and disable the field.

Mouse: Select a text box and change its value by clicking on 
it with the mouse.

When the field is selected, a dashed box appears next to the 
tick box.

Using Arrays
An array is used where many lines of data are required, each 
containing the same type of information. The data in an array 
is displayed in text boxes and combo boxes. Combo boxes in 
an array appear to be text boxes until they are selected, when 
an arrow appears on the righthand side.

Forms that contain arrays also contain additional buttons:

� Add: Adds a new row enabling data entry. Pressing F2 
also adds a new row.

� Repeat: Duplicates the data from the selected row, giving 
it a new name.

� Delete: Removes the currently selected row of data. 
Pressing F3 also deletes the selected row.

Keyboard: Select the different fields in an array using the Tab 
key or the right and left arrow keys. Pressing the up or down 
arrow keys moves up or down a row of data.

Mouse: Click on the required field.
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Programming Sequence

When programming Tait Orca trunked radios, you will find 
that possible entries and availability of certain features some-
times depends upon settings in other forms. The order in 
which form data is entered is, therefore, important.

The recommended order for changing radio settings is:

� network settings, then

� fleet settings, then

� radio unit settings

Access to some programming information is restricted by the 
access level. You can change the access level using the 
File>Change Access Level command.

In many cases, you will be supplied with a file that contains 
the correct network and/or fleet settings and so will need to 
change settings only for the particular radio being pro-
grammed. The supplied file can be loaded using the 
File>Open command.

Network Settings
Although few users will need to alter network information, 
it should be changed first. Network forms are:

� Trunked Channel Blocks

� Network Identity

� Network Parameters

� Hunting Parameters

Once the network information is correct or a suitable net-
work file has been loaded from disk, fleet settings should be 
changed.

Fleet Settings
Fleet forms are:

� Fleet Identity

� Fleet Parameters

� Conventional Channels

� DTMF Parameters

Once this information is correct or a suitable file has been 
loaded from disk, unit settings should be changed.

A file that contains suitable fleet settings will also contain the 
correct network settings.

access level

The access level determines the fields 
and forms within the Trunked Pro-
gramming Application that are edit-
able. The access level depends on the 
password entered, where the lowest 
access level requires no password.

network

A network is a number of intercon-
nected trunking systems. 

fleet

Each customer on a trunked network 
is assigned their own fleet. This keeps 
each customer unique so that their 
activities can be monitored and con-
trolled separately from each other. 
Each radio unit on the network 
belongs to their associated customer’s 
fleet. 



© Copyright Tait Electronics Ltd, 2004  Programming Sequence 25

Radio Settings
Forms that contain information specific to a radio unit are:

� Radio Identity

� Acquisition Data

� Preset Calls

� Lookup Table for 5 Digit Interfleet Calls

� Call Options

� Key Settings

� User Selectable Parameters

Working with Multiple Networks
Tait Orca radios can be programmed with one to four net-
work identities, depending on the model and firmware ver-
sion. This allows the radio user to access different networks, 
belong to different fleets or belong to fleets with different 
prefixes.

Programming a radio to operate on additional networks 
involves programming the radio with additional program-
ming databases. Note that when additional programming 
databases are loaded, the information in the first database 
defines common radio items. These common radio items are:

� the Radio Model Information, Radio Serial Number, 
User Security PIN, Radio Message Language and ESN 
fields in the Specifications form

� all fields in the User Defined Menu form

Each network is given a name that is displayed when the 
radio powers up (User Selectable Parameters form, Network 
Information field). In each form, the number and name of 
the currently selected network is displayed in the lower 
righthand corner:

In this example, TAITNET is the name that has been pro-
grammed for Network 2 in the Network Name field.

Use the commands in the Networks menu to:

� add additional networks

� delete the currently selected network

� switch to the next or previous network

Additional networks can also be added by using the 
File>Open (Append) command.

When the File>Save Current Network command is selected, 
it is important to remember that only the information in the 
currently selected network is saved. If you wish to save each 
network in a separate file, you will need to:

prefix

In MPT 1327, radios are identified 
by a three-digit prefix and a four-digit 
ident. Radio units in a fleet usually 
have the same prefix. 

programming database

The programming database is the 
information that is altered using the 
Trunked Programming Application. 
Each programming database consists 
of separate network, fleet and radio 
information. When the Radio>Read 
command is selected, the radio’s pro-
gramming database is read and the 
information in it is loaded into the 
fields and forms in the programming 
application. When the Radio>Pro-
gram command is selected, the radio’s 
programming database is overwritten 
with the information altered in the 
programming application. 
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� switch to the network you wish to save and

� select the File>Save Current Network command

These steps will need to be repeated for each network you 
wish to save. If you wish to save all networks in a single file, 
select the File>Save All Networks command.
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Specifications Form

The Specifications form shows basic radio information such 
as the radio model and the frequency band. You can also set 
various radio interface options in this form, including the 
security PIN and the radio message language. The Specifica-
tions form is shown below.

Radio Model Information
The radio model information fields show the radio product 
code and information contained in the product code (e.g. 
TOP-H2220) that is particularly relevant to radio program-
ming.

You cannot directly modify the Product Code field. How-
ever, if you change Band and/or Model, Product Code is 
updated to reflect the new values. Fields that are not relevant 
to the different Band and/or Model are automatically set to 
their default values.

You may wish to read data from a radio of a different type 
and use the settings as a template for programming radios of 

frequency band

model (Orca Elan/Excel/5030/5035/5040)

radio variant (conventional/trunked)

bandwidth (universal/wide)

TOP-H2220
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another variant. If so, change the values of Band and/or 
Model after loading the template file but before changing any 
other radio settings.

Product Code
The Product Code field is automatically read from the radio’s 
memory and shows the radio’s model number, which you 
can find on the back of the radio. However, if the radio has 
been upgraded, the model number on the back of the radio 
will not match that read from the radio.

Band
The Band field sets the frequency band the radio operates at 
and is indicated by the fourth position (first after the hyphen) 
in the Product Code number.

This letter indicates the frequency band as outlined in the 
table on the right. 

The Band field must be set correctly in order to validate 
channel settings, and changing the value of Band will:

� amend the Product Code field to reflect the different fre-
quency band

� set the values of Start Rx and Tx (Trunked Channels 
Block form) and the Receive and Transmit Frequencies 
(Conventional Channels form) to 0, as any frequency val-
ues previously entered are invalid for the new Band

Model
The Model field indicates the radio model, which is indi-
cated by the sixth position (third after the hyphen) of the 
product code.

1 = Orca Elan

2 = Orca Excel

4 = Orca 5030

5 = Orca 5035

6 = Orca 5040

The Model field must be set correctly as not all programma-
ble features are available for all radio models. Changing the 
value of Model will:

Note: Contact your local Tait 
office for information on the 
availability of different frequency 
bands.

Band Frequency Range

A 66-88 MHz

B 136-174 MHz

C 174-225 MHz

D 220-270 MHz

E 270-310 MHz

F 290-340 MHz

G 336-400 MHz

H 400-470 MHz

I 450-530 MHz

J 806-870 MHz

K 896-941 MHz

frequency band

TOP-H2220

radio model

TOP-H2220
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� amend the Product Code field to reflect the different 
model

� make selectable fields relevant to the new Model that 
were greyed out for the previous Model

� grey-out fields not relevant to the new Model

Radio Serial Number
The Radio Serial Number is automatically read from the 
radio’s memory. It is used for identification only and so the 
data in the field is greyed out. The Radio Serial Number has 
no effect on the normal operation of the radio.

Radio Message Language
The Radio Message Language field does not apply to Orca 
Elan and Orca 5030 radios.

The Radio Message Language field sets the language radio 
messages appear in. Select from the languages listed.

User Security PIN
The User Security PIN field does not apply to Orca Elan, 
Orca 5030 and Orca 5035 radios.

User Security PIN sets the PIN number the user is required 
to enter during the power-up sequence. Enter a number up 
to five digits long, or NONE if no PIN number is required.

Manufacturer’s Code
The Manufacturer’s Code is part of the radio’s electronic 
serial number (ESN) and is automatically read from the radio.

You cannot change the value of this field.

Model Code
The Model Code is part of the radio’s electronic serial 
number (ESN) and is automatically read from the radio.

You cannot change the value of this field.

ESN
The ESN is part of the radio’s electronic serial number (ESN) 
and is automatically read from the radio.

You cannot change the value of this field.

security PIN

A security PIN (personal identifica-
tion number) is a number up to five 
digits long the user is required to enter 
when the radio first powers up. When 
a security PIN is required, the radio 
displays the message ENTER 
CODE and then waits for the correct 
PIN to be entered before displaying 
the power-up message.The radio can-
not be used until the correct PIN has 
been entered.
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Part 2: Changing Network 
Settings
This part contains detailed information on changing network settings.

For access to these forms, you will require high-level password access.

Forms

� Trunked Channel Blocks Form

� Network Identity Form

� Network Parameters Form

� Hunting Parameters Form
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Trunked Channel Blocks Form

Trunked channel blocks specify the operating fre-
quencies of all channels on a network. The trunked channel 
blocks are set up in the Trunked Channel Blocks form, 
which is divided into two tabs: General Tab and Subaudible 
Tab.

NOTE: Information in this form cannot be altered unless you 
have high-level password access.

General Tab
Set operating frequencies for all channel blocks on the net-
work.

The General tab is shown below:

Add and Delete Channel Blocks 
Up to 20 channel blocks can be defined in the Trunked 
Channel Blocked form. 

To add a new block, click the Add button or press the F2 
key.

To delete the currently selected block, click the Delete but-
ton or press the F3 key. 

NOTE: At least one channel block must be defined (the last 
remaining channel block cannot be deleted).
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Channel Start and Stop
The Channel Start field sets the first number of each trunked 
channel block, and the Channel Stop field sets the last chan-
nel.

Enter a value from 1 to 1023 for Channel Start, and a value 
greater than or equal to the Channel Start value for Channel 
Stop. Channel Stop cannot be set higher than 1023.

If more than one block is defined, the Channel Start value for 
all subsequent blocks must be at least one greater than the 
Channel Stop value for the previous block.

Your network operator will tell you what values to set.

Channel Spacing
The Channel Spacing field sets the channel spacing (in kHz) 
for all channels in the trunked channel block, and is the value 
that will be used to calculate receive and transmit frequencies 
from the values of the Start Rx and Start Tx fields.

Enter the value assigned by your network operator, which 
will be a multiple of one of the following frequencies:

� 5 kHz

� 6.25 kHz.

� 7.5 kHz (if the Tx Deviation is set to Narrow, and Start 
RX is between 150 MHz and 174 MHz).

Different blocks can have different channel spacing values.

Start Rx and Tx
The Start Rx and Tx fields set the receive (Rx) frequency 
and transmit (Tx) frequency for the first channel in the 
trunked channel block. The receive and transmit frequencies 
for all other channels in the block will be calculated from 
these values using the value of the Channel Spacing field.

For both fields, enter the values assigned by your network 
operator, which will be a multiple of either 5 kHz or 6.25 
kHz, and will be within the radio’s frequency band.

The first channel in a block always has the lowest frequency, 
and the frequency range for a block cannot overlap with any 
other block’s frequencies.

Tx Deviation
The Tx Deviation field sets the transmitter deviation for the 
trunked channel block. 

The Deviation field can be set to:

� Narrow: Maximum deviation 2.5 kHz

� Medium: Maximum deviation 4 kHz

� Wide: Maximum deviation 5 kHz

channel spacing

Channel spacing is the interval 
between channels. For Tait Orca 
radios, this is 12.5, 20 or 25 kHz. 
Wide Band radios can be programmed 
for operation on 20 and 25 kHz 
channels only. Universal Band radios 
can be programmed for operation on 
12.5, 20 and 25 kHz channels. 
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Set Tx Deviation according to the system Channel Spacing. 
The channel spacing is indicated in the product code (in the 
fifth position, second after the hyphen). Alternatively, refer 
to the  Specifications form or the back of the radio.

The channel spacing is as follows:

� 1 (Wide Band): The radio can be programmed for oper-
ation on 20 and 25 kHz channels (select a Tx Deviation 
of Wide or Medium).

� 2 (Universal Band): The radio can be programmed for 
operation on 12.5, 20 and 25 kHz channels (select a Tx 
Deviation of Narrow, Medium or Wide).

Power Level
The Power Level field sets the transmit power level for the 
trunked channel block. 

Using the drop-down menu, select a power level setting 
within the limits permitted for the region in which the radio 
operates: 

� Off (O): When set to off, the radio cannot transmit on 
that channel.

� Low (L): 1 watt VHF, UHF, 800/900 MHz

� Medium (M): 2.5 watts VHF, UHF, 2 watts 800/900 
MHz

� High (H): 5 watts VHF, 4 watts UHF, 3 watts 800/900 
MHz

The transmit power can be temporarily reduced by use of the 
low power transmit feature and dynamic power control, 
which conserves battery life.

See “Function Key Option: Low Power” on page 101,  
“Menu Option: LOW PWR” on page 93, “Function Key 
Option: Dynamic Power Control” on page 100 and “Menu 
Option: DYN PWR” on page 94 for more information.

low power transmit

The low power transmit feature can be 
used to change the transmit power 
from the programmed level to low. 

dynamic power control

Dynamic power control optimises the 
radio’s power use by reducing the 
transmit power in high signal strength 
areas. 
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Subaudible Tab
Set the CTCSS Rx and CTCSS Tx frequencies. The tab also 
contains the operating frequencies that have been set up for 
each channel block on the General Tab. 

The Subaudible tab is shown below:

CTCSS Rx and CTCSS Tx
The CTCSS Rx field sets the subaudible signalling that the 
radio must receive on the traffic channel before the activity 
is regarded as valid and the mute is opened. 

The CTCSS Tx field sets the subaudible signalling that 
accompanies each transmission made on the traffic channel. 

For both fields, select the required CTCSS frequency using 
the drop-down menu. 

The subaudible frequency will only be used on a traffic chan-
nel.

NOTE: Leave CTCSS RX and TX fields set to NONE if no 
subaudible signalling is used on the traffic channel.
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Network Identity Form

The fields in the Network Identity form set properties of the 
network the radio will operate on. Appropriate values for the 
fields in this form will be assigned by the network operator. 
The Network Identity form is shown below.

Information in this form cannot be altered unless you have 
high-level password access.

Network Type and Identity
Together the Network Type and Network Identity Code 
determine whether a control channel is considered an ade-
quate candidate for acquisition. If the relevant bits decoded 
from the control channel do not correspond to the values 
programmed for the radio, the radio will not consider that 
control channel a candidate.

The Network Type field sets the network type, which can 
be either National or Regional. Consult your network oper-
ator for the correct setting.

The network identity codes set in the array are dependent on 
the Network Type:

� National: Enter a code from 0 to 3.

� Regional: Enter a code from 0 to 127.

Enter the value assigned by your network operator. 

Select the Add button or press the F2 key to add a new iden-
tity code, or select the Delete button or press the F3 key to 
delete the currently selected identity code.

control channel

In a trunking system, the control 
channel is used by the site to let the 
radio units in the site’s coverage area 
know when they can transmit their 
call information. 

acquisition

When a radio has successfully 
acquired a control channel, it is per-
mitted to transmit and receive on that 
channel. The radio will listen to the 
control channel until it is directed to a 
traffic channel to participate in a call. 
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SYNC Sequence
The SYNC Sequence field sets the codeword synchronisa-
tion sequence (SYNC) for messages transmitted on the con-
trol channel.

Enter the SYNC sequence code assigned by your network 
operator, which will be in hexadecimal format.

� MPT 1327 and Regionet 43 define SYNC as C4D7.

� PAA2424 defines SYNC as B433.

Area Field Length (LA)
The Area Field Length (LA) field sets the value of LA, which 
is used in a test carried out by the radio to see if it can acquire 
a control channel.

Enter the value assigned by your network operator, which 
will depend on the value of the Network Type field. For 
MPT 1327:

� National: Enter a value from 0 to 9.

� Regional: Enter a value from 0 to 4.

Zone Field Length (LZ)
The Zone Field Length (LZ) field sets the value of LZ, which 
is used in a test carried out by the radio to see if it can acquire 
a control channel.

Enter the value assigned by your network operator, which 
will depend on the value of the Network Type field. For 
MPT 1327:

� National: Enter a value from 0 to 9.

� Regional: Enter a value from 0 to 4.

SIL Field Length (LSIL)
The SIL Field Length (LSIL) field sets the value of LSIL, 
which is used in a test carried out by the radio to check 
whether the clear down received is from the correct trunking 
system controller. 

Enter the value assigned by your network operator.

Number of Pressel On/Off Messages
While a speech call is in progress, a radio will send pressel on 
messages (NPON) when the PTT is pressed and pressel off 
messages when the PTT is released. These messages assist call 
maintenance.

The Number of Pressel On Messages (NPON) and Number 
of Pressel Off Messages (NPOFF) fields set how many of 
these pressel messages will be sent. Enter the value assigned 
by your network operator, which will be from 1 to 5.

codeword

Messages on a trunking system are 
transmitted as codewords. Every code-
word is 64 bits long and consists of 48 
bits of data and a 16-bit cyclical 
redundancy code (CRC), which is 
used for error checking. The codewords 
are sent over the control channel using 
fast frequency shift keying (FFSK), 
where a 1200 Hz tone represents dig-
ital one and an 1800 Hz tone repre-
sents digital zero. 

trunking system controller

In MPT 1327 the trunking system 
controller (TSC) is the central intelli-
gence necessary to enable the trunking 
system to function. The TSC com-
municates with all radios on the net-
work via the control channel. 
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Pre-Emphasis
For the Pre-Emphasis field, select French or Other. For 
PAA2424 networks, Pre-Emphasis should be set to French.

Multiple Registration
The Multiple Registration field determines whether the 
radio can register simultaneously on up to three control 
channels.

� Enabled: The radio can store up to three registration 
records and thereby be simultaneously registered on up to 
three control channels. It can then roam between those 
control channels and acquire any of them without re-reg-
istering. The oldest registration records expire and are 
deleted after a period TD following registration (Net-
work Parameters form). The most recent record is 
known as the Prime record and does not expire. The 
trunking system announces how many registration 
records (either 1, 2 or 3) a radio shall maintain, via the 
BCAST SYSDEF 3 message.

� Disabled: Only a single registration record is maintained 
and any previous registration record will be discarded 
when the radio registers on a control channel.

Value of INFO in RQR
The Value of INFO in RQR field sets the 15-bit value that 
is added to the INFO field when a radio requests registration. 

This is normally set to 0, but in some systems is customised 
to convey additional information to the trunking system 
controller.

Consult your network operator for the appropriate value.

registration

A radio unit must let the trunking 
system know its current location, espe-
cially if the radio unit roams through-
out the network. Knowledge of its 
location allows for an efficient call 
setup process when the radio unit is 
called. A radio unit will attempt to 
register if the area code of the new 
site’s system identity code is different 
to that of the previous site. 
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Network Parameters Form

The fields in the Network Parameters form set variables used 
in communicating with the trunking system control channel. 
They can be divided into three categories:

� Control Channel Acquisition/Retention Parameters

� Background Search Parameters

� Signalling Parameters

The Network Parameters form is shown below.

Information in this form cannot be altered unless you have 
high-level password access.

Control Channel Acquisition/
Retention Parameters
The fields listed under Control Channel Acquisition/Reten-
tion Parameters set parameters the radio uses when attempt-
ing to acquire and retain a control channel.

The same values of parameters NZ1, NZ2 and L1 apply to 
both continuous and time-shared channels. Parameter TS 
applies only to time-shared channels.

Different values of parameters NC1, NC2, NV, NX1 and 
NX2 can be set for continuous and time-shared channels.

Your network operator will tell you what value to set these 
fields to.

control channel

In a trunking system, the control 
channel is used by the site to let the 
radio units in the site’s coverage area 
know when they can transmit their 
call information. 
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NZ1 and NZ2
Parameters NZ1 and NZ2 are used for error checking. 

NZ1 is used for error checking during hunting and is the 
number of contiguous samples of NC1 codewords without a 
codeword sample error event that must be recorded before 
the control channel being sampled can be confirmed. 

NZ2 is used for error checking during continuous monitor-
ing of a confirmed control channel. Once an error has been 
detected, NZ2 is the number of further contiguous samples 
of NC2 codewords each with a codeword sample error event 
that must be recorded before the radio can reject the control 
channel on the grounds of unacceptable codeword error rate.

Each field should be set to a value from 1 to 255. 

TS
TS is the time that a radio will stay tuned to a control channel 
without receiving a valid control channel system codeword 
on that channel. If this time expires, the radio will attempt to 
acquire an alternative channel. Enter a value from 1 to 10 
seconds.

On a system employing time-shared control channels where 
the control channel is radiated in discontinuous bursts, TS 
must be set to a value high enough to make sure the control 
channel is not relinquished in the gaps between bursts.

L1
For L1, enter the value assigned by your network operator, 
which will be from 0 to 40 dB in steps of 1 dB.

NC and NX
The combination of parameters NC and NX set the error 
threshold at which the control channel performance is con-
sidered inadequate. Separate values of NC and NX are set for 
use during hunting (NC1 and NX1) and during continuous 
monitoring of a confirmed control channel (NC2 and NX2).

Parameters NC1 and NC2 are the number of contiguous 
positions in which codewords are expected that will be mon-
itored in each codeword.

Parameters NX1 and NX2 are the number of errored code-
words that must be exceeded in the count of the respective 
NC codewords before the sample of NC codewords is con-
sidered an error event.

� NC1, NC2: Set a value from 1 to 255 for both continu-
ous and time-shared channels.

� NX1: Set a value from 0 to the value of the correspond-
ing NC1 parameter for continuous and time-shared 
channels.
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� NX2: Set a value from 0 to the value of the correspond-
ing NC2 parameter for continuous and time-shared 
channels. 

NV
Parameter NV sets the number of consecutive CCSCs (code-
words) with the same value of SYS field that must be 
received before the radio will attempt to verify that value.

Enter a value from 1 to 16 for both continuous and time-
shared channels.

Background Search Parameters
The fields listed under Background Search Parameters set 
parameters the radio uses when carrying out a background 
search. The Background Search field (Hunting Parameters 
form) must be enabled for these parameters to have effect.

TL
Parameter TL sets the minimum interval between successive 
departures from the confirmed control channel. Set a value 
from 10 to 320 seconds in steps of 10 seconds.

If the value of TL is low and/or the value of TH is high, new 
control channels will be identified more rapidly; however, 
because the radio will spend less time listening to the con-
firmed control channel, it is more likely that important mes-
sages will be missed.

TH
Parameter TH sets the amount of time the radio spends sam-
pling other control channels. Set a value from 1 to 100 slots 
in steps of 1 slot.

If the value of TL is low and/or the value of TH is high, new 
control channels will be identified more rapidly; however, 
because the radio will spend less time listening to the con-
firmed control channel, it is more likely that important mes-
sages will be missed.

NS
Parameter NS sets the number of consecutive samples of a 
channel that must be taken before it is identified as a candi-
date for acquisition as a control channel. 

Set a value from 1 to 10 in steps of 1. 

The lower the value of NS, the fewer the samples that need 
to be taken and so the more rapidly a new control channel 
will be identified. However, the identification will be less 
accurate than if NS is set higher. Setting NS higher will mean 
that identifying a new control channel will take longer, but 

background search

A background search is carried out as 
part of the control channel acquisition 
procedure. The background search is a 
method prescribed in MPT 1343 for 
monitoring other control channels and 
migrating to a superior channel when 
one is found. The background search is 
performed by periodically leaving the 
current control channel and sampling 
other control channels. What channels 
are sampled is specified in the Normal 
Hunt Channels array (Hunting 
Parameters form). If a channel is con-
sistently found for a certain number of 
consecutive samples to be preferred 
(according to the NDD preference data 
defined in the Acquisition Data form) 
or stronger than the current control 
channel by a certain margin, the radio 
will perform a preferential hunt to 
acquire the new control channel.
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identification will be more accurate since the radio will tend 
to ignore temporary fading effects.

LM1, LM2, LM3 and LM4
Parameters LM1, LM2, LM3 and LM4 set level margins used 
during preferential hunts. These values are network depend-
ent.

� LM1 sets how much stronger the signal on a sampled 
control channel must be than the current control channel 
for it to be considered during a background search 
sequence when neither channel is preferred. 

� LM2 sets how much stronger the signal on a sampled 
control channel must be than the current control channel 
for it to be considered during a background search 
sequence when both channels have equal preference. 

For both LM1 and LM2, enter the value assigned by your 
network operator, which will be from 3 to 40 dB in steps of 
1 dB. Note that parameter LM2 is ignored during hunts 
when the Nokia TS Channel Support field (Hunting Param-
eters form) is enabled.

� LM3 sets how much stronger the signal on a sampled 
control channel must be than the squelch threshold (L0) 
for it to be considered during a background search 
sequence when the channel is not preferred at all.

� LM4 sets how much stronger the signal on a sampled 
control channel must be than the squelch threshold (L0) 
for it to be considered during a background search 
sequence when the sampled control channel is preferred 
over the current control channel.

For LM3 and LM4, enter the value assigned by your network 
operator, which will be from 0 to 40 dB in steps of 1 dB.

Selecting a lower value for LM1 and/or LM2 will ensure that 
the radio will always migrate to a better control channel, 
even if it is only slightly better, and thus ensure the best qual-
ity of speech during a call. However, it will also result in 
increased hunting activity, which will increase the chance of 
missing important calls and may load the trunking system 
unnecessarily with registration requests.

Selecting a higher value for LM1 and/or LM2 will ensure 
that the radio will only migrate to a new control channel if it 
is significantly better than the confirmed control channel. 
This will reduce the amount of control channel swapping 
which occurs and thus reduce the chance of missing impor-
tant calls and network loading, but it might mean that the 
radio provides a slightly reduced quality of speech during a 
call. Raising LM1 and/or LM2 too high will prevent the 
radio from swapping control channels entirely, as the signal 
strength measurements are most sensitive over a limited 
range.
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Selecting a lower value for LM3 will ensure that the radio 
will always migrate to a preferred control channel, even at 
the expense of speech during a call. However, it will also 
result in increased hunting activity which will increase the 
chance of missing important calls and may load the trunking 
system unnecessarily with registration requests.

Selecting a higher value of LM3 will ensure that the radio 
will only migrate to a preferred control channel if the speech 
quality is of some minimum standard. This will reduce the 
amount of control channel swapping that occurs and thus 
reduce the chance of missing important calls and network 
loading, but it might mean that the radio does not acquire a 
preferred control channel at the first opportunity. Raising 
LM3 too high will prevent the radio from swapping control 
channels entirely, as the signal strength measurements are 
most sensitive over a limited range.

Signalling Parameters
The fields listed under Signalling Parameters set various 
parameters used in communication with the control channel. 

NW
Parameter NW sets the response delay, in slots. Enter the 
value assigned by your network operator, which will be from 
1 to 15.

ND1
Parameter ND1 sets the number of disconnect messages sent 
by an individually called radio. Enter the value assigned by 
your network operator, which will be from 1 to 5.

ND2
Parameter ND2 sets the number of disconnect messages sent 
by a calling radio. Enter the value assigned by your network 
operator, which will be from 1 to 5.

NE
Parameter NE sets the maximum number of random access 
transmissions of RQE (emergency call request). Enter the 
value assigned by your network operator, which will be from 
1 to 255.

NR
Parameter NR sets the maximum number of random access 
transmission of RQS, RQD, RQX, RQT, RQR or RQQ 
(non-emergency call requests). Enter the value assigned by 
your network operator, which will be from 1 to 255.
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TC
Parameter TC sets the random access timeout. Enter the 
value assigned by your network operator, which will be from 
10 to 120 seconds in steps of 10 seconds.

TD
Parameter TD sets the registration record timeout used when 
Multiple Registration (Network Identity screen) is set to 
Enabled. Enter the value assigned by your network operator, 
which will be from 5 to 70 minutes in steps of 5 minutes.

TJ
Parameter TJ sets the further signalling timeout. Enter the 
value assigned by your network operator, which will be from 
10 to 60 seconds in steps of 10 seconds.

TN
Parameter TN sets the traffic channel inactivity timeout. 
Enter the value assigned by your network operator, which 
will be from 1 to 10 seconds in steps of 1 second.

TT
Parameter TT sets the maximum transmit duration. Enter 
the value assigned by your network operator, which will be 
from 10 to 60 seconds in steps of 10 seconds.

TA
Parameter TA sets the timeout for the radio after receiving 
an AHY. Enter the value assigned by your network operator, 
which will be from 1 to 255 seconds in steps of 1 second.

TB
Parameter TB sets the time barred from calling the same 
ident after ACK/ACKX/ACKV or any ident after a ACKT/
ACKB. Enter the value assigned by your network operator, 
which will be from 1 to 255 seconds in steps of 1 second.

TP
Parameter TP sets the maximum interval between periodic 
messages (within speech limits) to be assumed at switch-on. 
Enter the value assigned by your network operator, which 
will be from 1 to 255 seconds in steps of 1 second.

TW
Parameter TW sets the timeout for the radio waiting for a 
call. Enter the value assigned by your network operator, 
which will be from 1 to 255 seconds in steps of 1 second.

ident

The ident is the part of the radio’s 
address that uniquely identifies that 
radio. In MPT 1327, radios are 
identified by a three-digit prefix and a 
four-digit ident. All radios in a fleet 
usually have the same prefix, but no 
two radios should have the same ident.
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Hunting Parameters Form

The fields in the Hunting Parameters form relate to network 
hunts carried out by the radio. The Hunting Parameters form 
is shown below.

Information in this form cannot be altered unless you have 
high-level password access.

Nokia TS Channel Support
The Nokia TS Channel Support field sets whether the radio 
supports Nokia time-shared channels.

When Nokia TS Channel Support is enabled, standard MPT 
1343 hunting procedures are varied by recognising Nokia 
Actionet time-shared control channels and ignoring the pre-
set L2 signal level while performing background searches. 
Because the L2 signal level is ignored, a radio will always try 
to find a better control channel regardless of the signal 
strength of the current control channel. The radio no longer 
complies with MPT 1343.

Background Search
The background search sequence is a method prescribed in 
MPT 1343 for monitoring other control channels and 
migrating to a superior channel when one is found.

The search is performed by periodically leaving the current 
control channel and sampling other control channels. What 
channels are sampled is defined in the Normal Hunt Chan-
nels array. If a channel is consistently found for a certain 
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number of consecutive samples to be preferred (according to 
the NDD preference data defined in the Acquisition Data 
form) or stronger than the current control channel by a cer-
tain margin, the radio will perform a preferential sampled 
hunt to acquire the new control channel.

Enable the Background Search field to allow the radio to 
carry out background searches.

The interval at which the radio performs the search is defined 
by the parameter TL, and the amount of time the radio 
spends performing hunts is determined by the parameter TH. 
The number of samples taken of each candidate control 
channel during the background search is determined by the 
parameter NS. These parameters are set in the Network 
Parameters form, together with four other parameters related 
to background searches, LM1, LM2, LM3 and LM4. See 
page 42 for more information.

Hunt Upon Expiry of NE or NR
The Hunt Upon Expiry of NE or NR field determines the 
type of control channel hunt performed when an attempt to 
set up a call is unsuccessful (when NE or NR expire). There 
are three options.

� Normal: The radio will carry out a background search 
using the information in the Normal Hunt Channels 
array.

� Preferential: The radio will carry out a background search 
using the NDD preference data (Acquisition Data form).

� Disabled: No search will be performed. 

For the radio to be fully MPT 1343 compliant, you should 
disable Hunt Upon Expiry of NE or NR as MPT 1343 
requires that no hunt be performed and the radio wait for 
further signalling when a call attempt fails.

On some networks, selecting Normal or Preferential may 
improve the chances of successfully making the call on the 
next attempt.

Comprehensive Hunt
The Comprehensive Hunt field determines how the radio 
behaves when it fails to find a control channel. If Compre-
hensive Hunt is enabled, the radio will then search through 
all defined channels, except those specified as non-applicable 
in the Non Applicable Channels array.

Act On Vote Now
Enable Act On Vote Now to allow the radio to act on vote 
now BCAST codewords. The signal strength margin that the 
new control channel must exceed the old control channel by 

vote now

Vote now is carried out as part of the 
control channel acquisition procedure. 
Some trunking systems use a vote 
now BCAST codeword to help the 
radio find the best control channel. 
When the radio receives a vote now 
BCAST codeword, the radio will 
switch to the channel specified by the 
system and monitor its RSSI level. If 
the RSSI on the new channel is not 
greater than the current control chan-
nel by a particular value, the radio 
will return to the current control chan-
nel. Otherwise it will switch to the 
control channel specified by the trunk-
ing system. 
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for the radio to switch to the new control channel is set in 
the Vote Now Advice Margin field.

Vote Now Advice Margin
The Vote Now Advice Margin field sets the signal strength 
margin that the new channel must exceed the current control 
channel by for the radio to switch to the new control channel 
it has been directed to by a vote now BCAST codeword. 
The Act On Vote Now field must be enabled for the setting 
of Vote Now Advice Margin to have any effect.

Set a value from 1 to 15 dB in steps of 1 dB.

Control Category
The setting of the Control Category field determines the 
radio’s rights of access to a network’s control channels. 

A radio can only access a control channel when the radio’s 
Control Category corresponds to the value of the LAB field 
in the system identity code.

Select one of the categories: A, B, C or D.

Site Select
The Site Select feature is not available on Orca Elan and 
Orca 5030 radios.

Site Select allows a user to select a control channel the radio 
must then attempt to register on regardless of its suitability for 
acquisition.

There are two ways to operate the site select function.

On all radios that support site select, the site select function 
can be selected by the press of a function key. Assign a func-
tion key setting with the Site Select option (Key Settings 
form).

On Orca 5035 and Orca 5040 radios, the site select function 
can be selected from the user function menu. Tick the SITE 
SELECT option in the User Defined Menu form. 

Normal Hunt Channels
The Normal Hunt Channels array defines the channels that 
will be examined during a normal background search 
sequence to see if they can be acquired as a control channel. 

If the radio fails to find a suitable control channel among 
these channels, it will search through all channels if the Com-
prehensive Hunt field (Hunting Parameters form) is enabled.

The channels available to the radio are defined in the 
Trunked Channel Blocks form.

Up to 32 normal hunt channels can be defined. Select the 
Add button or press the F2 key to add a new channel, or 
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select the Delete button or press the F3 key to delete the cur-
rently selected channel. At least one channel must be defined, 
and so the last remaining channel cannot be deleted.

Two fields must be set for this array: Channel and Type.

Channel
For the Channel field, enter any channel number between 
the lowest and highest channel defined for the network. See 
your network operator for these values.

Type
For the Type field, select Continuous or Time-shared. See 
your network operator for the channel type, which will nor-
mally be Continuous.

Non Applicable Channels
The Non Applicable Channels array defines the upper and 
lower limits of the channel range that will not be included in 
comprehensive hunt sequences. Select the Add button or 
press the F2 key to add a new range of channels, or select the 
Delete button or press the F3 key to delete the currently 
selected range.

You can define up to ten channel ranges, where the field 
From defines the start of the range not included in the hunt 
and the field To defines the end of the range not included in 
the hunt. See your network operator for these values.

If Comprehensive Hunt (Hunting Parameters form) is disa-
bled or if you do not wish to limit the range of channels the 
radio will search, this list can be left blank. 

comprehensive hunt

A comprehensive hunt is carried out as 
part of the control channel acquisition 
procedure. When the control channel 
acquisition procedure has failed to 
identify a suitable control channel, the 
radio will then search through all 
channels in the trunked channel blocks 
defined for the radio, except those 
specified as non-applicable in the Non 
Applicable Channels array. 
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Part 3: Changing Fleet Settings
This part contains detailed information on changing fleet settings.

For access to these forms, you will require medium-level password 
access.

Forms

� Fleet Identity Form

� Fleet Parameters Form

� Conventional Channels Form

� DTMF Parameters Form
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Fleet Identity Form

The fields in the Fleet Identity form provide information 
about the fleet to which a radio unit belongs. These proper-
ties are generally common to call radios in a fleet. The Fleet 
Identity form is shown below.

Information in this form cannot be altered unless you have 
medium-level password access.

What fields are available depends on the level of password 
access and the Dialling Scheme selected. What Fleet Identity 
fields are applicable for the different dialling schemes is out-
lined in Table 1 on page 54.

Dialling Scheme
The Dialling Scheme field describes the dialled digit 
sequence categories used by the radio for interfleet and 
intrafleet calls. It is system-dependent and so should be used 
only with compatible trunking systems. Tait Orca radios sup-
port five options.

� MPT 1343: Suitable for all MPT 1343 networks.

� ZVEI: Suitable for Regionet 43 networks.

� Number Presets: Suitable for all MPT 1343 networks. 
However, dialling will be limited to the preset calls pro-
grammed for the radio (in the Preset Calls form).

� Nokia ANN: Suitable for all Nokia Actionet networks.
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� CPSX Dialling: Suitable for Chinese networks that utilise 
5-digit interfleet dialling. It is compatible only with other 
CPSX dialling trunking systems.

Consult your network operator for the appropriate Dialling 
Scheme.

Fleet Number Prefix
The Fleet Number Prefix field is not available if Dialling 
Scheme is Nokia ANN.

The Fleet Number Prefix field defines the network across 
which all fleets have been specified. The Fleet Number Pre-
fix is the same for all radios in a fleet.

Enter the value assigned by your network operator, which 
will be from 200 to 327.

Fleet Individual Number
The Fleet Individual Number field is not available if Dialling 
Scheme is Nokia ANN.

The Fleet Individual Number field defines the fleet number 
and must be common to all radios in a fleet. The Fleet Indi-
vidual Number is dependent on the Dialling Scheme.

Enter the value assigned by your network operator, which 
will be:

� MPT 1343, ZVEI, Number Presets: from 2001 to 6050

� CPSX Dialling: from 20 to 79, although not all numbers 
in this range will be valid. Whether a fleet number is valid 

Table 1: Fleet Identity form fields available for different dialling schemes

Field
MPT 
1343

ZVEI
Number 
Presets

Nokia 
ANN

CPSX 
Dialling

Fleet Number Prefix � � � ✗ �

Fleet Individual Number � � � ✗ �

Highest Individual Number in 
Fleet

� � � ✗ �

Fleet Group Number � � � ✗ ✗

Highest Group Number in Fleet � � � ✗ �

Prime Despatcher Number � � � � �

Prime Emergency Number � � � � �

ANN Numbering Model ✗ ✗ ✗ � ✗

Fleet Structure Definition ✗ ✗ ✗ � �
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depends on the parameters set in the Fleet Structure Def-
inition array.

Highest Individual Number in Fleet
The Highest Individual Number in Fleet field is not available 
if Dialling Scheme is Nokia ANN. If Dialling Scheme is 
CPSX Dialling, the Highest Individual Number in Fleet is 
calculated from the values of parameters Large, Medium and 
Small in the Fleet Structure Definition array, in which case 
the Highest Individual Number in Fleet field cannot be 
changed.

The Highest Individual Number in Fleet field defines the 
highest individual number that can be called by any unit 
within a fleet. 

Enter the value assigned by your network operator, which 
will be:

� MPT 1343, Number Presets: from 20 to 89 or 200 to 899

� ZVEI: from 20 to 79 or 200 to 799

Fleet Group Number
The Fleet Group Number field is not available if Dialling 
Scheme is Nokia ANN or CPSX Dialling.

The Fleet Group Number field is used with the group mem-
berships defined in the Group Membership array (Radio  
Identity form) to identify groups of radios in a network.

Enter the value assigned by your network operator, which 
will be from 2001 to 6050. If the user is not allowed group 
calls, enter 0.

Highest Group Number in Fleet
The Highest Group Number in Fleet field is not available if 
Dialling Scheme is Nokia ANN. If Dialling Scheme is CPSX 
Dialling, the Highest Group Number in Fleet is calculated 
from the values of parameters Large, Medium and Small in 
the Fleet Structure Definition array, in which case the High-
est Group Number in Fleet field cannot be changed.

The Highest Group Number in Fleet field defines the highest 
group number that can be called by any unit within a fleet.

If the value of Fleet Group Number is 0, then this field 
should also be set to 0.

Enter the value assigned by your network operator, which 
will be:

� MPT 1343, Number Presets: from 90 to 99 or 900 to 998

� ZVEI: from 90 to 99 or 900 to 999
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Prime Despatcher Number
The Prime Despatcher Number field sets the number the 
unit will default to when a despatcher call (*0) is dialled 
without specifying a unit number.

Enter a valid unit number from within the radio’s own fleet. 
For fleets that have no despatcher, enter 0.

Prime Emergency Number
The Prime Emergency Number field is the number the unit 
will default to when an emergency call (*9) is dialled without 
specifying a unit number. Set the Prime Emergency Number 
according to the Dialling Scheme.

For MPT 1343, Number Presets and ZVEI:

� If the called unit is from within the radio’s own fleet, 
enter the called unit’s number in the Number field. If so, 
the Prefix and Ident fields should be set to 0.

� If the called unit is in another fleet, enter the number in 
MPT 1327 format in the Prefix and Ident fields. If so, the 
Number field should be set to 0. Prefix should be a value 
from 0 to 127, and Ident should be a value from 1 to 
8100.

For CPSX Dialling:

� Enter a valid unit number from within the radio’s own 
fleet.

For Nokia ANN:

� Consult your network operator for the Prime Emergency 
Number to enter in this field.

ANN Numbering Model
The ANN Numbering Model field is available if Dialling 
Scheme is Nokia ANN.

The ANN Numbering Model field defines the length of 
strings to be used for interfleet numbers. There are four 
options.

� Small: Interfleet numbers contain 5 digits and fleets with 
prefix 0 are accessible.

� Medium: Interfleet numbers contain 6 digits and fleets 
with prefixes from 0 to 9 are accessible.

� Large: Interfleet numbers contain 7 digits and fleets with 
prefixes from 0 to 99 are accessible.

� Extended Large: Interfleet numbers contain either 7 or 8 
digits. Fleets with prefixes from 0 to 127 are accessible, 
although in some cases dialling may be abbreviated to 7 
digits.
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Fleet Structure Definition
The Fleet Structure Definition array is not available if Dial-
ling Scheme is MPT 1343, ZVEI or Number Presets.

� Nokia ANN: See “ANN Fleet Structure” below. 

� CPSX Dialling: See “CPSX Fleet Structure” below. 

ANN Fleet Structure
When Dialling Scheme is Nokia ANN, the Fleet Structure 
Definition array defines the ANN (Algorithmic Network 
Numbering) fleet structure, which differs from MPT 1343 
numbering in the way it divides fleets.

Up to 128 blocks can be defined. Select the Add button or 
press the F2 key to add a new block, or select the Delete but-
ton or press the F3 key to delete the currently selected block. 
For each block, you must set: Start Prefix, Stop Prefix, FPP 
and MEP.

Start Prefix
Start Prefix is the first prefix of the range to which the given 
values for FPP and MEP apply.

Enter a value from 0 to 127.

Stop Prefix
Stop Prefix is the last prefix of the range to which the given 
values for FPP and MEP apply.

Enter a value from 0 to 127 that is greater than or equal to 
the value of the corresponding Start Prefix.

FPP
FPP is the Fleet Partitioning Parameter and sets the partition 
between large and other fleets that are available in the ident 
range of a prefix. FPP gives the number of large fleets in a 
prefix directly. 

Set the value assigned by your network operator, which will 
be from 1 to 10.

MEP
MEP is the Miniaturisation Extent Parameter and specifies 
how the remaining ident range of a prefix is divided between 
small and mini fleets. 

Set the value assigned by your network operator, which will 
be from 1 to 10 minus the value of FPP. For instance, if FPP 
is 4, MEP should be between 1 and 6. 

CPSX Fleet Structure
When Dialling Scheme is CPSX Dialling, the Fleet Structure 
Definition array defines the CPSX fleet structure, which dif-
fers from MPT 1343 numbering in the way it divides fleets.
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CPSX systems are divided up into large, medium, small and 
tiny fleets. 

� Large: 699 units, 99 groups

� Medium: 354 units, 51 groups

� Small: 236 units, 34 groups

� Tiny: 118 units, 17 groups

Up to 128 blocks can be defined. Select the Add button or 
press the F2 key to add a new block, or select the Delete but-
ton or press the F3 key to delete the currently selected block. 
For each block, five fields must be set: Start Prefix, Stop Pre-
fix and the Large, Medium and Small parameters.

Start Prefix
Start Prefix is the first prefix of the range to which the given 
values for Large, Medium and Small apply.

Enter a value from 0 to 127.

Stop Prefix
Stop Prefix is the last prefix of the range to which the given 
values for Large, Medium and Small apply.

Enter a value from 0 to 127 that is greater than or equal to 
the value of the corresponding Start Prefix.

Large, Medium and Small Parameters
How many large, medium, small and tiny fleets there are is 
determined by the values of the parameters Large, Medium 
and Small.

Using these parameters, the network operator can configure 
a system in which interfleet and interprefix dialling are pos-
sible from any radio in any other fleet of any other prefix. 
Interfleet calls are made by dialling a five-digit number, and 
interprefix calls are made by dialling an eight-digit number.

Because each type of fleet is fixed in size, the values of the 
fields in the Fleet Structure Definition array will determine 
the values of the Number Range for Individual Calls and 
Number Range for Group Calls fields in the Radio Identity 
form and the Highest Individual Number in Fleet and High-
est Group Number in Fleet fields in the Fleet Identity form.

See “CPSX Dialling” on page 124 for more information.
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Fleet Parameters Form

The fields in the Fleet Parameters form define how calls are 
handled. The Fleet Parameters form is shown below.

Information in this form cannot be altered unless you have 
medium-level password access.

Full Off Air Call Setup
Trunking systems can set up calls in two ways. In some sys-
tems, it is possible for the system to seek acknowledgement 
from the called party before setting up a call. The Full Off Air 
Call Setup field determines whether such acknowledgement 
is required. There are two options.

� Allowed: Acknowledgement will be sought from the 
called party before a traffic channel will be allocated for 
the call. However, if the system is not capable of seeking 
acknowledgement, setting Full Off Air Call Setup to 
Allowed will have no effect.

� Disallowed: A traffic channel will be allocated for the call 
before the called radio has answered.

Default Call Time Limit
The Default Call Time Limit field sets the maximum dura-
tion of a call.

In MPT 1327, this value can be overwritten by a BCAST 
message from the system.

Enter a value as follows:
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� 0 for no call time limit

� from 10 to 254 seconds in steps of 1 second

� from 300 to 780 seconds in steps of 60 seconds

Note that the system can raise or lower the call time limit if 
necessary.

A different limit can be set for emergency calls (Default 
Emergency Call Time Limit field).

Default Emergency Call Time Limit
The Default Emergency Call Time Limit field sets the max-
imum duration of an emergency call.

Enter a value as follows:

� 0 for no call time limit

� from 10 to 254 seconds in steps of 1 second

� from 300 to 780 seconds in steps of 60 seconds

Note that in MPT 1327, this limit cannot be overwritten by 
the system.

Call Timer Count Up
The Call Timer Count-up field does not apply to Orca Elan 
or Orca 5030 radios.

� Enabled: The radio will display the duration of the call.

� Disabled: The radio will display the time remaining for 
the call.

Ignore TSC Call Time Limit
If the Ignore TSC Call Time Limit field is enabled, call time 
limits set by the system in BCAST SYSDEF messages will be 
disregarded. The radio will instead always use the call limit 
set in the Default Call Time Limit field.

Dynamic Group Insert
Applies to  CPSX Dialling only.

Dynamic group insert allows a system to add or delete a 
group using an AHYI signal on a control channel.

� Enabled: If the system offers dynamic group insert, the 
first group defined in the Group Membership array 
(Radio Identity form) can be overwritten with the group 
specified by a system AHYI. The overwritten group is 
lost permanently unless another AHYI is received to 
restore it.

� Disabled: The first group in the Group Membership array 
will not be overwritten when a system AHYI is received.
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Stun and Revive
The Stun and Revive feature allows a system to stun the 
radio using an AHYK signal on a control channel. While 
stunned, the radio cannot make or receive calls, but commu-
nication with the trunking system controller is maintained. 
The radio will be inoperative until a corresponding Revive 
command is received via an AHYL addressed to the radio 
over the control channel.

� Enabled: The system operator can send an AHYK signal 
to stun the radio.

� Disabled: The system operator cannot stun the radio.
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Conventional Channels Form

A trunked radio can switch between trunked and conven-
tional modes of operation. Up to ten conventional channels 
can be defined in the Conventional Channels form. The 
Conventional Channels form is shown below.

Information in this form cannot be altered unless you have 
medium level password access.

For more information on conventional channels, see 
“Appendix C: Switching to Conventional Channels” on 
page 128.

Tx Inhibit On Busy
The Tx Inhibit field sets the transmit inhibit conditions while 
the radio is operating in conventional mode. There are three 
options:

� None: The radio always transmits when the PTT is 
pressed, even when there is traffic on the channel.

� Busy: The radio does not transmit when the PTT is 
pressed if there is activity on the channel, whether it is 
valid or invalid.

� Mute: The radio does not transmit when the PTT is 
pressed, unless there is valid activity on the channel. If 
monitor has been activated, the radio transmits regardless 
of valid or invalid activity.

transmit inhibit

The transmit inhibit feature determines 
under what conditions a press of the 
PTT results in the radio not transmit-
ting.



© Copyright Tait Electronics Ltd, 2004  Conventional Channels Form 63

Reverse Tone Burst Duration
The Reverse Tone Burst Duration field specifies how long a 
CTCSS reverse tone burst is transmitted. Reverse tone burst 
transmission increases the speed of receiver shutdown in 
some repeaters and associated equipment.

Set a value from 0 to 250 ms in steps of 1 ms. Setting this field 
to 0 disables reverse tone burst transmission.

The recommended value is 130 ms, which works for all 
CTCSS tones between 67.0 and 250.3 Hz. Longer durations 
may be used for lower CTCSS frequencies and shorter dura-
tions for higher CTCSS frequencies. However, it should not 
be necessary to deviate from 130 ms unless your system has 
specific requirements.

Conventional Channels
The Conventional Channels array defines the conventional 
channels the radio operates on.

Up to 10 conventional channels can be defined for each 
trunking network. Select the Add button or press the F2 key 
to add a new channel, or select the Delete button or press the 
F3 key to delete the currently selected channel. For each 
conventional channel, set: Access Number, Receive and 
Transmit Frequencies, Transmit Deviation, Power Level, 
Subaudible Signalling and Squelch.

Access Number
The Access Number field defines the string that must be 
entered to change to the conventional channel. Enter a value 
from 101 to 110, or from 101 to 109 for the ZVEI dialling 
scheme.

On Orca Elan and Orca 5030 radios, the user cannot dial 
strings, and so the Access Number should be entered as one 
of the preset calls defined in the Preset Calls form. When the 
user changes to that preset calls position on the 16-way selec-
tor, the conventional channel will automatically be selected.

Receive and Transmit Frequencies
The Rx Freq MHz and Tx Freq MHz fields set the conven-
tional channel’s receive and transmit frequencies. 

For each channel, enter a frequency within the radio’s fre-
quency band that is a multiple of one of the following fre-
quencies:

� 2.5 kHz (if the Transmit Deviation is set to Narrow, and 
the RX Frequency is between 150 MHz and 174 MHz).

� 5 kHz

� 6.25 kHz

CTCSS

CTCSS (continuous tone controlled 
squelch system) is a type of signalling 
used for segregating groups of users. 
CTCSS uses subaudible tones between 
67 and 250.3 Hz to identify a group 
of radio users.
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The letter in the fourth position (first after the hyphen) in the 
product code (see the Specifications form or the back of the 
radio) indicates the radio’s frequency band as outlined in the 
table on page 64.  

Note that the range of frequencies permitted for bands J and 
K are different for Rx Freq (MHz) and Tx Freq (MHz).

Transmit Deviation
The Tx Dev field sets the transmitter deviation. It can be set 
to:

� wide: maximum deviation 5 kHz

� medium: maximum deviation 4 kHz

� narrow: maximum deviation 2.5 kHz 

Set Tx Dev according to the system Channel Spacing. Chan-
nel spacing is indicated in the number in the fifth position 
(second after the hyphen) in the product code (see the Spec-
ifications form or the back of the radio).

� 1 (Wide Band): The radio can be programmed for oper-
ation on 20 and 25 kHz channels only (select a Tx Devi-
ation of Wide or Medium).

� 2 (Universal Band): The radio can be programmed for 
operation on 12.5, 20 and 25 kHz channels (select a Tx 
Deviation of Wide, Medium or Narrow).

Power Level
The Power Level field sets the transmit power level. 

Band
Receive Frequency 

(MHz)
Transmit Frequency 

(MHz)

A 66-88 66-88

B 136-174 136-174

C 174-225 174-225

D  220-270  220-270

E 270-310 270-310

F 290-340 290-340

G 336-400 336-400

H 400-470 400-470

I 450-530 450-530

J  851-870  806-870

K 935-941 896-941

channel spacing

Channel spacing is the interval between 
channels. For Tait Orca radios, this is 
12.5, 20 or 25 kHz. Wide Band 
radios can be programmed for operation 
on 20 and 25 kHz channels only. 
Universal Band radios can be pro-
grammed for operation on 12.5, 20 
and 25 kHz channels.
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Using the drop-down menu, select a power level setting 
within the limits permitted for the region in which the radio 
operates: 

� Off (O): When set to off, the radio cannot transmit on 
that channel.

� Low (L): 1 watt VHF, UHF, 800/900 MHz

� Medium (M): 2.5 watts VHF, UHF, 2 watts 800/900 
MHz

� High (H): 5 watts VHF, 4 watts UHF, 3 watts 800/900 
MHz

The transmit power can be temporarily reduced by use of the 
low power transmit feature, which is a way of conserving 
battery life. When low power transmit is active, all transmis-
sions are made at the low power level rather than at the pro-
grammed power level. When low power transmit is deacti-
vated, transmissions are made at the programmed power 
level.

See “Function Key Option: Low Power” on page 101 and 
“Menu Option: LOW PWR” on page 93 for more informa-
tion.

Subaudible Signalling
The CTCSS Rx field sets the receive subaudible signalling 
the radio must receive before channel activity is regarded as 
valid and the mute opened. The CTCSS/DCS Tx field sets 
the subaudible signalling that accompanies each transmission 
made on the channel.

For CTCSS Rx, select the required CTCSS frequency from 
the drop-down list. For CTCSS/DCS Tx, select the 
required CTCSS frequency or DCS code from the drop-
down list.

Leave these fields set to NONE if no subaudible signalling is 
used on the channel.

Squelch
The Squelch Level field sets the squelch threshold. There are 
two options:

� Country: 12 dB SINAD

� City: 16 dB SINAD

squelch threshold

The squelch threshold is the level the 
signal must reach before it is regarded 
as intelligible and the radio’s mute is 
opened. Tait Orca radios can operate 
at two different squelch thresholds: 
city and country squelch.
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DTMF Parameters Form

DTMF options are set in the DTMF Parameters form. This 
form does not apply to Orca Elan, Orca 5030 and Orca 5035 
radios. The DTMF Parameters form is shown below.

Information in this form cannot be altered unless you have 
medium-level password access or higher.

For more information on DTMF, see:

� “Introduction to DTMF” on page 132

� “DTMF Overdialling” on page 132

Manual DTMF Dialling
� Enabled: DTMF calls can be made from the numeric 

keypad. 

� Disabled: The radio cannot make DTMF calls.

PTT as Shift Key
If the user wishes to dial tones A to D or a pause, the PTT 
can be used as a shift key in conjunction with the numeric 
keypad. For example, on the Orca Excel:

PTT +  = A

PTT +  = B

PTT +  = C

PTT +  = D

PTT +  = pause

DTMF

DTMF (dual tone multiple fre-
quency) is the tone-based system used 
for the world’s telephone networks. A 
DTMF “tone” actually consists of a 
pair of tones. DTMF tones are some-
times referred to as “touch tones”.
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So pressing the PTT key, holding it, then pressing the   
key enters tone A in the DTMF string. Pressing the PTT, 
holding it, and then pressing the  key enters a pause in 
the string. A hyphen is entered in the display to indicate the 
pause.

Enable PTT as Shift Key if the user will need to dial tones A 
to D and pauses.

Transmit Key Up Delay
The Transmit Key Up Delay field sets a delay for the start of 
tone transmissions so that a repeater has time to stabilise. 
Enter a value from 10 to 2550 ms in steps of 10 ms.

Minimum Tone Duration (0-9, A-D)
The Minimum Tone Duration (0-9, A-D) field sets the min-
imum amount of time tones 0 to 9 and A to D are encoded. 
Enter a value from 50 to 1020 ms in steps of 10 ms.

Minimum Tone Duration (*, #)
The Minimum Tone Duration (*, #) field sets the minimum 
amount of time tones * and # are encoded. Enter a value 
from 50 to 1020 ms in steps of 10 ms.

Minimum Intertone Gap
The Minimum Intertone Gap field sets the minimum 
amount of time between encoded tones. Enter a value from 
10 to 500 ms in steps of 10 ms.

Interdigit Tx Hold Time
The Interdigit Tx Hold Time field determines how long the 
radio keeps transmitting between the encoding of each tone. 
This provides a delay for the user to dial the next digit with-
out transmission stopping and restarting again. Some systems 
require continuous transmission between DTMF tones and 
therefore a long hold time.

Enter a value between 10 and 2550 ms, in steps of 10 ms.
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Part 4: Changing Radio Settings
This part contains detailed information on changing radio settings.

Most of the fields in these forms require only low-level password 
access.

Forms

� Radio Identity Form

� Selective Scan form

� Acquisition Data Form

� Preset Calls Form

� Lookup Table for 5 Digit Interfleet Calls Form

� Call Options Form

� SOS Options Form

� Status Labels Form

� User Defined Menu Form

� Key Settings Form

� User Selectable Parameters Form

� Short Data Messages Form
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Radio Identity Form

The fields in the Radio Identity form define the radio’s iden-
tity on a particular network. The Radio Identity form is 
shown below.

Radio Unit Number
The Radio Unit Number field defines the unit number that 
uniquely identifies each radio within its fleet. The Radio 
Unit Number should already be assigned by the network 
operator as part of setting up the system. Enter the number 
assigned by your network operator.

The value this field will be set to is affected by the Dialling 
Scheme field (Fleet Identity form).

� If Dialling Scheme is MPT 1343, ZVEI or Number Pre-
sets, the number entered in the Radio Unit Number field 
is dependent on the Highest Individual Number in Fleet 
field (Fleet Identity form). If Highest Individual Number 
in Fleet has two digits, enter a value from 20 to the High-
est Individual Number in Fleet. If Highest Individual 
Number in Fleet has three digits, enter a value from 200 
to the Highest Individual Number in Fleet.

� If Dialling Scheme is Nokia ANN, the radio’s identity 
should be defined in the Fully Qualified ANN Radio 
Unit Number field.

� If Dialling Scheme is CPSX Dialling, the number entered 
in Radio Unit Number should be in the range specified 
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by the Number Range for Individual Calls fields in the 
Radio Identity form.

Fully Qualified ANN Radio Unit 
Number
The Fully Qualified ANN Radio Unit Number field defines 
the unit number that uniquely identifies each radio within its 
fleet when Dialling Scheme is Nokia ANN. The Fully Qual-
ified ANN Radio Unit Number should already be assigned 
by the network operator as part of setting up the system. 
Enter the number assigned by your network operator.

Maximum Number of Group 
Addresses
The Max Number of Group Addresses field shows the max-
imum number of group addresses available and that can be 
programmed in the Group Membership array.

Set a value from 1 to 32.

Group Membership
The Group Membership array defines what groups the radio 
belongs to. A radio can belong to up to 32 groups, depending 
on the number indicated in the Maximum Number of 
Group Addresses field. Select the Add button or press the F2 
key to add a new group address, select the Delete button or 
press the F3 key to delete the currently selected group 
address, or select the Repeat button to duplicate the current 
group address’ settings, except for the Number.

How group addresses are entered depends on the Dialling 
Scheme (Fleet Identity form).

� If Dialling Scheme is MPT 1343, ZVEI or Number Pre-
sets, group addresses can be entered in MPT 1343 format 
(in the Number field) or in MPT 1327 format (in the 
Prefix and Ident fields). For MPT 1343 format, the num-
bers entered are dependent on the Highest Group 
Number in Fleet field (Fleet Identity form). If Highest 
Group Number in Fleet has two digits, enter a value from 
90 to the Highest Group Number in Fleet. If Highest 
Group Number in Fleet has three digits, enter a value 
from 900 to the Highest Group Number in Fleet. For 
MPT 1327 format, enter a Prefix from 0 to 127 and an 
Ident from 1 to 8100. Whichever format you choose, the 
other fields must remain set to zero. If the radio will not 
subscribe to any groups, set all fields to zero.

� If Dialling Scheme is Nokia ANN, group addresses must 
be entered in the ANN Group ID field. Enter a valid 
ANN group identity.
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� If Dialling Scheme is CPSX Dialling, enter a group 
number within the range specified by the Number 
Range for Group Calls fields (Radio Identity form). If the 
group is in a different fleet, enter the full interfleet dialling 
number.

User Programmable
The User Programmable field sets the method by which the 
radio subscribes to different groups. When a radio is sub-
scribed to a group, it will respond to all calls made within that 
group.

The options for User Programmable are Dynamic (Orca Elan 
and Orca Excel radios only), Permanent, Selectable, Scan 
and Scan + Selectable.

� Dynamic (Orca Excel and Orca Elan radios): The first 
group in the array will always be set to Dynamic. This 
position is left free to allow a network operator to sub-
scribe the radio to a group over the air using the Dynamic 
Group Insert feature, which is enabled in the Fleet 
Parameters form. Any group number programmed for 
this first group will be overwritten should the network 
operator subscribe the radio to a group using the dynamic 
group insert feature, and so it is recommended that the 
value of the other fields in the first row should be left at 0.

NOTE: This feature is enabled by default for Orca 5030, 
Orca 5035 and Orca 5040 radios.

� Permanent: The radio will always respond to calls 
intended for the group.

� Selectable, Scan or Scan + Selectable: The radio user 
must select the group before the radio will respond to 
calls for that group. How the group is selected depends 
on the setting of User Programmable.

For more information on groups, see “Appendix B: Selecting 
Groups” on page 127.

Number Range for Individual Calls
The Number Range for Individual Calls fields define the 
range of individual numbers a radio can call. The setting of 
these fields can restrict the calls a radio can make to other 
radios in the fleet. 

The range entered is dependent on the Highest Individual 
Number in Fleet field in the Fleet Identity form.

� If Highest Individual Number in Fleet has two digits, the 
Number Range for Individual Calls can be anywhere 
from 20 to the Highest Individual Number in Fleet.

� If Highest Individual Number in Fleet has three digits, 
the Number Range for Individual Calls can be anywhere 
from 200 to the Highest Individual Number in Fleet.
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If you wish to prevent the radio from making individual calls 
to other radios in its fleet, enter 0 in both fields.

Number Range for Group Calls
The Number Range for Group Calls fields define the range 
of group numbers a radio can call. The setting of these fields 
can restrict the calls a radio can make to groups of radios in 
the fleet. 

The range entered is dependent on the Highest Group 
Number in Fleet field in the Fleet Identity form.

� If Highest Group Number in Fleet has two digits, the 
Number Range for Group Calls can be anywhere from 
90 to the Highest Group Number in Fleet.

� If Highest Group Number in Fleet has three digits, the 
Number Range for Group Calls can be anywhere from 
900 to the Highest Group Number in Fleet.

If you wish to prevent the radio from making group calls to 
other radios in its fleet, enter 0 in both fields.
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Selective Scan form

The Selective Scan form is used to add groups to one of the 
four selective scan groups available (***1 to ***4) for Orca 
5030, Orca 5035 and Orca 5040 radios.

Tick the Enable priority scan box to add the first member in 
each row to a priority group.

The Selective Scan form is shown below. 

ID
ID displays the identifier of up to 4 selective scan groups. 
You must add this number (***1 to ***4) to the call string 
of a preset call (Preset Calls form) to access the scan group. 
This field is read-only and cannot be edited. 

Group Membership List
Member groups are added to the selective scan group in the 
group membership list. Select a group identity (ID field) 
from the drop-down list. There must be at least 2 and no 
more than 16 entries for each scan group, and a group can 
appear in a particular scan group only once. 

Only groups with User Programmable set to Scan or User 
Selectable+Scan (Radio Identity form) can be selected.

selective scan

Selective Scan is a feature for Orca 
5030, 5035 and 5040 radios. It 
enables a number of groups (scan 
group) to be selected and collectively 
scanned for activity. The selective scan 
group must be added to a preset call 
using a call string of ***1 to ***4, 
and cannot be dialled directly from the 
keypad. Each of the 4 scan groups can 
contain from 2 to 16 groups.
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Acquisition Data Form

The arrays in the Acquisition Data form define data used 
when the radio is attempting to acquire a control channel. 
The Acquisition Data form is shown below.

Acquisition Authorisation
The fields in the Acquisition Authorisation array specify how 
the radio identifies a control channel on which it can operate.

Up to eight definitions are permitted. Select the Add button 
or press the F2 key to add a new definition, select the Delete 
button or press the F3 key to delete the currently selected 
definition, or select the Repeat button to duplicate the cur-
rent definition’s settings.

For each definition, you must specify a Type and Code.

Type
The Type field specifies the areas of the trunking network in 
which the radio may operate. Enter the value assigned by 
your network operator, which will be Full, Area or Zone.

Code
The Code field sets the specific code for acquisition author-
isation. 

On some networks, this field is left blank. Possible entries are 
constrained by the values of the fields Area Field Length (LA) 
and Zone Field Length (LZ) (see the Network Identity 
form).
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If the Network Type (Network Identity form) is National, 
enter a value from 0 to 511. If the Network Type is 
Regional, set a value from 0 to 15. 

NDD Preference Data
The fields in the NDD Preference Data array define the 
information used to encourage the radio to acquire certain 
control channels during a preferential hunt. 

Up to four definitions are permitted. Select the Add button 
or press the F2 key to add a new definition, select the Delete 
button or press the F3 key to delete the currently selected 
definition, or select the Repeat button to duplicate the cur-
rent definition’s settings.

For each definition, you must specify Field Length, Priority 
and Value.

Field Length
The Field Length field specifies how many bits of the SYS 
code are used to determine the identity of the site to be allo-
cated a priority. The maximum number is dependent on 
Network Type (Network Identity form).

If the Network Type is National, enter a value from 1 to 9 
for Field Length. If the Network Type is Regional, enter a 
value from 1 to 4 for Field Length.

Priority
The Priority field specifies the priority of the entry, from 1 
(high) to 10.

Value
The Value field specifies the decimal value of the binary bits 
derived from the SYS code to determine the site to be given 
priority. Value must be storable in the number of bits speci-
fied by Field Length.

Home Zone
The Home Zone field specifies the network zone in which 
the radio is normally working. The radio also uses the home 
zone to determine whether re-registration is required on a 
network when registration records for the network have only 
been maintained on a temporary basis.

The maximum value of Home Zone depends on the value 
of Zone Field Length (LZ) (Network Identity form).

preferential hunt

A preferential hunt is carried out as 
part of the control channel acquisition 
procedure. A preferential hunt covers 
all channel numbers likely to be used 
as control channels on the selected net-
work. For a preferential hunt, the 
radio will only acquire a control chan-
nel for which a preference exists.

registration

A radio unit must let the trunking sys-
tem know its current location, espe-
cially if the radio unit roams through-
out the network. Knowledge of its 
location allows for an efficient call 
setup process when the radio unit is 
called. A radio unit will attempt to 
register if the area code of the new site’s 
system identity code is different to that 
of the previous site.
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Preset Calls Form

Between 20 to 100 preset calls, depending on the model, can 
be defined for each radio together with two function key 
calls. These calls are defined in the Preset Calls form. The 
Preset Calls form is shown below.

Preset Calls Array
The Preset Calls array defines the preset calls the radio can 
make.

For Orca Elan, Orca Excel and Orca 5030 radios, up to 20 
preset calls can be defined, numbered 0 to 19. For Orca 5035 
and Orca 5040 radios, up to 100 preset calls can be defined, 
numbered 0 to 99. Select the Add button or press the F2 key 
to add a new preset call, select the Delete button or press the 
F3 key to delete the currently selected preset call, or select 
the Repeat button to duplicate the currently selected preset 
call’s Call String.

For each preset call, you must define a Preset ID, Label and 
Call String.

Preset ID
The Preset ID field sets the number of the preset call, which 
must be a number from 0 to 19 (Orca Elan, Orca Excel and 
Orca 5030 radios), or from 0 to 99 (Orca 5035 and Orca 
5040 radios). Entries need not be numbered sequentially.

Preset calls numbered 1 to 16 will be assigned to the corre-
sponding position on the 16-way selector. The first 16 preset 
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calls entered by default will be automatically numbered from 
1 to 16. Zero will not appear by default until the end as it is 
not a position on the 16-way selector.

Label
The Label field sets an alphanumeric label for the preset call, 
which will appear on the display when the call is selected for 
Orca 5035, Orca 5040 and Orca Excel radios. Each label 
must be unique. Enter a name of up to 8 characters from: 

A to Z 0 to 9 ! @ # $ % ^ & * + - = { } ( ) [ ] < > : ; ? | , 
. _ " ’ space

Call String
The Call String field sets the string that is dialled when the 
preset call is selected.

Enter any valid dialling sequence using the characters: 0-9 * 
# that conforms to the selected Dialling Scheme.

What strings are valid depends on how the trunking system 
is configured. Consult your network operator, and see 
“Appendix B: Selecting Groups” on page 127 and “Appen-
dix C: Switching to Conventional Channels” on page 128 
for more information.

The Call String field cannot be left blank, nor can it be set to 
another preset call Preset ID.

Function Key Preset Calls
Each radio can have two function key preset calls that can 
then be assigned to a function key setting.

For the Function Key Preset Call 1 and Function Key Preset 
Call 2 fields, enter any valid dialling sequence using the char-
acters: 0-9 * #

What strings are valid depends on how the trunking system 
is configured. Consult your network operator, and see 
“Appendix B: Selecting Groups” on page 127 and “Appen-
dix C: Switching to Conventional Channels” on page 128 
for more information.

In order to make use of these two preset calls, they must be 
assigned to one of the function key settings in the Key Set-
tings form.
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Lookup Table for 5 Digit Interfleet Calls Form

The Lookup Table for 5 Digit Interfleet Calls form is used to 
define 5-digit access strings that can be used to make inter-
fleet calls. This form applies only to fleets that use MPT 
numbering. If the network is not MPT 1343 compliant, con-
sult the network operator. The Lookup Table for 5 Digit 
Interfleet Calls form is shown below. 

Up to 20 lookup entries can be set. Select the Add button or 
press the F2 key to add a new lookup entry, select the Delete 
button or press the F3 key to delete the currently selected 
lookup entry, or select the Repeat button to duplicate the 
current lookup entry’s settings, except for the Access String.

At least one of the Interfleet Calls or Interfleet Group Calls 
fields (in the Call Options form must be enabled before any 
lookup entries can be made.

For each lookup entry, five fields must be set: Prefix, Fleet 
Number, Fleet Type, Highest Number in Fleet and 5 Digit 
Access String.

Prefix
The Prefix field sets the lookup table number prefix.

In MPT 1343, the number prefix must be from 200 to 327. 
If you do not know the number prefix of the fleet to be 
called, consult the network operator.
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Fleet Number
The Fleet Number field sets the number of the fleet that will 
be called.

In MPT 1343, the fleet number must be from 2001 to 6050. 
If you do not know the fleet number of the fleet to be called, 
consult the network operator.

Fleet Type
The Fleet Type field sets the type of the fleet that will be 
called and specifies whether the call is an Individual or Group 
call. The types are the same for interfleet calls as they are for 
normal in-fleet calls.

Highest Number in Fleet
The Highest Number in Fleet field sets the highest number 
in the fleet that will be called.

In MPT 1343, if this lookup entry is being defined for indi-
vidual calls then the number range is 20 to 89 or 200 to 899. 
If the lookup entry is being defined for group calls then the 
number range is 90 to 99, or 900 to 998. If you are not sure 
of the correct highest number for the fleet to be called, con-
sult the network operator.

5 Digit Access String
The 5 Digit Access String field defines the five digit, short 
form number the user will dial.

The first two digits of the 5 Digit Access String must be 
unique and start with either a 2 or a 9. MPT 1343 recom-
mends you use 2 as the first character of the Access String for 
individual calls and 9 as the first character of the Access String 
for group calls. This convention is not mandatory.

Accept the default number selected by the software, or enter 
your own 5 Digit Access String.
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Call Options Form

The fields in the Call Options form determine the types of 
calls a radio unit is permitted to make and how they are 
made. The Call Options form is shown below.

PABX Calls
The setting of the PABX Calls field determines whether the 
radio is permitted to make calls to PABX extensions on 
trunking systems that support PABX calling.

� Enabled: The radio is permitted to make PABX calls.

� Disabled: The radio can receive PABX calls but can only 
transmit PABX calls programmed as preset calls (in the 
Preset Calls form).

If the system does not support PABX calls, the setting of the 
PABX Calls field has no effect on radio operation.

PSTN Calls
The setting of the PSTN Calls field determines whether the 
radio is permitted to make calls to PSTN numbers on trunk-
ing systems that support PSTN calling.

� Enabled: The radio is permitted to make PSTN calls.

� Disabled: The radio can receive PSTN calls but can only 
transmit PSTN calls programmed as preset calls (in the 
Preset Calls form).

If the  system does not support PSTN calls, the setting of the 
PSTN Calls field has no effect on radio operation.

PABX

PABX stands for private automatic 
branch exchange. A trunking system 
can be connected to a PABX and so 
radios using that system can make 
calls to and receive calls from PABX 
extensions. 

PSTN

PSTN stands for public switched tel-
ephone network, the public telephone 
network on which subscribers own or 
rent tethered communications devices 
(telephones, facsimiles, modems) as 
opposed to untethered communica-
tions devices (radio telephones, cellular 
phones). A trunking system can be 
connected to the PSTN and so radios 
using that system can make calls to 
and receive calls from PSTN num-
bers. 
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Interfleet Calls
When the Interfleet Calls field is enabled, the radio can make 
calls to individual radios in other fleets.

Unless there is a specific reason to allow this type of call, dis-
able this field.

Interfleet Group Calls
When the Interfleet Group Calls field is enabled, the radio 
can make calls to groups of radios in other fleets.

Unless there is a specific reason to allow this type of call, dis-
able this field.

ALLI Calls
When the ALLI Calls field is enabled, the radio can make 
calls to all idents (ALLI).

High-level password access is required to change the value of 
ALLI Calls. This facility is normally used only by network 
technicians and so this field should be disabled for most radios 
in a fleet. Do not enable this field unless authorised to do so 
by the network operator.

Network Operator Service Calls
When the Network Operator Service Calls field is enabled, 
the radio can make a service call to the network operator.

This facility may be set up to aid in the reporting of, for 
example, faults.

High-level password access is required to change the value of 
this field.

Direct Despatcher Calls
When the Direct Despatcher Calls field is disabled, the radio 
cannot make normal speech calls to the despatcher.

The despatchers number is defined in the Prime Despatcher 
Number field (Fleet Identity form). Users can still enter and 
leave the despatcher’s queue (if available) using the dial 
strings *0# and #0#.

Status Calls
When the Status Calls field is enabled, the user can send sta-
tus messages. 

When this field is disabled, the user will be able to dial status 
strings, but the status message will not be sent.

status message

A status message is a short signalling 
message that carries only a number 
between 1 and 30. Because of the 
brevity of the message, no audio chan-
nel is used. All the required informa-
tion can be transferred in the signal-
ling between the network and the 
radio unit. 
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Callback Cancel
The Callback Cancel field only applies to Orca 5035 and 
Orca 5040 radios. 

Callback Cancel sets whether the radio can delete status mes-
sages from the call queue, in response to a STATUS 31 call. 
If this box is ticked, when the radio receives a STATUS 31 
call it will remove the last status or voice call from the call 
queue. If both Callback Cancel and Delete SDM Call In The 
Queue are unchecked, then only voice calls can be deleted 
from the queue.

Abbreviated Dialling
The trunking system can be configured so that radios on the 
system can make a call to the PSTN without dialling the full 
number.

Enable the Abbreviated Dialling field to allow the radio to 
make use of this feature.

If Abbreviated Dialling is enabled, you should also set the 
Abbreviated Dialling Limit.

Abbreviated Dialling Limit
The Abbreviated Dialling Limit field sets the number of dif-
ferent abbreviated dialled calls a radio can make.

Tait Orca radios can support up to 50 abbreviated dialling 
calls, although the number the trunking system supports may 
be lower. Consult your network operator to determine how 
many abbreviated dialling calls are available.

Callback Facility
The Callback Facility field does not apply to Orca Elan and 
Orca 5030 radios.

When Callback Facility is enabled, the number of an incom-
ing call will be displayed when the call is cleared down. The 
user can then call back the calling radio by pressing the PTT.

Call Queuing
The Call Queuing field does not apply to Orca Elan and 
Orca 5030 radios.

Call queuing sets a queue to hold unanswered calls, automat-
ically queued calls and status calls. There are three options.

� Full: All calls will be queued. 

�  Unanswered: Only unanswered calls and status calls will 
be queued.

� Last: Only the last unanswered call will be queued.
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Unanswered Call Timer
The Unanswered Call Timer field sets how long an unan-
swered call alert will persist. 

Set a value from 0 to 255 seconds in steps of 1 second.

If Unanswered Call Timer is set to 0, the radio will ring until 
the call is answered or is cleared down.

Divert Own Calls
When the Divert Own Calls field is enabled, the user can set 
the radio to divert incoming calls to another destination.

Divert Third Party Calls
When the Divert Third Party Calls field is enabled, the user 
can divert another radio’s incoming calls to another destina-
tion.

Do Not Disturb
When the Do Not Disturb field is enabled, the user can set 
the radio to ignore incoming calls while still allowing outgo-
ing calls to be made as usual.

When Do Not Disturb is disabled, the radio will always 
receive calls as long as it is switched on and in range of the 
network. These calls may be accepted or queued.

Join Busy Group
Some networks send repeat go-to-channel messages. On 
such networks, a radio can make a call to a group it is not 
subscribed to and if a group call is already in progress, the 
radio will be directed to the allocated traffic channel. When 
the Join Busy Group field is enabled, the radio will be able to 
join busy groups.

Do not enable this field unless authorised to do so by the net-
work operator.

Note that on systems that support group call amalgamation, 
the radio will automatically join busy groups regardless of the 
setting of this field.

Delete SDM Call In The Queue
The Delete SDM Call In The Queue field only applies to 
Orca 5035 and Orca 5040 radios.

Delete SDM Call In The Queue sets whether the radio can 
delete short data messages (SDMs) from the call queue, in 
response to a STATUS 31 call. If this box is ticked, when the 
radio receives a STATUS 31 call it will remove the last call 
it has stored in the call queue. The Delete SDM Call In The 
Queue field can only be enabled when the Callback Cancel 
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field is enabled. If both Delete SDM Call In The Queue and 
Callback Cancel are unchecked, then only voice calls can be 
deleted from the queue.
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SOS Options Form

Set options for SOS calls and lone worker in the SOS 
Options form (Orca 5030/5035/5040 radios only). The SOS 
Options form is shown below.

NOTE: SOS calls and lone worker are not available on con-
ventional channels.

Call String
Call String sets the number the radio will dial when the radio 
user presses a function key set to SOS Call. Enter any valid 
dialling sequence using the characters 0-9, *, #. To make the 
call an emergency call that will pre-empt other calls on the 
trunking system, add *9 to the start of the call string. 

Silent SOS Calls
Silent SOS Calls sets whether the radio should process the 
SOS call silently, with no audible or visual indicators. 

NOTE: If this field is checked, the 16-way selector, PTT and 
all other keys will be disabled for the duration of the SOS 
call. 

Num Retries
Num Retries sets the number of attempts the radio will make 
to set up an SOS call after failing to gain a traffic channel. 
Enter a number between 0 and 255.

SOS call

An SOS call can be assigned to a 
function key or assigned automatically 
to the lone worker feature. When an 
SOS call is initiated, the radio sends 
a call to a pre-programmed call string, 
and cycles between receiving and 
transmitting so that the called party 
can hear activity near the radio and so 
decide how to respond. The radio can 
be programmed so that all indicators 
remain unchanged when sending the 
SOS call and when cycling between 
Tx and Rx mode. 
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Call Time Limit
Call Time Limit sets a total call time limit in seconds for SOS 
calls. This time limit overrides any other time limits that 
might be in effect. Enter a value between 10 and 120 sec-
onds.

Rx Time
The radio automatically cycles between receiving and trans-
mitting when it makes an SOS call. Rx Time sets how long 
the radio should spend receiving. Enter a value between 0 
and 120 seconds. Ensure that the sum of SOS Tx Time and 
SOS Rx Time do not exceed the Call Time Limit.

Tx Time
The radio automatically cycles between receiving and trans-
mitting when it makes an SOS call. Tx Time sets how long 
the radio should spend transmitting. Enter a value between 0 
and 120 seconds. Ensure that the sum of SOS Tx Time and 
SOS Rx Time do not exceed the Call Time Limit.  

Rx Mute
Rx Mute sets whether the receive audio on the radio that 
initiated the SOS call is muted. If checked, receive audio will 
be muted for the duration of the SOS call. If unchecked, 
receive audio will not be muted and the recipient will be able 
to communicate with the unit making the call.

Call Type
Call Type is part of the lone worker feature, and sets the type 
of emergency action that will be initiated after both the inac-
tivity and warning timers have expired. Select Prime Emer-
gency Number to send an emergency call to the call string 
defined in the Prime Emergency Number field (Fleet Iden-
tity form), or SOS Call to initiate the call string defined in 
the SOS Call String field and start Tx/Rx cycling.

Inactivity Timer
The Inactivity Timer is part of the lone worker feature, and 
sets the time from when the radio user presses the lone 
worker function key option, to when the Warning Timer 
starts. Pressing any key during this time will restart the timer. 
Enter a time between 1 and 60 minutes. 

Warning Timer
The Warning Timer is part of the lone worker feature, and 
sets the time from when the Inactivity Timer has timed out, 
to when the radio sends a either an emergency call or an SOS 
call. An audible alert will sound for the duration of the warn-

lone worker

Lone worker is a feature in Orca 
5030, Orca 5035 and Orca 5040 
radios. When activated, the radio 
begins a pre-programmed inactivity 
timer. Once this time has counted 
down with no keypress (or motion 
detected if programmed), an audible 
alert will sound for the length of the 
warning timer. If no key is pressed in 
this time (or motion detected), then an 
emergency call is made to the Prime 
Emergency Number, or a call made to 
the SOS Call String. 
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ing timer. Pressing any key during this time will stop the 
warning timer and restart the inactivity timer. Enter a time 
between 15 and 240 seconds.

Enabled on Power-on
The Enabled on Power-on field determines whether the 
lone worker feature is enabled when the radio is first turned 
on. Tick the Enabled on Power-on box to enable lone 
worker and begin the Inactivity Timer as soon as the radio is 
powered on.

Worker Detection
The Worker Detection field determines how user activity is 
monitored by the radio after lone worker has been activated. 
User activity resets the Inactivity Timer or Warning Timer. 
The following options are available:

� Key Press: the inactivity or warning timers will be reset if 
a key is pressed.

� Motion Sensor: the inactivity or warning timers will be 
reset if a key is pressed, or motion is detected. A man 
down motion sensor accessory must be fitted to the radio 
for this option to be valid.
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Status Labels Form

Status labels are available on Orca 5035 and Orca 5040 radios 
and are set in the Status Labels form. The Status Labels form 
is shown below.

Select the Add button or press the F2 key to add a status mes-
sage, select the Delete button or press the F3 key to delete 
the currently selected status message, or select the Repeat 
button to duplicate the current status message’s label. Up to 
30 status messages can be defined.

Status ID
The Status ID field sets the status message number that is 
transmitted. Enter a value from 1 to 30.

Label
The Label field sets the status label associated with the status 
message. 

Enter a name of up to 8 characters from:

A to Z 0 to 9 ! @ # $ % ^ & * + - = { } ( ) [ ] < > : ; ? | , 
. _ " ’ space
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User Defined Menu Form

Items that appear in the user menu of Orca 5035 and Orca 
5040 radios are set in the User Defined Menu form. This 
form is not available to Orca Elan, Orca Excel and Orca 5030 
radios. The User Defined Menu form is shown below.

The information displayed is the information that will appear 
in the radio’s user function menu. Ticking a top-level menu 
(for example, USER SETTINGS) will enable all of that 
menu’s submenu functions, and unticking a top-level menu 
will disable all submenu functions.

Enable All/Disable All
Click the Enable All button to enable all menu items, or the 
Disable All button to disable all menu items.

Menu Labels
You can edit the menu labels by entering a password in the 
box at the top of the form. If you do not have a password, 
contact your local Tait office. 

Restore Default Text
If menu labels have been changed and you wish to use the 
default text, click the Restore Default Text menu button. 

Save as Default Text
If you wish to save a different set of menu labels as the 
default, click the Save as Default Text button.
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Restore Factory Settings
To restore the radio’s factory settings, click the Restore Fac-
tory Settings button.

List Operation
The List Operation field determines the behaviour of scroll-
ing lists. There are two options.

� Wrap Around: The list is treated as a continuous loop, 
with the first and last entries adjacent. The next entry dis-
played after the last is the first, and vice versa.

� Stop at End of List: The list movement stops when the 
first or last entry is reached. 

Menu Options
Items selected are available for all programmed networks.

The availability of some items depends on the value of fields 
in other forms. The functions available are outlined below:

Menu Option: QUEUED CALLS

Description:
The QUEUED CALLS: menu option accesses the call 
queue. The radio only displays this option when at least one 
call has been queued.

Menu Option: SELECT PRESET

Description:
The SELECT PRESET menu option allows the user to view 
the list of preset calls programmed in the Preset Calls form. 
The radio user can scroll through and select from the list of 
calls.

Alternatives:
Preset calls numbered 1 to 16 are automatically accessible 
from the 16-way selector.

Menu Option: SELECT STATUS

Description:
The SELECT STATUS menu option allows the user to 
view and select from a list of status labels. 
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Menu Option: SELECT SDM

Description:
The SELECT SDM menu option allows the user to view a 
list of short data messages, and either edit or send an SDM 
Preset.

Menu Option: HANDSET

Description:
The HANDSET menu option turns handset operation on 
and off.

Handset mode automatically turns off after the handset inac-
tivity timer expires. The handset inactivity timer is set in the 
Key Settings II tab.

Menu Option: LOW PWR

Description:
The LOW PWR menu option allows the user to turn the 
low power transmit feature on and off. Low power transmit 
overrides the power level setting programmed for the chan-
nel in the Trunked Channel Blocks form or the Conven-
tional Channels form so that the radio transmits at low 
power.

Alternatives:
Channels can be programmed to always transmit at low 
power (Power Level field, Trunked Channel Blocks form, 
Power Level field Conventional Channels form).

Menu Option: KEYLOCK

Description:
The KEYLOCK menu option allows the user to lock the 
keypad so the keys cannot be activated accidentally. Which 
keys are locked depends on how the radio was programmed 
(Keypad Lock Disables, Key Settings II tab).

A long press of the clear key ( ) turns off keypad lock. 

Menu Option: SQUELCH

Description:
The SQUELCH menu option allows the user to change the 
squelch threshold, which can be city squelch or country 
squelch.

handset operation

Tait Orca radios can be operated as a 
normal radio where the user holds the 
radio with the microphone about 15 
cm away from the mouth or it can be 
operated like a telephone handset. 
Handset mode is useful in noisy envi-
ronments, when privacy is required or 
in quiet environments when the lowest 
volume setting seems too loud.
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Menu Option: DTMF
The DTMF menu option turns DTMF overdialling mode 
on and off.

Menu Option: QUEUE

Description:
The QUEUE menu option allows the user to turn call queu-
ing on and off.

Menu Option: QUIET

Description:
The QUIET menu option allows the user to turn do not dis-
turb on and off.

Menu Option: DYN PWR

Description:
The DYN PWR menu option allows the user to turn 
dynamic power control on and off.

Menu Option: PTTLOCK

Description:
The PTTLOCK menu option allows the user to lock the 
PTT key. The user can unlock the PTT key by pressing the 
clear key ( ).

Menu Option: TONES

Description:
The TONES menu option allows the user to turn audible 
indicators on and off.

Menu Option: LEVEL

Description:
The LEVEL menu option allows the user to change the level 
of audible indicators. There are two options: HIGH and 
LOW.

DTMF overdialling

The DTMF overdialling feature 
allows the radio user to dial DTMF 
strings using the numeric keypad.

call queuing

If the radio user is unable to answer 
calls immediately, they can be stored 
in the call queue so that the user can 
call back later. On Orca Elan and 
Orca 5030 radios, only one unan-
swered call can be queued. On Orca 
Excel, Orca 5035 and Orca 5040 
radios, up to 20 calls can be stored.

do not disturb

Do not disturb allows the radio user to 
ignore incoming calls while still mak-
ing outgoing calls as usual. Do not 
disturb can be activated by dialling 
*49# and can be deactivated by dial-
ling #49#.

dynamic power control

Dynamic power control optimises the 
radio’s power use by reducing the 
transmit power in high signal strength 
areas.
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Menu Option: KEYTONE

Description:
The KEYTONE menu option allows the user to turn key-
press confidence tones on and off.

Menu Option: INDVDUAL
The INDVDUAL menu option allows users to turn individ-
ual call tones on and off.

Menu Option: GROUP
The GROUP menu option allows users to turn group call 
tones on and off.

Menu Option: EMERGNCY
The EMERGNCY menu option allows users to turn emer-
gency call tones on and off.

Menu Option: QUEUE
The QUEUE menu option allows users to turn queue call 
tones on and off.

Menu Option: NIGHT

Description:
The NIGHT menu option allows the user to turn night use 
on and off.

Menu Option: ADJUST CONTRAST

Description:
The CONTRAST ADJUST menu option allows the user to 
adjust the contrast of the LCD display.

Menu Option: SELECT SITE

Description:
The SELECT SITE menu option allows the user to access 
the site select feature and enter a control channel that the 
radio must acquire.

keypress confidence tones

Keypress confidence tones are a confi-
dence indicator that tells the radio user 
whether or not an action is permitted 
whenever a keypad key or function 
key is pressed.

night use

When the night use feature is on, the 
radio’s backlighting activates when-
ever valid activity is detected, a key on 
the radio is pressed or when the radio 
receives a call. Backlighting remains 
on for the duration of the backlighting 
timer unless further activity is 
detected.

site select

The site select feature allows the radio 
user to specify the control channel the 
radio must acquire. The site select fea-
ture overrides the radio’s normal 
acquisition processes.
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Menu Option: SELECT NETWORK

Description:
The SELECT NETWORK menu option allows the user to 
switch to another trunking network. Tait Orca radios can be 
programmed to operate on one to four networks, depending 
on the model and firmware version.

Menu Option: FW VER

Description:
The FW VER menu option allows the user to view the radio 
firmware version number.

Menu Option: HW VER

Description:
The HW VER menu option allows the user to view the 
radio hardware version number.

Menu Option: MAIN DB

Description:
The MAIN DB menu option allows the user to view the 
programming software database version number.

Menu Option: CAL DB

Description:
The CAL DB menu option allows the user to view the cali-
bration database version number.
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Key Settings Form

Function key, handset mode and keypad lock options are set 
in the Key Settings form.

The Key Settings form is divided into two tabs.

� Set function key options, including external function 
keys, in the Key Settings I tab.

� Set handset mode and keypad lock options in the Key 
Settings II tab.

Key Settings I Tab
Set function key options, including handset mode options, in 
the Key Settings I tab. The Key Settings I tab is shown 
below.

Function Key Settings
Each radio has two function keys above the PTT key. Orca 
5035 and Orca 5040 radios have a third function key, which 
is the leftmost key in the row of four keys underneath the 
LCD display.

These radio function keys can have functions assigned to 
both short and long keypresses. A short keypress is less than 
one second. The radio user may need to experiment to 
become familiar with the duration of short and long key-
presses.

The third function key on Orca 5035 and Orca 5040 radios 
can also be operated as a “shortcut” to up to three user func-
tion menu options. The shortcut menu is a wrap around 
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menu, with one press of the third function key accessing the 
option that was last selected, and each subsequent press 
selecting the next option in a continuous loop. The user 
function menu options that will appear in the drop-down 
lists are those that are ticked in the User Defined Menu form.

Some radio accessories also have function keys, and most of 
the options available for the radio function keys are also avail-
able for external function keys.

Note: If a particular feature is applicable only in trunked 
mode or only in conventional mode, the function key press 
has no effect while in the other operating mode.

Function Key Option: Audible Indicators

Description:
Pressing the function key turns audible indicators on and off. 
Whether audible indicators are on or off when the radio 
powers up is determined by the Initial Setting for the Audible 
Indicators field (User Selectable Parameters form).

Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca 5030
✔ Orca 5035
✔ Orca 5040

Alternatives:
Audible indicators can be turned on and off from the user 
function menu.

Function Key Option: Backlighting On

Description:
Pressing the function key activates display backlighting. 
Backlighting deactivates when the backlighting timer 
expires.

Applies To:
✘ Orca Elan
✔ Orca Excel
✘ Orca 5030
✔ Orca 5035
✔ Orca 5040

Alternatives:
When the night use feature is on, the radio’s backlighting is 
activated whenever valid activity is detected, a key on the 
radio is pressed or when the radio receives a call.
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Function Key Option: Clear

Description:
Clears the last request to the trunking system.

Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca 5030
✔ Orca 5035
✔ Orca 5040

Limitations:
Cannot be used to clear calls from the call queue.

Alternatives:
On Orca Excel, Orca 5035 and Orca 5040 radios, a short 
press of the clear key ( ) clears the last request to the trunk-
ing system and clears calls from the call queue.

Function Key Option: Contrast Adjustment

Description:
Pressing the function key allows the radio user to adjust the 
display contrast using the scroll key(s). The radio automati-
cally returns to its previous mode of operation after a few sec-
onds of inactivity. The contrast can be reset to the default by 
pressing and holding Function Key 2 while turning the radio 
on.

Applies To:
✘ Orca Elan
✔ Orca Excel
✘ Orca 5030
✔ Orca 5035
✔ Orca 5040

Alternatives:
On Orca 5035 and Orca 5040 radios, the contrast adjust fea-
ture is available from the user function menu.

Function Key Option: Do Not Disturb

Description:
Pressing the function key turns the do not disturb function 
on and off.

do not disturb

Do not disturb allows the radio user to 
ignore incoming calls while still mak-
ing outgoing calls as usual. Do not 
disturb can be activated by dialling 
*49# and can be deactivated by dial-
ling #49#.
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Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca 5030
✔ Orca 5035
✔ Orca 5040

Alternatives:
On Orca Excel and Orca 5040 radios, do not disturb can also 
be activated by dialling the string *49#. Do not disturb can 
be deactivated by dialling the string #49#. On all radios, 
these strings can be entered as preset calls.

On Orca 5035 and Orca 5040 radios, do not disturb can be 
turned on and off via the user function menu.

Function Key Option: DTMF Mode

Description:
Pressing the function key turns DTMF overdialling mode on 
and off.

Applies To:
✘ Orca Elan
✔ Orca Excel
✘ Orca 5030
✘ Orca 5035
✔ Orca 5040

Function Key Option: Dynamic Power Control

Description:
Pressing the function key turns dynamic power control on 
and off.

Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca 5030
✔ Orca 5035
✔ Orca 5040

Function Key Option: Handset Mode

Description:
Pressing the function key turns handset operation on and off.

Handset mode automatically turns off after the handset inac-
tivity timer expires. The handset inactivity timer is set in the 
Key Settings II tab.

DTMF overdialling

The DTMF overdialling feature 
allows the radio user to dial DTMF 
strings using the numeric keypad.

dynamic power control

Dynamic power control optimises the 
radio’s power use by reducing the 
transmit power in high signal strength 
areas.

handset operation

Tait Orca radios can be operated as a 
normal radio where the user holds the 
radio with the microphone about 15 
cm away from the mouth or it can be 
operated like a telephone handset. 
Handset mode is useful in noisy envi-
ronments, when privacy is required or 
in quiet environments when the lowest 
volume setting seems too loud.
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Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca 5030
✔ Orca 5035
✔ Orca 5040

Alternatives:
On Orca 5035 and Orca 5040 radios, handset mode can be 
turned on and off via the user function menu.

Function Key Option: Keypad Lock

Description:
Pressing the function key locks the keypad so the keys cannot 
be activated accidentally. Which keys are locked depends on 
how the radio was programmed (Keypad Lock Disables, Key 
Settings II tab).

A long press of the clear key ( ) turns off keypad lock. 

Applies To:
✘ Orca Elan
✔ Orca Excel
✘ Orca 5030
✔ Orca 5035
✔ Orca 5040

Alternatives:
On Orca 5035 and Orca 5040 radios, keypad lock can be 
activated via the user function menu.

Function Key Option: Low Power

Description:
Pressing the function key overrides the power level setting 
programmed for the channel in the Trunked Channel Blocks 
form or the Conventional Channels form so that the radio 
transmits at low power. Pressing the function key again 
returns the transmit power to the preprogrammed level. 
Whether low power transmit is on or off when the radio 
powers up is determined by the Initial Low Power Transmit 
Setting field (User Selectable Parameters form).

Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca 5030
✔ Orca 5035
✔ Orca 5040



102 Key Settings Form   © Copyright Tait Electronics Ltd, 2004

Alternatives:
Channels can be programmed to always transmit at low 
power (Power Level field, Trunked Channel Blocks form, 
Power Level field Conventional Channels form). On Orca 
5035 and Orca 5040 radios, low power transmit can be acti-
vated via the user function menu.

Function Key Option: Monitor

Description:
Pressing the function key turns monitor on and off.

Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca 5030
✔ Orca 5035
✔ Orca 5040

Alternatives:
On Orca Excel radios, a long press of the clear/monitor key 
( ) turns monitor on and off.

Function Key Option: Night Use

Description:
Pressing the function key turns the night use feature on and 
off. Whether night use is on or off when the radio first pow-
ers up is determined by the Initial Setting for the Night 
Operation Backlighting level field (User Selectable Parame-
ters form).

Applies To:
✘ Orca Elan
✔ Orca Excel
✘ Orca 5030
✔ Orca 5035
✔ Orca 5040

Alternatives:
On Orca 5035 and Orca 5040 radios, night use can be turned 
on and off via the user function menu. 

Function Key Option: Preset Calls

Description:
Pressing the function key sends a preset call.

monitor

When the radio is operating on con-
ventional channels, monitor allows 
the radio user to override a channel’s 
signalling and so hear all traffic on a 
channel.

night use

When the night use feature is on, the 
radio’s backlighting activates when-
ever valid activity is detected, a key on 
the radio is pressed or when the radio 
receives a call. Backlighting remains 
on for the duration of the backlighting 
timer unless further activity is 
detected.
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Applies To:
✔ Orca Elan
✔ Orca Excel
✔ Orca 5030
✔ Orca 5035
✔ Orca 5040

Alternatives:
On Orca Excel and Orca 5040 radios, calls can also be dialled 
using the keypad.

Function Key Option: Site Select

Description:
Pressing the function key allows the user to select a control 
channel to which the radio must tune. Pressing the assigned 
function key again resumes normal hunting.

Applies To:
✘ Orca Elan
✔ Orca Excel
✘ Orca 5030
✔ Orca 5035
✔ Orca 5040

Alternatives:
On Orca 5035 and Orca 5040 radios, Select Site can be 
turned on and off via the user function menu. 

Function Key Option: Queue On/Off

Description:
The QUEUE menu option allows the user to turn call queu-
ing on and off.

Applies To
✘ Orca Elan
✘ Orca Excel
✘ Orca 5030
✔ Orca 5035
✔ Orca 5040

Alternatives:
On Orca 5035 and Orca 5040 radios, the radio queue can be 
turned on and off via the user function menu. 

 

call queuing

If the radio user is unable to answer 
calls immediately, they can be stored 
in the call queue so that the user can 
call back later. On Orca Elan and 
Orca 5030 radios, only one unan-
swered call can be queued. On Orca 
Excel, Orca 5035 and Orca 5040 
radios, up to 20 calls can be stored.
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Function Key Option: Lone Worker

Description:
Pressing the function key activates the lone worker feature 
and begins the Inactivity Timer.

Applies To:
✘ Orca Elan
✘ Orca Excel
✔ Orca 5030
✔ Orca 5035
✔ Orca 5040

Function Key Option: SOS Call

Description:
Pressing the function key sends an SOS call to the sequence 
entered in the Call String field (SOS Options form). 

Applies To:
✘ Orca Elan
✘ Orca Excel
✔ Orca 5030
✔ Orca 5035
✔ Orca 5040
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Key Settings II Tab
Set function key options, including handset mode options, in 
the Key Settings II tab. The Key Settings II tab is shown 
below.

Handset Volume Override
The radio can be programmed to use the function keys as 
volume keys while the radio is in handset mode. The volume 
increase and volume decrease settings can be assigned to short 
or long presses of function key 1 and function key 2. The 
programmed settings for the selected keypresses are overrid-
den for use as volume keys while handset mode is active. 
Note that if a function key is set to turn handset mode on and 
off, the application does not allow you to select that function 
key setting for controlling volume in handset mode.

Handset Inactivity Timer
The field Handset Inactivity Timer sets the amount of time 
the radio remains in handset mode if no transmissions are 
made.

Set a value from 0 to 240 seconds in steps of 1 second. If set 
to 0, the timer is disabled and the radio remains in handset 
mode until the user disables it.

Note that when a call is received and handset mode is active, 
the ringing volume is also reduced. While handset mode is 
active, the user may not hear received calls due to the low 
ringing volume. You may wish to set Handset Inactivity 
Timer to a value other than 0 in order to minimise the 
chances of missing calls because handset mode is active.
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Keypad Lock Disables
Keypad lock is available on Orca Excel, Orca 5035 and Orca 
5040 radios.

The Keypad Lock Disables fields determine what keys the 
keypad lock disables when it is activated. Keys that can be 
disabled are:

� PTT key

� function keys

� numeric keys (Orca Excel and Orca 5040 only)

� an external PTT key, e.g. on a lapel microphone

� external function keys

� menu/mode keys

Tick the box for each of the keys you wish to be disabled 
when the keypad lock is activated.

 The clear key can never be locked.

keypad lock

The keypad lock prevents accidental 
operation of the radio by locking the 
keypad so that only a certain set of 
keys can be used.
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User Selectable Parameters Form

The User Selectable Parameters form determines the user 
interface options for the radio. The form is divided into three 
tabs: General, Display and Tones:

NOTE: For each parameter, Initial Setting indicates that 
the setting can be modified by the radio user. When ticked, 
the parameter will be enabled when the radio is pro-
grammed.

General Tab
Set user interface options for features such as the default 
microphone and power settings.

The General tab is shown below:

Default Microphone
The setting of the Default Microphone field determines 
which microphone operates during normal operation. Select 
Top or Bottom, using the drop-down menu. While the 
radio is in handset mode, the bottom microphone operates, 
regardless of the setting of this field.

If the radio being programmed is not capable of supporting 
this feature, the Default Microphone feature is set to Bottom 
when the radio is programmed. Radios with a blue function 
key 1 support this feature.

handset operation

Tait Orca radios can be operated as a 
normal radio where the user holds the 
radio with the microphone about 15 
cm away from the mouth, or it can be 
operated like a telephone handset. 
Handset mode is useful in noisy envi-
ronments, when privacy is required, or 
in quiet environments when the lowest 
volume setting seems too loud.
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PTT Initiates a Call
This field is available for Orca Elan, Orca Excel and Orca 
5030 radios.

The setting of the PTT Initiates Call field determines 
whether a press of the PTT initiates a call request.

For Orca Elan and Orca 5030 radios, PTT Initiates Call 
should be enabled.

The PTT on Orca 5035 and Orca 5040 radios initiates a call 
by default if the PTT is not locked. The PTT is locked if the 
Keypad Lock Disables option for PTT (Key Settings II tab) 
is ticked. Keypad Lock is accessed by a function key preset, 
or KEYLOCK, using the user function menu.

Menu Button Initiates Call
The Menu Button Initiates Call field only applies to Orca 
5035 and Orca 5040 radios.

When enabled, this field lets you initiate a call by simply 
pressing the Menu Accept Key. 

Initial Low Power Transmit Setting
The Initial Low Power Transmit Setting field determines 
whether all transmissions are made at low power or at the 
power level programmed for a channel. Tick the Initial Low 
Power Transmit Setting box if all transmissions are to made 
at low power by default when the radio first powers up.

Orca 5035 and Orca 5040 radios can enable or disable low 
power transmit via the user function menu. This is defined 
on the User Defined Menu Form, by ticking the LOW 
PWR box.

All radios can enable or disable low power via a function key 
preset using the Low Power option (Key Settings I tab).

Audio Noise Reduction
When the Audio Noise Reduction field is checked, weak 
signals such as background noise are reduced when the mute 
is open and nobody is talking on the channel. This applies to 
all channels. 

Reregister on Power-up
The Reregister on Power-up field determines whether the 
radio is automatically re-registered with the trunked network 
each time the radio is powered-up. If checked, the radio will 
be forced to reregister with the trunked network each time 
it is turned on.

Dynamic Power 
Dynamic power control optimises the radio’s power use by 
reducing the transmit power in high signal strength areas. 
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Initial Setting
The Initial Setting field determines whether or not Dynamic 
power control is enabled when the radio first powers up.

Orca 5035 and Orca 5040 radios can enable or disable 
dynamic power control via the User Function Menu. This is 
defined on the User Defined Menu Form, by ticking the 
DYN PWR box.

All radios can enable or disable dynamic power control via a 
function key preset using the Dynamic Power Control 
option (Key Settings I tab).

Power Reduction Level
The Power Reduction Level field sets the receive power 
level for the Dynamic Power Control feature, at which point 
the transmit power will be reduced.

The value specified in the Power Reduction Level field is the 
number of dB above the LØ (zero) at which the radio will 
switch to low power.

Enter a value between 0 and 255. The default is 32.

Display Tab
Set user interface options for display information such as 
Network Information, Power-up Message, Night Operation 
Backlighting and Channel Display.

The Display tab is shown below: 
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Network Information
The Network Information settings determine the network 
information to be displayed on power-up.

Network Name
Although Orca Elan and Orca 5030 radios do not display the 
Network Name, this field can be programmed as an aid to 
identifying radios.

The Network Name field shows the name of the network, 
which will be displayed during the power-up sequence. 
Enter a name of up to 8 characters (Orca 5035 and Orca 5040 
radios), or 12 characters (Orca Elan, Orca Excel or Orca 
5030 radios) from:

A to Z 0 to 9 ! # $ % ^ & * + - = { } ( ) [ ] < > : ; ? | , . _ 
" ’ space

Display Radio Information on Power-up
The Display Radio Information on Power-up field only 
applies to Orca 5035 and Orca 5040 radios.

When it is enabled, the name of the network together with 
the radio network ID is displayed when the radio is switched 
on. This information appears before the power-up message.

Power-up Message
The Power-up Message fields set the power-up message, 
which can be up to 24 characters chosen from:

A to Z 0 to 9 ! @ # $ % ^ & * + - = { } ( ) [ ] < > : ; ? | , 
. _ " ’ space

Enter up to 12 characters in each box, including leading 
spaces if you want the message to be centred. 

Although Orca Elan and Orca 5030 radios do not display a 
power-up message, the Power-up Message fields can be pro-
grammed as an aid to identifying radios.

Night Operation Backlighting
The Night Operation Backlighting group box enables the 
night use feature and sets the backlighting duration.

The Network Information group box contains the following 
fields:

Initial Setting
Tick the Initial Setting box to enable night use.

Backlighting Timer
The Backlighting Timer field sets the duration of the back-
lighting timer. Enter a value between 1 and 10 seconds in 
steps of 1 second.

power-up message

The power-up message is the message 
displayed after the radio is turned on.

night use

When the night use feature is on, the 
radio’s backlighting activates when-
ever valid activity is detected, a key on 
the radio is pressed, or when the radio 
receives a call. Backlighting remains 
on for the duration of the backlighting 
timer unless further activity is 
detected.
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Channel Display
The Channel Display feature is not available on Orca Elan or 
Orca 5030 radios.

Channel Display allows the radio user to view the current 
control channel. If the radio is hunting then the user will 
observe the control channel changing rapidly. However, if 
there are other messages present on the display then the dis-
play of the control channel will take lowest priority.

If Channel Display is enabled, the radio will also display the 
traffic channel while it is engaged in a call. Once the call has 
been cleared down, the control channel will again be dis-
played.

Tones Tab
Select confidence tone sets, enable Audible Indicators, and 
set Alert Durations and Ring Patterns. The Tones tab is 
shown below: 

Audible Indicators
The Audible Indicators group box enables and configures 
audible indicators such as keypress confidence tones and 
other warnings. The settings in this group box do not affect 
DTMF sidetones.

Enabled – Initial Setting
Tick the Enabled – Initial Setting box to enable audible indi-
cators.

The setting of this field overrides that of the Keypress Con-
fidence Tones field.

audible indicators

Audible indicators include keypress 
confidence tones, received call signals, 
low battery and high temperature 
warnings, transmit timer and unan-
swered call signals.
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Initial Indicator Level
The Audible Indicator Level field sets the volume of the 
radio’s audible indicators. Select High or Low using the 
drop-down menu. If the Audible Indicators Initial Setting is 
disabled, the setting of this field will have no effect.

Tone Set
The Tone Set field determines the confidence tones and 
radio tones the radio uses. Two tone sets are available for Tait 
Orca radios: Tait and MPT 1343. Select the preferred tone 
set using the drop-down menu.

When the Tait tone set is selected, the tone option fields can 
be enabled or disabled by ticking or unticking the appropri-
ate box.

When MPT 1343 is selected, the first three tone options are 
greyed out. In this mode only the Queue Call option can be 
enabled or disabled. 

NOTE: The Status, SDM, and Ring Patterns fields are una-
vailable in MPT 1343 mode.

Keypress Confidence Tones
The Keypress Confidence Tones field enables and disables 
keypress confidence tones.

Enabled – Initial Setting
Tick the Initial Setting box to enable keypress confidence 
tones.

NOTE: If the Audible Indicators Initial Setting field is not 
ticked, keypress confidence tones are disabled, regardless of 
the setting of Keypress Confidence Tones. The tone set used 
is specified in the Tone Set field.

To set the volume for the Keypress Confidence Tones, use 
the Initial Indicator Level drop-down field in the Audible 
Indicators group area.

 Mimic Full Off Air Call Setup
The Mimic Full Off Air Call Setup feature provides an alter-
native option when the network does not support the Full 
Off Air Call Setup. 

When enabled, the radio that has been called will ring for the 
duration specified in the Alert Duration field. The radio 
receiving the call will transmit a ringing tone to the caller, 
indicating that the call has not been answered. If the radio 
receiving the call is not answered within the time specified in 
the Alert Duration field, the call will be cleared down (can-
celled).

keypress confidence tones

Keypress confidence tones are a confi-
dence indicator that tells the radio user 
whether or not an action is permitted 
whenever a keypad key or function 
key is pressed.
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Enabled
To enable the Mimic Full Off Air Call Setup, tick the Ena-
bled box. To disable, untick the Enabled box.

Alert Duration
To specify an Alert Duration, enter a numerical value in the 
Alert Duration field from 0 to 255 seconds, in steps of 1 sec-
ond. 

Status
The Status group box enables and configures Audible Alerts 
for Status Calls. When a Status Call is received, the phone 
will ring with the specified Ring Pattern.

Alert Duration
To set the Alert duration, enter a numerical value in the Alert 
Duration field from 0 to 255 seconds, in steps of 1 second. 
To disable the Status Alert, set the Alert Duration field to 0.

Ring Pattern
To specify the Ring Pattern, enter an 8-digit code using the 
numerical values 1 and 0, where 1 indicates a tone, and 0 
indicates a gap. 

The Status fields will only be available when the Tait Tone 
Set is selected.

Short Data Message (SDM)
The SDM group box enables and configures Audible Alerts 
for Short Data Messages. When an SDM Call is received, the 
phone will ring with the specified ring pattern.

Alert Duration
To set the Alert duration, enter a numerical value in the Alert 
Duration field from 0 to 255 seconds, in steps of 1 second. 
To disable the SDM Alert, set the Alert Duration field to 0.

Ring Pattern
To specify the ring pattern, enter an 8-digit code using the 
numerical values 1 and 0, where 1 indicates a tone, and 0 
indicates a gap. The SDM fields will only be available when 
the Tait Tone Set is selected.

Ring Patterns
The Ring Patterns group box enables and configures the 
caller alert the radio will give when a specific call type is 
received. 

To specify a ring pattern, enter an 8-digit code using the 
numerical values 1 and 0, where 1 indicates a tone and 0 
indicates a gap. For example, the code 11110000 would 
sound as one long ring followed by a pause of equal length, 
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and the code 11001100 would sound as a short ring followed 
by a pause, then another short ring and another pause. The 
ring pattern for each type of call should be unique. 

NOTE: In order to access the Ring Patterns field, either 
Mimic Full Off Air Setup or Full Off Air Call Setup (found 
in the Fleet Parameters Form) must be enabled.

Reset to defaults
The Reset to Defaults button restores all fields to their orig-
inal setting, with the exception of the Initial Indicator Level 
and the Tone Set field.
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Short Data Messages Form

Enter settings for Orca 5035/5040 Short Data Messages 
(SDMs) on the Short Data Messages Form. This form is not 
available for Orca Elan, Orca Excel and Orca 5030 radios. 
The Short Data Messages form is shown below:

TGI
TGI is the Individual Incoming Short Data Timer. It defines 
the length of time that the radio shall wait for further signal-
ling, if it expects any, during an individual short data call. If 
the TGI time elapses the current short data transaction is reset 
and future short data signalling is assumed to be a new trans-
action.

Valid entries are from 0 to 16.

TGG
TGG is the Group Incoming Short Data Timer. It defines 
the length of time that the radio shall wait for further signal-
ling, if it expects any, during a group short data call. If the 
TGG time elapses the current short data transaction is reset 
and future short data signalling is assumed to be a new trans-
action.

Valid entries are from 1 to 30.
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SDM Presets
Five SDM Presets are available for the 5035 and 5040. Each 
preset has a unique ID that cannot be changed and a string of 
up to 24 characters.

Valid characters are those which have ASCII values from 32 
to 122. That is, upper and lower case letters, numbers and 
most symbols.

In order to send an SDM Preset the Enter SDM menu item 
must be selected on the User Defined Menu form.
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Part 5: Reference
This part outlines basic concepts related to the Trunked Programming 
Application.

Appendices

� Appendix A: Introduction to Trunking

� Appendix B: Selecting Groups

� Appendix C: Switching to Conventional Channels

� Appendix D: Squelch and Signalling in Conventional Mode

� Appendix E: Introduction to DTMF

� Appendix F: Radio Features

� Appendix G: What’s New - Orca 5000 Series
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Appendix A: Introduction to Trunking

A trunking system is an efficient alternative to a conventional 
repeater-based system. In a conventional system, radio users 
compete for access to individual channels, and one channel 
can be overloaded with traffic while others are virtually 
unused. A trunking system allows the automatic sharing of 
several channels by a number of radio users. Channels are 
pooled and allocated on demand for the duration of a call. As 
calls are completed, the channels are returned to the pool for 
allocation for other calls. Channel use is, therefore, optimised 
and the time each user must wait to make a call is reduced, 
as shown below.

Thus each user has access to any free channel in a system. 
However, this access is under control of the trunking system 
and not under user control in much the same way as sub-
scribers on the public switched telephone network make calls 
with equal priority but do not dictate the route that their call 
takes.

The function of the trunking system is complex; however, 
radio operation is simple because the system protocol and 
internal processing are transparent to the radio user. The use 
of microprocessors throughout the system adds features not 
found on conventional systems. Automatic call logging assists 
in monitoring the general performance on the system and 
provides data to bill trunking system subscribers according to 
their individual on air time.

Control Channel Communication
One channel is designated the control channel, which the 
trunking system controller (TSC) uses to communicate with 
all radios on the system. Radios listen to the control channel 
until they are directed to a traffic channel to participate in a 
call. Traffic channels are allocated by the channel control 
module for the duration of the call. At the end of a call, the 
radios revert back to monitor the control channel. The traffic 

channel

A channel is a pair of radio frequen-
cies, one used for transmitting and one 
used for receiving. In trunking sys-
tems, the term channel can also refer to 
the equipment at a site that is used to 
receive, modulate and transmit com-
munications on a particular frequency. 

repeater

A repeater receives a radio signal and 
retransmits it. Use of a repeater 
increases the coverage area of a two-
way radio system and ensures more 
reliable performance in areas where 
signals are reflected or attenuated by 
buildings or terrain. In a repeater-
based system, the radio’s transmit fre-
quency is the frequency the repeater is 
listening on, and the radio’s receive 
frequency is the frequency the repeater 
rebroadcasts signals on.

Key:
Call in progress

Caller waiting

Conventional Radio 
Channels

Trunked Radio 
Channels

control channel

In a trunking system, the control 
channel is used by the site to let the 
radio units in the site’s coverage area 
know when they can transmit their 
call information.

trunking system controller

In MPT 1327 the trunking system 
controller (TSC) is the central intelli-
gence necessary to enable the trunking 
system to function. The TSC com-
municates with all radios on the net-
work via the control channel.
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channel is released into a standby mode awaiting the next 
allocation for a call.

The control channel communicates with the radios on the 
system using codewords. Every codeword is 64 bits long and 
consists of 48 bits of data and a 16-bit cyclical redundancy 
code (CRC), which is used for error checking. The code-
words are sent over the control channel using fast frequency 
shift keying (FFSK), where a 1200 Hz tone represents digital 
one and an 1800 Hz tone represents digital zero.

A protocol called “slotted Aloha” is used to communicate 
over the control channel. All radios monitor the control 
channel’s frequency, communicating continuously with the 
TSC using the appropriate codewords. Every second the 
TSC broadcasts approximately 20 codewords to the radios, 
and every second there are approximately 10 opportunities 
for radios to send codewords to the TSC. In simple terms, 
the codewords sent from the TSC ask each radio in turn “do 
you want to make a call?” If the radio user has not initiated 
a call, the radio will respond “no”. If a call has been initiated, 
the radio will respond “yes”, together with the identity of the 
called party and the type of call.

The system can be set up so that different channels act as the 
control channel at different times. The system can also be set 
up so that if a priority call is attempted when there are no free 
channels, the control channel can temporarily act as a traffic 
channel.

A radio remains on the control channel until it requests and 
receives permission to make a call or until it is notified that a 
call is being set up. The call setup process for a radio-to-radio 
call in which the called radio is free and the calling radio ends 
the call is illustrated below.

Radio 
A

Radio 
BTSC

Control
channel

signalling

Traffic
channel

signalling

Radio B accepts 
incoming voice call

Radio A requests a 
call to Radio B TSC informs 

Radio B that a call 
is incoming

Radio A goes to 
channel allocated 

for call

Radio A requests 
disconnection

Call in progress

Radio B goes 
channel allocated 

for call

Call in progress

TSC directs Radio B 
to clear down call
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When the call is cleared down, both radios again monitor the 
control channel.

Early Trunking Systems
Early trunking systems were usually based on five-tone 
Selcall or DTMF signalling but they had no common stand-
ard.

Over time, the radio spectrum became more crowded and so 
having some channels overloaded while others were virtually 
unused became less acceptable. In the early 1980s it become 
apparent that more efficient management of the frequency 
spectrum was necessary. The MPT 1327 and MPT 1343 
standards were developed as part of the drive to make more 
efficient use of the frequency spectrum.

Both standards were published by the United Kingdom 
Department of Trade and Industry. MPT 1327 describes a 
signalling standard for trunked private land mobile radio sys-
tems. It describes the protocol used for communication 
between a trunking system controller (TSC) and the radios 
on the network. MPT 1343 describes the radio interface and 
outlines the minimum performance requirements for radios 
operating on MPT 1327-compliant networks. In short, 
MPT 1327 describes the communications protocol used 
between the network and the radios on the network, 
whereas MPT 1343 describes the radio performance and the 
interface between the radio and the radio user. The interac-
tions on an MPT network are illustrated below.

Selcall

Selcall stands for “selective calling”, 
which is a signalling system that uses 
sequences of audible tones to isolate 
calls intended for specific radios. 

DTMF

DTMF (dual tone multiple fre-
quency) is the tone-based system used 
for the world’s telephone networks. A 
DTMF “tone” actually consists of a 
pair of tones. DTMF tones are some-
times referred to as “touch tones”. 

MPT 1343

MPT 1327

MPT
1327

MPT
1327

MPT
1327

MPT
1327

Trunking Network

Telephone

PSTN

MPT
1327

PABX

Telephone

MPT 1327
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Since MPT 1327 and MPT 1343 were published, a number 
of variants of the MPT 1343 specification have arisen that 
offer different radio-user interfaces, which are commonly 
referred to as dialling schemes. Tait trunked radios are 
designed to operate on MPT 1327-compliant networks and 
support the following MPT 1327-compatible dialling 
schemes:

� MPT 1343

� CPSX

� Nokia ANN

� ZVEI

� Number Presets

Addressing
A unique identity number is programmed into each radio 
operating on a trunking network so the radio can be con-
tacted by the TSC and, thus, by the other users of the system. 
The identity number consists of a unique number for the 
radio and numerical information shared with the other mem-
bers of the same organisation, or fleet. The identity of each 
radio provides a unique address that allows it to be contacted 
by members of the same fleet and other fleets using the same 
trunking network.

MPT 1327 and MPT 1343 specify different but related num-
bering schemes for addressing trunked radios.

� MPT 1327 specifies the numbering scheme used for 
identifying radios on a network. MPT 1327 numbers are 
used for all communications between all elements of the 
trunking network, including the radios operating on that 
network.

� MPT 1343 specifies the numbering scheme used by radio 
users. The MPT 1343 numbering scheme is simpler than 
the MPT 1327 format and allows radio users to address 
radios without having to remember long addresses. Typ-
ically it is possible to make a call by dialling only a two- 
or three-digit number.

As discussed in “Early Trunking Systems” on page 121, var-
iants of the MPT 1343 specification have arisen that offer dif-
ferent radio-radio user interfaces, which are commonly 
referred to as dialling schemes. These dialling schemes 
include:

� CPSX dialling

� Nokia ANN

� ZVEI

MPT 1327 numbering is described below, and MPT 1343 
numbering is described on page 123. CPSX dialling is dis-
cussed on page 124.

CPSX dialling

CPSX dialling is a dialling scheme 
designed for use on Chinese networks 
that use 5-digit interfleet dialling. It is 
compatible only with other CPSX 
dialling trunking systems.

Nokia ANN

Nokia ANN (Algorithmic Network 
Numbering) is a dialling scheme 
designed for use on Nokia Actionet 
networks. It differs from MPT 1343 
in the way it divides up fleets. Nokia 
ANN numbering reduces the number 
of digits that must be dialled for calls 
between fleets.

ZVEI

ZVEI is a dialling scheme based on 
the MPT 1343 dialling scheme. The 
ZVEI dialling scheme is used on 
Regionet 43 networks.
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MPT 1327 Numbering
MPT 1327 numbers are used by the trunking system control-
ler for communicating with radios and other devices on the 
network.

Under MPT 1327, each radio is assigned a unique identity as 
follows:

The 3-digit prefix merely extends the range of numbers 
available for addressing. 

The available idents (1 to 8100) are divided to provide indi-
vidual and group addresses. A block of idents are usually allo-
cated for use by a particular fleet. Idents 0 and above 8100 are 
reserved for addressing special destinations, such as PABX 
and PSTN numbers.

MPT 1343 Numbering
Under MPT 1343, radios on a network are divided into 
fleets. Since a trunking system is used by many different 
organisations, a fleet usually includes all the radios of a single 
organisation, although a large organisation could have several 
fleets on the network.

All radios within a fleet have the same fleet number and it is 
usually possible to make calls between radios in different 
fleets. Each radio in a fleet has a two- or three-digit unit 
number that is assigned to only one radio in the fleet. If the 
radio number is two digits, there can be up to 70 radios in 
that fleet; if the radio number is three digits, there can be up 
to 700 radios in the fleet. The diagram below illustrates MPT 
1343 radio numbering.

p p p / i i i i

3 digit prefix 
between 0 
and 127

4 digit ident 
between 1 
and 8100

p p p / f f f f / u u

3-digit prefix between 
200 and 327

p p p / f f f f / u u u

4-digit fleet number 
between 2001 and 6050

2-digit unit number 
between 20 and 89, 

or a 3-digit unit 
number between 

200 and 899
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MPT 1343 allows radios to be grouped together so that calls 
can be received simultaneously. A range of numbers (called 
group numbers) are reserved for identifying groups of radios, 
and one or more radio units may be associated with that 
group number (subscribed to the group). These two- or 
three-digit group numbers are used in place of the radio unit 
number, as illustrated below.

To make a call to another radio, the radio user dials an MPT 
1343 number, which is converted to MPT 1327 for commu-
nication with the TSC and the receiving radio. In the receiv-
ing radio, the MPT 1327 number is converted to MPT 1343 
for displaying to the radio user.

In order for the addresses to be converted correctly:

� the trunking system must be aware of how the available 
idents are partitioned into fleets, and

� the radios must be aware of the base ident of their own 
fleet.

CPSX Dialling
As with MPT 1343 numbering, radios using CPSX dialling 
have a prefix, fleet number and unit number, as illustrated 
below. 

The prefix allocation is identical to MPT 1343, but:

� the fleet number is two digits, from 20 to 79

� the unit number is three digits, from 200 to 999

� unit numbers from 900 to 999 are reserved for groups

� individual and group numbers use the same fleet number.

p p p / f f f f / g g

p p p / f f f f / g g g

2-digit group number 
between 90 and 99, 

or a 3-digit group 
number between 900 

and 998

p p p / f f / u u u

3-digit prefix 
between 200 

and 327

2-digit fleet 
number from 

20 to 79

3-digit unit 
number from 
200 to 999*

*Unit numbers 900 to 999 are 
reserved for groups.
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Within each prefix, there are 8100 user addresses, which are 
divided into ten blocks of 810 addresses each. Three param-
eters, Large, Medium and Small, specify how the number 
and size of fleets within those blocks of 810 addresses. There 
are four options for fleet size:

� Large: 700 units

� Medium: 354 units

� Small: 236 units

� Tiny: 118 units.

The number of blocks allocated as large, medium, small and 
tiny fleets in a prefix is calculated as follows.

So if parameters Large, Medium and Small are 2, 7 and 9 
respectively, there are:

� 2 blocks of large fleets = 2 large fleets

� 5 blocks of medium fleets = 10 medium fleets

� 2 blocks of small fleets = 6 small fleets

� 1 block of tiny fleets = 6 tiny fleets

The allocation of fleets throughout the prefix’s 8100 idents, 
for this example, is as illustrated in the diagram below.

Note that within each prefix, fleets are grouped together 
according to size. That is, all large fleets will be allocated to 
the lower idents and all tiny fleets will be allocated to the 
higher idents.

Large fleets = l
Medium fleets = 2 (m - l)
Small fleets = 3 (s - m)
Tiny fleets = 6 (10 - s)

810 16200 2430 3240 4050 4860 5670 6480 7290

1619 2429809 3239 4049 4859 5669 6479 7289 8100

Large fleet

Medium fleet

Small fleet

Tiny fleet
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Within each fleet, there is a range of individual and group 
addresses. For each fleet size, the possibilities are:

Under CPSX dialling, the number of digits the radio user is 
required to dial is only five for interfleet calls (as opposed to 
6 or 7 under MPT 1343) and eight for interprefix calls (as 
opposed to 9 or 10 under MPT 1343). Radios can display the 
caller’s identity for interfleet and interprefix calls, whereas 
under MPT 1343 radios can only indicate that the call is from 
outside the fleet or prefix.

Fleet Size Radios Groups Radio Number Range Group Number Range

Large 700 100 200 to 899 900 to 999

Medium 354 51 200 to 553 900 to 950

Small 236 34 200 to 435 900 to 933

Tiny 118 17 200 to 317 900 to 916



© Copyright Tait Electronics Ltd, 2004  Selecting Groups 127

Appendix B: Selecting Groups

Groups set for Selectable, Scan or Scan + Selectable (Group 
Membership array in the Radio Identity form can be assigned 
to positions on the 16-way selector by setting them up as pre-
set calls numbered 1 to 16 or as function key preset calls.

For groups designated Selectable or Scan + Selectable, the 
groups number can be entered for Call String, or for the 
Function Key Preset Calls. When the user switches to the 
corresponding position on the 16-way selector or presses the 
assigned function key, the radio will be subscribed to the 
group. The radio will be unsubscribed when the user 
switches to another position or presses the assigned function 
key again.
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Appendix C: Switching to Conventional 
Channels

Conventional channels can be accessed as follows:

� They can be assigned to positions on the 16-way selector 
by setting them up as preset calls numbered 1 to 16. Enter 
the Access Number (Conventional Channels form) for 
the conventional channel in the Call String field (Preset 
Calls form).

� You can access Conventional Channels via the press of a 
function key. Enter a conventional channel into the Pre-
set Calls array, add the Preset ID to Function Key Preset 
Call 1 or 2 (Preset Calls form), and select the correspond-
ing Function Key Preset Call option (Key Settings I tab).

� For Orca 5035 or Orca 5040 radios, you can access con-
ventional channels using the User Defined Menu. Assign 
conventional channels to preset calls, and tick the 
SELECT PRESET box (User Defined Menu form).

� For Orca Excel or Orca 5040 radios, you can access con-
ventional channels by dialling the access number associ-
ated with the channel using the numeric keys on the key-
pad, then either the enter key (Orca Excel), Menu 
Accept key (Orca 5040) or PTT.



© Copyright Tait Electronics Ltd, 2004  Squelch and Signalling in Conventional Mode 129

Appendix D: Squelch and Signalling in Con-
ventional Mode

Tait Orca trunked radios can switch between trunking and 
conventional modes of operation. In conventional mode, a 
radio communicates directly with other radios or via a 
repeater rather than through the trunking system. Without 
some mechanism for filtering what the radio broadcasts to 
the user while in conventional mode, the radio’s speaker 
would operate continuously and the user would hear not 
only any speech on a channel, but also all noise. This would 
be annoying for the radio user and so the radio filters out 
unwanted signals using various methods.

Squelch
At the most basic level, the squelch feature ensures that the 
speaker only unmutes when an intelligible signal is received. 
A signal is considered intelligible when it is strong enough to 
exceed a predetermined squelch threshold.

Tait Orca radios can operate at two different squelch thresh-
olds, city squelch and country squelch. The specific values of 
city and country squelch are set at radio calibration time, but 
are generally:

� country: 12 dB SINAD

� city: 16 dB SINAD

The squelch threshold for city squelch is higher than that for 
country squelch so that the radio is effectively less sensitive 
on channels programmed with city squelch than on channels 
programmed with country squelch. City squelch is intended 
for use in environments where signal strength is likely to be 
strong throughout the area where the radio is operating and 
where a high level of background noise could cause the 
speaker to unmute for unintelligible signals were it set to a 
lower squelch threshold. Country squelch is intended for use 
in lower signal strength areas.

Programming Squelch Thresholds
At radio programming time, conventional channels are pro-
grammed for either city or country squelch in the Conven-
tional Channels form. A radio can have a mix of city and 
country squelch channels, which can be useful if a radio is 
going to be used in both high and low signal strength areas.

For example, two channels could be set up with the same 
transmit and receive frequencies and subaudible signalling 
but with different squelch levels. Both channels would have 
the same traffic and the radio operator could tune in to the 
city channel while they were close to the repeater. If the sig-
nal started to become less intelligible as the user started to 
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move away from the repeater, they could switch to the 
country channel. 

Mutes
A mute, or squelch, controls the circumstances under which 
a received signal is passed to the radio’s speaker. When a 
mute is active, the radio’s speaker only unmutes under cer-
tain conditions, determined by the type of signalling operat-
ing on a channel. 

Signalling
Squelch ensures that the radio user only hears intelligible sig-
nals, but the user hears all traffic on a channel. This could 
become a nuisance, particularly if several companies are using 
the same channel. Signalling provides a way of isolating 
groups of users so they only hear traffic intended for that 
group. It does not provide privacy since anyone tuning to a 
channel can hear its traffic if they wish, but it does minimise 
the possibility of radio users hearing nuisance traffic.

Signalling is non-voice coding on a channel for the purpose 
of identifying parties and/or segregating user groups. If a 
radio receives signalling that matches that programmed for 
the radio, the signalling is said to be valid and the radio’s 
mute opens. Otherwise, the transmission is ignored and the 
radio remains silent, although the radio’s channel busy indi-
cator is activated.

The types of signalling available for Tait Orca radios are 
CTCSS and DCS, although DCS signals can only be 
encoded and sent (not received and decoded) in Tait Orca 
Trunked radios. 

CTCSS and DCS
CTCSS and DCS use subaudible signalling to segregate 
groups of users by transmitting additional information with 
normal speech.

For CTCSS the additional information is transmitted in the 
form of subaudible tones in the frequency band 67 to 250.3 
Hz. For DCS the additional information is transmitted as 
digital data using frequencies between 10 and 134 Hz.

Subaudible signalling is assigned on a per channel basis, and 
each channel can have different receive and transmit signal-
ling. 

CTCSS

continuous tone controlled squelch sys-
tem

DCS

digitally coded squelch
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Tables 2, 3 and 4 show the CTCSS frequencies and DCS 
codes Tait Orca radios support.

Table 2: CTCSS Tone Frequencies Supported by Tait Orca Radios

67.0 77.0 88.5 100.0 114.8 131.8 151.4 173.8 203.5 233.6

69.3 79.7 91.5 103.5 118.8 136.5 156.7 179.9 210.7 241.8

71.9 82.5 94.8 107.2 123.0 141.3 162.2 186.2 218.1 250.3

74.4 85.4 97.4 110.9 127.3 146.2 167.9 192.8 225.7

Table 3: Standard DCS Codes and Their Inverses

Code : Inv Code : Inv Code : Inv Code : Inv Code : Inv Code : Inv Code : Inv

023 : 047 073 : 506 156 : 265 261 : 732 365 : 125 503 : 162 654 : 743

025 : 244 074 : 174 162 : 503 263 : 205 371 : 734 506 : 073 662 : 466

026 : 464 114 : 712 165 : 251 265 : 156 411 : 226 516 : 432 664 : 311

031 : 627 115 : 152 172 : 036 271 : 065 412 : 143 532 : 343 703 : 565

032 : 051 116 : 754 174 : 074 306 : 071 413 : 054 546 : 132 712 : 114

043 : 445 125 : 365 205 : 263 311 : 664 423 : 315 565 : 703 723 : 431

047 : 023 131 : 364 223 : 134 315 : 423 431 : 723 606 : 631 731 : 155

051 : 032 132 : 546 226 : 411 331 : 654 432 : 516 612 : 346 732 : 261

054 : 413 134 : 223 243 : 351 343 : 532 445 : 043 624 : 632 734 : 371

065 : 271 143 : 412 244 : 025 346 : 612 464 : 026 627 : 031 743 : 654

071 : 306 152 : 115 245 : 072 351 : 243 465 : 331 631 : 606 754 : 116

072 : 245 155 : 731 251 : 165 364 : 131 466 : 662 632 : 624

Table 4: Commonly Used DCS Codes and Their Inverses

Code : Inv Code : Inv Code : Inv Code : Inv Code : Inv Code : Inv

017 : 050 122 : 225 246 : 523 274 : 145 446 : 255 462 : 252

036 : 172 145 : 274 252 : 462 325 : 526 452 : 053 523 : 246

050 : 017 212 : 356 255 : 446 332 : 455 454 : 266 526 : 325

053 : 452 225 : 122 266 : 454 356 : 212 455 : 332
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Appendix E: Introduction to DTMF

DTMF (dual tone multiple frequency) is the tone-based sys-
tem used for the world’s telephone networks. A DTMF tone 
actually consists of a pair of tones.

Tait Orca radios can encode series of DTMF tones (referred 
to as DTMF strings) and so can make DTMF calls, but can-
not decode DTMF tones and so cannot receive DTMF calls. 
If the system a radio is operating on has access to systems that 
make use of DTMF tones, the radio can make DTMF calls 
to those systems. Examples of such systems are the public 
switched telephone network, message retrieval systems and 
telephone banking facilities.

DTMF Tone Transmission
How DTMF strings are transmitted is illustrated in the dia-
gram below.

The different timing parameters are programmable and are 
defined in the DTMF Parameters form.

The transmit key up delay is the time, in milliseconds, 
between when the transmission has been initiated (by the 
press of a function key, the DTMF key or the enter key) and 
the time transmission of the DTMF string actually starts. The 
transmit key up delay gives the repeater time to stabilise 
before the first DTMF tone is transmitted, and is set in the 
Transmit Key Up Delay field.

X is how long each tone in the string is transmitted, or the 
tone duration, in milliseconds. The minimum tone duration 
is programmable, as outlined below. The actual duration may 
be longer if the radio user presses the key for longer than the 
minimum tone duration.

� The duration of tones 0-9 and A-D is set in the Mini-
mum Tone Duration (0-9, A-D) field.

� The duration of tones * and # is set in the Minimum 
Tone Duration (*, #) field.

Y is the amount of time between the transmission of each 
tone in the string, or the gap duration, in milliseconds. The 
gap duration is set in the Minimum Intertone Gap field.

DTMF Overdialling
The DTMF dialling feature allows the radio user to dial 
DTMF strings using the numeric keypad. DTMF dialling is 
available on Orca Excel and Orca 5040 radios.

tone

A tone is a sound wave of a particular 
frequency. When defining DTMF 
strings, the different tones are repre-
sented by the characters 0-9, A-D, * 
and #. The frequencies used are deter-
mined by an internationally accepted 
standard.

DTMF string

A DTMF string is a series of DTMF 
tone pairs. 

transmit key 
up delay (ms) Tone 1

X
Gap

Y
Tone 2

X
Gap

Y
Tone 3

X
...
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DTMF overdialling features are set in the DTMF Parameters 
form.

� The Manual DTMF Dialling field enables and disables 
DTMF overdialling.

� The Interdigit Tx Hold Time field determines how long 
the radio keeps transmitting between the encoding of 
each tone.  This provides a delay for the user to dial the 
next digit without transmission stopping and restarting 
again. Some systems require continuous transmission 
between DTMF tones and for such systems, this field 
should be set to a long hold time.

� The PTT as Shift Key field enables and disables the PTT 
as shift key feature.
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Appendix F: Radio Features

This appendix lists the features available on Tait Orca radios 
and, if a feature is programmable, in what form or forms it is 
set up. See the glossary, starting on page 144, for descriptions 
of the features.

Man-Machine Interface

Feature
Orca 
Elan

Orca 
Excel

Orca 
5030

Orca 
5035

Orca 
5040

Where Programmed

Preset calls 20 20 20 100 100 Preset calls are programmed in the 
Preset Calls form.

PTT key ✔ ✔ ✔ ✔ ✔ Not programmable. However, the 
PTT key can be used for call initia-
tion; this option is enabled in the 
User Selectable Parameters form 
(PTT Initiates a Call field), or for Orca 
5035 and Orca 5040, in the User 
Defined Menu form (PTTLOCK) and 
Key Settings II tab (Keypad Lock Dis-
ables > PTT).

LED indicator ✔ ✔ ✔ ✔ ✔ Not programmable

Function keys ✔ ✔ ✔ ✔ ✔ Functions are assigned to function 
key settings in the Key Settings 
form.

Keypress confi-
dence tones

✔ ✔ ✔ ✔ ✔ Keypress confidence tones are ena-
bled and disabled in the User 
Selectable Parameters form. The 
option to toggle keypress confi-
dence tones on and off via a func-
tion key press is programmed in the 
Key Settings form. 
On 5035 and 5040 radios, the 
option to turn keypress confidence 
tones on and off via the user func-
tion menu is set in the User Defined 
Menu form (TONES option).

Handset opera-
tion

✔ ✔ ✔ ✔ ✔ Handset mode is assigned to a func-
tion key setting in the Key Settings 
form. On 5035 and 5040 radios, the 
option to turn handset mode on and 
off via the user function menu is set 
in the User Defined Menu form 
(HANDSET option).

Automatic acces-
sory detection

✔ ✔ ✔ ✔ ✔ Not programmable

Transmit timer ✔ ✔ ✔ ✔ ✔ Network Parameters form, TT field.
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16-way selector 
switch

✔ ✔ ✔ ✔ ✔ Preset calls (programmed in the Pre-
set Calls form) numbered 1 to 16 are 
automatically assigned to positions 
on the 16-way selector.

On/off volume 
control switch

✔ ✔ ✔ ✔ ✔ Not programmable

LCD display (2 x 
12 characters)

✘ ✔ ✘ ✔ ✔ Not programmable

Received signal 
strength indica-
tor

✘ ✔ ✘ ✔ ✔ Not programmable

Battery charge 
indicator

✘ ✔ ✘ ✔ ✔ Not programmable

Low battery 
warning

✔ ✔ ✔ ✔ ✔ Not programmable

Keypad lock ✘ ✔ ✘ ✔ ✔ Keypad lock is assigned to a func-
tion key setting in the Key Settings 
form. What keys are locked is also 
set in the Key Settings form.
On 5035 and 5040 radios, the 
option to activate keypad lock via 
the user function menu is set in the 
User Defined Menu form (KEYLOCK 
option).

Backlighting ✘ ✔ ✘ ✔ ✔ Backlighting is assigned to a func-
tion key setting in the Key Settings 
form.

Night use ✘ ✔ ✘ ✔ ✔ Night use is assigned to a function 
key setting in the Key Settings form.
On 5035 and 5040 radios, the 
option to turn night use on and off 
via the user function menu is set in 
the User Defined Menu form (NIGHT 
option).

International lan-
guage messages

✘ ✔ ✘ ✔ ✔ The language radio messages 
appear in is set in the  Specifications 
form.

Keypad keys 0 17 0 5 17 Not programmable

Numeric dialling ✘ ✔ ✘ ✘ ✔ Not programmable

Feature
Orca 
Elan

Orca 
Excel

Orca 
5030

Orca 
5035

Orca 
5040

Where Programmed
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Power Saving Features

Dialling Schemes

Feature
Orca 
Elan

Orca 
Excel

Orca 
5030

Orca 
5035

Orca 
5040

Where Programmed

Dynamic power 
control

✔ ✔ ✔ ✔ ✔ Dynamic power control is assigned 
to a function key setting in the Key 
Settings form.
On 5035 and 5040 radios, the 
option to turn dynamic power con-
trol on and off via the user function 
menu is set in the User Defined 
Menu form (DYN PWR option).

Low power 
transmit

✔ ✔ ✔ ✔ ✔ Low power transmit is assigned as a 
function key setting in the Key Set-
tings form. 
Channels can also be programmed 
to permanently transmit at low 
power (Power Level field, Trunked 
Channel Blocks form, Power Level 
field Conventional Channels form).
On 5035 and 5040 radios, the 
option to turn low power transmit 
on and off via the user function 
menu is set in the User Defined 
Menu form (LOW PWR option).

Feature
Orca 
Elan

Orca 
Excel

Orca 
5030

Orca 
5035

Orca 
5040

Where Programmed

MPT 1343 ✔ ✔ ✔ ✔ ✔ Select MPT1343 for the Dialling 
Scheme (Fleet Identity or Radio Iden-
tity forms).

Regionet (ZVEI) ✔ ✔ ✔ ✔ ✔ Select ZVEI for the Dialling Scheme 
(Fleet Identity or Radio Identity 
forms).

Nokia ANN ✔ ✔ ✔ ✔ ✔ Select Nokia ANN for the Dialling 
Scheme (Fleet Identity or Radio Iden-
tity forms).

CPSX dialling ✔ ✔ ✔ ✔ ✔ Select CPSX Dialling for the Dialling 
Scheme (Fleet Identity or Radio Iden-
tity forms).

number presets ✔ ✔ ✔ ✔ ✔ Select Number Presets for the Dial-
ling Scheme (Fleet Identity or Radio 
Identity forms). The radio user will 
only be able to dial the preset calls 
programmed in the Preset Calls 
form.
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MPT Network-Driven Function

Trunked Call Options

Feature
Orca 
Elan

Orca 
Excel

Orca 
5030

Orca 
5035

Orca 
5040

Where Programmed

Basic stun and 
revive

✔ ✔ ✔ ✔ ✔ Stun and revive is enabled and disa-
bled in the Fleet Parameters form. 
Stun and revive must be supported 
by the network.

Multi-network 
support

1 3 1 4 4 Select the Add Net button (or the 
Network>Add Network command) 
to add additional networks.

Feature
Orca 
Elan

Orca 
Excel

Orca 
5030

Orca 
5035

Orca 
5040

Where Programmed

Priority calls ✔ ✔ ✔ ✔ ✔ Not programmable. However, the 
only priority calls Orca Elan and Orca 
5030 radios can make are those pro-
grammed as preset calls (Preset Calls 
form).

Emergency call ✔ ✔ ✔ ✔ ✔ The number the emergency call will 
be sent to is specified in the Fleet 
Identity form (Prime Emergency 
Number field). On Orca Elan and 
Orca 5030 radios, an emergency call 
can only be made if one is pro-
grammed as one of the preset calls 
(Preset Calls form). On Orca Excel 
and Orca 5040 radios, the radio user 
can also dial an emergency call. If 
the user specifies a radio number 
when dialling the emergency call, 
the Prime Emergency Number is not 
used.

Group calls ✔ ✔ ✔ ✔ ✔ Group calling is enabled by entering 
a number other than 0 in the Fleet 
Group Number field (Fleet Identity 
form). The highest group number 
that can be called by any radio 
within a fleet is set in the Highest 
Group Number in Fleet field (Fleet 
Identity form).

Conference calls ✔ ✔ ✔ ✔ ✔ Conference calling is enabled if 
group calling is allowed. However, 
the only conference calls Orca Elan 
and Orca 5030 radios can make are 
those programmed as preset calls 
(Preset Calls form).
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Broadcast calls ✔ ✔ ✔ ✔ ✔ Broadcast calling is enabled if group 
calling is allowed. However, the only 
broadcast calls Orca Elan and Orca 
5030 radios can make are those pro-
grammed as preset calls (Preset Calls 
form).

Status calls ✔ ✔ ✔ ✔ ✔ Orca Elan and Orca 5030 radios can 
send status calls, if programmed as a 
preset call. However, Orca Elan and 
Orca 5030 radios cannot display a 
received status call.

PSTN calls ✔ ✔ ✔ ✔ ✔ PSTN calling is enabled in the Call 
Options form.

PABX calls ✔ ✔ ✔ ✔ ✔ PABX calling is enabled in the Call 
Options form.

Interfleet calls ✔ ✔ ✔ ✔ ✔ Interfleet calling is enabled in the 
Call Options form.

Interfleet group 
calls

✔ ✔ ✔ ✔ ✔ Interfleet group calling is enabled in 
the Call Options form.

ALLI calls ✔ ✔ ✔ ✔ ✔ All ident calling is enabled in the Call 
Options form.

Despatcher call-
back request

✔ ✔ ✔ ✔ ✔ The option to send despatcher call-
back requests is enabled in the Call 
Options form. The number the des-
patcher callback request will be sent 
to is specified in the Fleet Identity 
form (Prime Despatcher Number 
field). On Orca Elan and Orca 5030 
radios, a despatcher callback request 
can only be sent if the call is pro-
grammed as one of the preset calls 
(Preset Calls form). On Orca Excel 
and Orca 5040 radios, the radio user 
can also dial a despatcher callback 
request. If the user specifies a radio 
number when dialling the call, the 
Prime Despatcher Number is not 
used.

Last number 
redial

✔ ✔ ✔ ✔ ✔ Not programmable

Call diversion ✔ ✔ ✔ ✔ ✔ Not programmable. However, Orca 
Elan and Orca 5030 radios can only 
activate and deactivate call diversion 
if the required strings are pro-
grammed as preset calls (Preset Calls 
form).

Feature
Orca 
Elan

Orca 
Excel

Orca 
5030

Orca 
5035

Orca 
5040

Where Programmed
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Do not disturb ✔ ✔ ✔ ✔ ✔ Do not disturb is assigned to a func-
tion key setting in the Key Settings 
form.However, if no function key is 
assign the do not disturb option, 
Orca Elan and Orca 5030 radios can 
only activate and deactivate do not 
disturb if the required strings are 
programmed as preset calls (Preset 
Calls form).
On 5035 and 5040 radios, the 
option to turn do not disturb on and 
off via the user function menu is set 
in the User Defined Menu form 
(QUIET option).

Callback facility ✘ ✔ ✘ ✔ ✔ The callback facility is enabled in the 
Call Options form.

Unanswered call 
queuing

✘ ✔ ✘ ✔ ✔ Unanswered call queuing is enabled 
in the Call Options form (Call Queu-
ing set to Unanswered). If Call 
Queuing is set to Last, only the last 
call will be queued.
On 5035 and 5040 radios, the 
option to turn call queuing on and 
off via the user function menu is set 
in the User Defined Menu form 
(QUEUE option).

Full call queuing 
(up to 20 calls)

✘ ✔ ✘ ✔ ✔ Full call queuing is enabled in the 
Call Options form (Call Queuing set 
to Full or Unanswered).
On 5035 and 5040 radios, the 
option to turn call queuing on and 
off via the user function menu is set 
in the User Defined Menu form 
(QUEUE option).

Feature
Orca 
Elan

Orca 
Excel

Orca 
5030

Orca 
5035

Orca 
5040

Where Programmed
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Trunked Mode Functions and 
Features

Feature
Orca 
Elan

Orca 
Excel

Orca 
5030

Orca 
5035

Orca 
5040

Where Programmed

Preferential NDD 
hunt facility 
(home hunt)

✔ ✔ ✔ ✔ ✔ Preference data is defined in the 
NDD Preference Data array (Acquisi-
tion Data form.

Background 
search sequence

✔ ✔ ✔ ✔ ✔ The background search feature is 
enabled in the Hunting Parameters 
form. Parameters related to back-
ground searches include TL, TH, NS, 
NE, NR, LM1, LM2, LM3 and LM4 
and are set in the Network Parame-
ters form. What channels are sam-
pled is defined in the Normal Hunt 
Channels array (Hunting Parameters 
form) and preference data is defined 
in the NDD Preference Data array 
(Acquisition Data form). If a channel 
is consistently found for a certain 
number of consecutive samples to 
be preferred (according to the NDD 
preference data defined in the NDD 
Preference Data array) or stronger 
than the current control channel by 
a certain margin, the radio will per-
form a preferential hunt to acquire 
the new control channel.

Vote now ✔ ✔ ✔ ✔ ✔ Vote now is enabled in the Hunting 
Parameters form (Act On Vote Now 
field). The vote now advice margin is 
also set in the Hunting Parameters 
form.

Call cancellation ✔ ✔ ✔ ✔ ✔ The clear function is assigned to a 
function key setting in the Key Set-
tings form. Calls can also be can-
celled by switching to another 
position on the 16-way selector, and 
on Orca Excel radios, calls can be 
cancelled by dialling the string *#.

Trunked channel 
block frequency 
barring

✔ ✔ ✔ ✔ ✔ Factory only. Limitations to the 
range of frequencies available are 
set in the Trunked Channel Blocks 
form (Bar Access and Rx Partition 
Frequency fields).

User selectable 
talk groups

✔ ✔ ✔ ✔ ✔ What groups a radio belongs to is 
set in the Group Membership array. 
The number of groups a radio can 
belong to is set in the Maximum 
Number of Group Addresses field, 
and how the user selects groups is 
determined by the User Programma-
ble field. All fields are in the Radio 
Identity form.
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Conventional Mode Features

Manual site 
select

✘ ✔ ✘ ✔ ✔ Site select is assigned to a function 
key setting in the Key Settings form.
On 5035 and 5040 radios, the 
option to activate site select via the 
user function menu is set in the User 
Defined Menu form (SELECT SITE 
option).

Call time limit 
display

✘ ✔ ✘ ✔ ✔ Not programmable

Call time display 
count up/down

✘ ✔ ✘ ✔ ✔ Whether the duration or the time 
remaining for a call is displayed is set 
in the Call Timer Count Up field 
(Fleet Parameters form).

Control channel 
display

✘ ✔ ✘ ✔ ✔ Control channel display is set in the 
Hunting Parameters form (Channel 
Display field).

Feature
Orca 
Elan

Orca 
Excel

Orca 
5030

Orca 
5035

Orca 
5040

Where Programmed

Feature
Orca 
Elan

Orca 
Excel

Orca 
5030

Orca 
5035

Orca 
5040

Where Programmed

Conventional 
channels

10 10 10 10 10 Conventional channels are pro-
grammed in the Conventional 
Channels form. Conventional chan-
nels are accessed by dialling the 
Access Number set in the Conven-
tional Channels array. On Orca Elan 
and Orca 5030  radios, conventional 
channels can only be accessed if the 
Access Number is set for one of the 
preset calls (Preset Calls form).

CTCSS ✔ ✔ ✔ ✔ ✔ Channels are set for CTCSS in the 
Conventional Channels form

DCS (encode 
only)

✔ ✔ ✔ ✔ ✔ Conventional channels are set for 
DCS encoding in the Conventional 
Channels form.

Monitor function ✔ ✔ ✔ ✔ ✔ The monitor function is assigned to 
a function key setting in the Key Set-
tings form.
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Appendix G: What’s New - Orca 5000 Series

This section outlines new features for Orca 5030, Orca 5035 
and Orca 5040 radios. Each feature will be available on radios 
with the corresponding version number or higher.

Feature Form Firmware Version Database Version

Callback Cancel Call Options 4.21 2.07

Delete SDM Call In The 
Queue

Call Options 4.21 2.07

Enabled on Power On SOS Options 4.21 2.07

Worker Detection SOS Options 4.21 2.07

Selective Scan Selective Scan 4.16 2.06

Short and long press of 
external function keys

Key Settings 4.16 2.06

SOS calls SOS Options 4.16 2.06

Lone Worker SOS Options 4.16 2.06

Reregister on Power-up User Selectable 4.16 2.06

Short Data Messages Short Data Messages 4.13 2.05

Power Reduction Level User Selectable 4.13 2.05

Audio Noise Reduction User Selectable 4.13 2.05

Queue On/Off Key Settings 4.12 2.04
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Glossary

Terms in italics are defined in the glossary.

16-way selector The 16-way selector is the larger of the two switches on the top of each 
radio. Each position on the 16-way selector can be programmed to make a 
preset call, subscribe to a group, access a conventional channel or change to 
another trunking network.

access level The access level determines the fields and forms within the Trunked Pro-
gramming Application that are editable. The access level depends on the 
password entered, where the lowest access level requires no password.

accessory An accessory is an external device fitted to a radio, such as an external 
speaker microphone or lapel microphone. Accessories are fitted to the radio 
via the accessory connector on the back of the radio.

ACK ACK is short for acknowledgement. An acknowledgment is a signal sent by 
a called radio unit as part of the call setup procedure.

acquisition When a radio has successfully acquired a control channel, it is permitted to 
transmit and receive on that channel. The radio will listen to the control 
channel until it is directed to a traffic channel to participate in a call.

address The address is the 20-bit number by which a radio unit or group of units is 
known on a network 

address 
codeword

An address codeword is a 64-bit codeword that conforms to the requirements 
of MPT 1327 and in which the first bit is set to 1. An address codeword is 
always the first codeword in any message and defines the nature of the mes-
sage.

ALLI call An ALLI (all idents) call is a call to all radio units on a trunking system.

audible 
indicators

Tait Orca radios use combinations of audible indicators and visual displays 
to indicate the radio’s current state and activity.

Audible indicators include keypress confidence tones, received call signals, low 
battery and high temperature warnings, transmit timer and unanswered call 
signals.

Audible indicators are enabled in the User Selectable Parameters form.

 background 
search

A background search is carried out as part of the control channel acquisition 
procedure. The background search is a method prescribed in MPT 1343 for 
monitoring other control channels and migrating to a superior channel when 
one is found. The background search is performed by periodically leaving 
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the current control channel and sampling other control channels. What 
channels are sampled is specified in the Normal Hunt Channels array 
(Hunting Parameters form). If a channel is consistently found for a certain 
number of consecutive samples to be preferred (according to the NDD 
preference data defined in the Acquisition Data form) or stronger than the 
current control channel by a certain margin, the radio will perform a prefer-
ential hunt to acquire the new control channel.

backlighting The radio’s LCD lights up when there is activity on the radio, such as when 
a key is pressed or when a call is received.

Battery life can be extended by reducing the amount of time radio back-
lighting remains active.

Backlighting can be activated in two ways.

� A function key can be programmed to activate backlighting (Backlight-
ing On option).

� The radio can be programmed for night use, which can be turned on and 
off by the press of a function key (Night Use option) and on Orca 5035 
and Orca 5040 radios via the NIGHT user function menu option.

The value of the backlighting timer and how backlighting was activated deter-
mine how long backlighting remains on.

backlighting 
timer

The backlighting timer determines how long backlighting remains on once 
it is activated. There are two ways backlighting can be activated, and how 
it was activated affects how the backlighting timer operates.

� If activated via the Backlighting On function key setting, backlighting 
remains on for the duration of the backlighting timer.

� If activated via the Night Use function key setting or via the NIGHT 
user function menu option, backlighting remains on for the duration of the 
backlighting timer, which resets whenever a key is pressed or a call is 
received.

The duration of the backlighting timer is set in the User Selectable Param-
eters form.

bit Bit is an abbreviation for a binary digit consisting of either a 0 or a 1. Eight 
bits are equivalent to one byte.

broadcast call A broadcast call is a group call in which only the radio user who initiated the 
call may speak. Contrast with conference call.

In a broadcast call, all radios in the group are directed to the same traffic chan-
nel for the duration of the call. However, the call is cleared down as soon as 
the announcement is delivered and the recipients are not given an oppor-
tunity to respond.

byte A byte is a group of 8 bits. Half of a byte is a nibble. Computer memory is 
measured in kilobytes or megabytes.
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calibration Calibration is the process whereby a radio is electronically tuned. Orca Elan 
and Orca Excel radios are calibrated using a PC running either the Calibra-
tion System for Tait Orca Radios (DOS-based) or the Calibration Applica-
tion (Windows-based). Orca 5030, Orca 5035 and Orca 5040 radios are cal-
ibrated using the Windows-based Calibration Application.

call diversion Call diversion allows the radio user to divert received calls to another 
address, such as another radio or a PSTN or PABX number.

call queuing If the radio user is unable to answer calls immediately, they can be stored in 
the call queue so that the user can call back later. On Orca Elan and Orca 
5030 radios, only the last unanswered call can be queued. On Orca Excel, 
Orca 5035 and Orca 5040 radios, up to 20 calls can be stored.

callback When an incoming call is terminated, a radio may be programmed to dis-
play the caller’s identity. If the radio user wishes to call the party back, they 
can do so by pressing the enter key.

CCSC CCSC stands for Control Channel System Codeword. The CCSC is used 
in MPT 1327 and MPT 1343 to identify the system to radio units and pro-
vides synchronisation for the address codeword that follows.

channel A channel is a pair of radio frequencies, one used for transmitting and one 
used for receiving. In trunking systems, the term channel can also refer to 
the equipment at a site that is used to receive, modulate and transmit com-
munications on a particular frequency.

The channels used by the trunking system are set up in the Trunked Channel 
Blocks form. The channels used in conventional channel operation are set up in 
the Conventional Channels form.

channel spacing Channel spacing is the interval between channels. For Tait Orca radios, this 
is 12.5, 20 or 25 kHz. Wide Band radios can be programmed for operation 
on 20 and 25 kHz channels only. Universal Band radios can be programmed 
for operation on 12.5, 20 and 25 kHz channels.

Channel spacing for the trunking system channels is set in the Trunked Chan-
nel Blocks form. Channel spacing for conventional channel operation is set in 
the Conventional Channels form.

city squelch When a radio’s squelch threshold is programmed for city squelch, the radio is 
less sensitive to interference than if programmed for country squelch and so 
stronger signals are required for the radio’s speaker to unmute.

The value of city squelch is set at radio calibration time.

codeword Messages on a trunking system are transmitted as codewords. Every code-
word is 64 bits long and consists of 48 bits of data and a 16-bit cyclical 
redundancy code (CRC), which is used for error checking. The codewords 
are sent over the control channel using fast frequency shift keying (FFSK), 
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where a 1200 Hz tone represents digital one and an 1800 Hz tone represents 
digital zero.

The two types of codeword are: address codeword and data codeword.

comprehensive 
hunt

A comprehensive hunt is carried out as part of the control channel acquisition 
procedure. When the control channel acquisition procedure has failed to 
identify a suitable control channel, the radio will then search through all chan-
nels in the trunked channel blocks defined for the radio, except those specified 
as non-applicable in the Non Applicable Channels array.

conference call A conference call is a group call in which all group members can participate 
in the conversation. Contrast with broadcast call.

In a conference call, all radios in the group are directed to the same traffic 
channel for the duration of the call. All radios participate freely, as they 
would for a normal radio-to-radio call.

confidence 
indicator

Confidence indicators provide feedback to the radio user on how the cur-
rent operation is proceeding. For example, keypress confidence tones are the 
tones heard when a keypad key or a function key is pressed and tell the user 
whether or not an action is permitted.

contrast 
adjustment

The contrast adjustment feature allows the radio user to adjust the display 
contrast. Once activated, the radio user adjusts contrast using the scroll keys. 
The radio returns to its previous mode of operation after a few seconds of 
inactivity.

control channel In a trunking system, the control channel is used by the site to let the radio 
units in the site’s coverage area know when they can transmit their call 
information.

control channel 
acquisition

Control channel acquisition is the procedure by which a radio that is not cur-
rently on a traffic channel attempts to select a control channel. Control channel 
acquisition consists of hunting for a control channel and confirming that any 
candidate control channels are suitable to acquire.

conventional 
channel 
operation

A trunked radio can switch between trunking and conventional modes of 
operation. In conventional mode, a radio communicates directly with other 
radios or via a repeater rather than through the trunking system.

country squelch When a radio’s squelch threshold is programmed for country squelch, the 
radio is more sensitive than if programmed for city squelch and so the radio’s 
speaker unmutes more readily. When programmed for country squelch, the 
radio can be used in areas where the signal may be weak and where maxi-
mum range is desirable.

The value of country squelch is set at radio calibration time.



148 Glossary   © Copyright Tait Electronics Ltd, 2004

CPSX dialling CPSX dialling is a dialling scheme designed for use on Chinese networks that 
use 5-digit interfleet dialling. It is compatible only with other CPSX dial-
ling trunking systems. 

Unlike radios using MPT 1343 dialling, radios using CPSX dialling can dis-
play the caller’s identity for interfleet and interprefix calls.

CTCSS CTCSS (continuous tone controlled squelch system) is a type of signalling 
used for segregating groups of users. CTCSS uses subaudible tones between 
67 and 250.3 Hz to identify a group of radio users.

CTCSS invalid 
confirmation 
delay

When an incoming CTCSS signal has been found to be valid but then 
degrades to the point where the radio can no longer accurately decode it, 
the radio continues to consider it valid for the duration of the CTCSS 
invalid confirmation delay. If once the delay has expired the signal still can-
not be accurately decoded, the signal is treated as invalid.

data codeword A data codeword is a 64-bit codeword that conforms to the requirements of 
MPT 1327 in which the first bit is set to 0. Data codewords are linked to 
an address codeword and supplement the information in the address code-
word.

DCS DCS (digital coded squelch) is a type of signalling used for segregating 
groups of users. DCS uses subaudible tones between 10 and 134 Hz to trans-
mit digital data to identify a group of radio users.

DCS codes take the form of a continuously repeating 23-bit digital code-
word that represents a user group. Codewords are identified by a three-digit 
octal number, which forms part of the codeword. The remainder of the 
codeword includes a sequence of bits derived mathematically from the 
three-digit code. 

When assigning DCS signalling for a channel, it is only necessary to specify 
the three-digit code. 

DCS polarity DCS signals are susceptible to polarity inversion at various points in the sig-
nal path from originator to recipient. On some systems, consistent inver-
sions can be compensated for by forcing the radio to decode the inverse of 
every codeword.

despatcher A despatcher is a person who gives official instructions by radio to a fleet.

despatcher 
callback request

A despatcher callback request is a call sent to the fleet’s despatcher. The des-
patcher will then call back the calling radio at a convenient time.

dialling scheme The dialling scheme determines how a radio user makes calls to other radios 
in and outside the fleet, groups of radios, PABX extensions and PSTN num-
bers. The dialling scheme is, simply put, the set of numbers a radio user can 
dial. 

Tait Orca radios support the following dialling schemes:
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� MPT 1343

� CPSX Dialling

� Nokia ANN

� ZVEI

� Number Presets

do not disturb Do not disturb allows the radio user to ignore incoming calls while still 
making outgoing calls as usual. Do not disturb can be activated by dialling 
*49# and can be deactivated by dialling #49#.

DTMF DTMF (dual tone multiple frequency) is the tone-based system used for the 
world’s telephone networks. A DTMF “tone” actually consists of a pair of 
tones. DTMF tones are sometimes referred to as “touch tones”.

Tait Orca radios can encode DTMF tones and so can make DTMF calls (see 
DTMF string), but cannot decode DTMF tones and so cannot receive 
DTMF calls.

DTMF signalling is often used for the transmission of telephone dialling 
information and may be used on systems authorised to operate with con-
nection to a PABX or a PSTN.

DTMF call See DTMF string.

DTMF 
overdialling

The DTMF overdialling feature allows the radio user to dial DTMF strings 
using the numeric keypad.

DTMF string A DTMF string is a series of DTMF tone pairs.

dynamic power 
control

Dynamic power control optimises the radio’s power use by reducing the 
transmit power in high signal strength areas.

emergency call An emergency call is a call that pre-empts other calls on the trunking system 
when there are no free channels. Emergency calls can have a different call 
time limit than normal calls.

ESN ESN stands for electronic serial number. This number is a unique identifier 
given to each radio unit by the manufacturer. Radio units may be validated 
by this number.

FFSK FFSK (fast frequency shift keying) is the signalling method employed in 
trunked radios. Data is represented by 1 cycle of 1200 Hz (logic 1) or 1.5 
cycles of 1800 Hz (logic 0) and is transmitted at 1200 baud.

fleet Each customer on a trunked network is assigned their own fleet. This keeps 
each customer unique so that their activities can be monitored and control-
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led separately from each other. Each radio unit on the network belongs to 
their associated customer’s fleet.

FOACSU FOACSU stands for full off-air call set up. In full off-air call setup, a traffic 
channel is not allocated for a call until the called party has answered.

frequency band The radio’s frequency band is the range of frequencies it is capable of trans-
mitting and receiving on.

The frequency band the radio operates on is set in the Specifications form.

function key Each radio has two function keys above the PTT key. Orca 5035 and Orca 
5040 radios have a third function key, which is the leftmost key in the row 
of four keys underneath the LCD display. This third function key can also 
have functions assigned to both short and long presses. 

These radio function keys can have functions assigned to both short and 
long keypresses. A short keypress is less than one second. The radio user 
may need to experiment to become familiar with the duration of short and 
long keypresses. The third function key on Orca 5035 and Orca 5040 radios 
can also be operated as a “shortcut” to up to three user function menu options. 

Some radio accessories also have function keys, and most of the options 
available for the radio function keys are also available for external function 
keys. However, these external function keys do not have short and long 
keypresses.

function key 
preset call

Tait Orca radios can have two function key preset calls defined at radio pro-
gramming time.

group Group refers to one or more radio units that are the recipient of a group call. 
In MPT 1327, each group is given a unique address, to which radio units 
subscribe to be part of that group. The maximum number of groups per-
mitted is dependent on the number entered in the fleet record. 

group call A group call is a call that involves more than two radios simultaneously. 
Group calls can only be heard by radios subscribed to the group. Group calls 
can be conference calls or broadcast calls.

GTC GTC stands for go to channel. A GTC message is sent by the control chan-
nel as part of the call setup procedure. The GTC tells the radio units 
involved in the call to switch to the traffic channel designated for the call.

handset micro-
phone

The handset microphone is the microphone at the bottom of the radio. 
When handset mode is active, the handset microphone operates.  The radio 
can also be programmed so that the handset microphone is the default 
microphone (User Selectable Parameters form).

handset 
operation

Tait Orca radios can be operated as a normal radio where the user holds the 
radio with the microphone about 15 cm away from the mouth or it can be 
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operated like a telephone handset. Handset mode is useful in noisy environ-
ments, when privacy is required or in quiet environments when the lowest 
volume setting seems too loud.

hunting Hunting is a procedure used by the radio unit to select an appropriate control 
channel to allow a session with a trunking system to be initiated or continued. 
The hunting process consists of systematic sampling of the forward channel 
frequencies by the radio unit until it selects and confirms one of the forward 
channels, which together with its paired return channel is an appropriate 
control channel.

Types of hunting include:

� background search

� comprehensive hunt

� normal hunt

� preferential hunt

� resuming hunt

� single channel hunt

� vote now

ident The ident is the part of the radio’s address that uniquely identifies that radio. 
In MPT 1327, radios are identified by a three-digit prefix and a four-digit 
ident. All radios in a fleet usually have the same prefix, but no two radios 
should have the same ident.

indicator Indicators provide feedback to the radio user on how the current operation 
is proceeding and on the operating state of the radio. Tait Orca radios use 
combinations of audible and visual indicators.

individual call An individual call is a call from one radio to another. Because individual 
calls take place on a traffic channel allocated specifically for that call, they can-
not be overheard by other radios in the fleet or on the same trunking network. 
Individual calls are the most common type of trunking call.

interfleet call An interfleet call is a call between two radio units that belong to different 
fleets.

interfleet group 
call

An interfleet group call is a group call in which participating radios belong to 
different fleets.

invalid activity Invalid activity is traffic on a channel that carries signalling that does not 
match that of the receiving radio.

keypad lock The keypad lock prevents accidental operation of the radio by locking the 
keypad so that only a certain set of keys can be used. 
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What keys are locked depends on how the radio was programmed (Keypad 
Lock Disables fields, Key Settings II tab).

keypress confi-
dence tones

Keypress confidence tones are a confidence indicator that tells the radio user 
whether or not an action is permitted whenever a keypad key or function 
key is pressed.

Keypress confidence tones are enabled in the User Selectable Parameters 
form.

label A label is a sequence of up to eight characters that can give the radio user 
additional information about the radio’s current state. For example, a label 
can be set that indicates the recipient of a preset call. 

last number 
redial

When an outgoing call is terminated, a radio can be preprogrammed to dis-
play the identity of the called party. If the radio user wishes to call that party 
again, they can do so by pressing the enter key.

LCD display Orca Excel, Orca 5035 and Orca 5040 radios have a 2 x 12 character LCD 
(liquid crystal) display. In combination with the radio’s LED indicator and 
audible indicators, the display provides the radio user with information on the 
state of the radio.

LED indicator The LED (light-emitting diode) at the top of the radio is the main indicator 
for displaying the state the radio is in. The audible indicators and the LCD 
display provide information intended to supplement that provided by the 
LED.

low power 
transmit

The low power transmit feature can be used to change the transmit power 
from the programmed level to low.

lone worker Lone worker is a feature in Orca 5030, Orca 5035 and Orca 5040 radios. 
When activated, the radio begins a pre-programmed inactivity timer. Once 
this time has counted down with no keypress (or motion detected if pro-
grammed), an audible alert will sound for the length of the warning timer. 
If no key is pressed in this time (or motion detected), then an emergency 
call is made to the Prime Emergency Number, or a call made to the SOS 
Call String.

The purpose is to get the radio user to press any key every specified period, 
to restart the inactivity timer. If no key is pressed, then it is an indication 
that the worker is incapacitated and an emergency call is automatically 
made.

Lone Worker options are set in the SOS Options form.

monitor When the radio is operating on conventional channels, monitor allows the 
radio user to override a channel’s signalling and so hear all traffic on a chan-
nel.

Note that monitor is not permitted in some countries.
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MPT 1327 MPT 1327 is a radio unit signalling standard published by the United King-
dom Department of Trade and Industry that describes the signalling stand-
ard for trunked private land mobile radio systems.

MPT 1343 MPT 1343 is a performance specification standard published by the United 
Kingdom Department of Trade and Industry that describes the system 
interface specification for radio equipment to be used with commercial 
trunking networks operating in Band III, sub-bands 1 and 2. 

MPT 1343 also refers to the set of numbers a radio user can dial (the dialling 
scheme).

mute A mute controls the circumstances under which a received signal is passed 
to the radio’s speaker. When a mute is active, the radio’s speaker only 
unmutes under certain conditions, determined by the type of signalling 
operating on a channel.

NDD NDD stands for network dependent data. NDD is an MPT 1343 term and 
is a means of identifying specific control channel transmissions that originates 
within a network.

network A network is a number of interconnected trunking systems.

night use When the night use feature is on, the radio’s backlighting activates whenever 
valid activity is detected, a key on the radio is pressed or when the radio 
receives a call. Backlighting remains on for the duration of the backlighting 
timer unless further activity is detected.

Nokia ANN Nokia ANN (Algorithmic Network Numbering) is a dialling scheme 
designed for use on Nokia Actionet networks. It differs from MPT 1343 in 
the way it divides up fleets. Nokia ANN numbering reduces the number of 
digits that must be dialled for calls between fleets.

normal hunt A normal hunt is carried out as part of the control channel acquisition proce-
dure. A normal hunt covers all channel numbers likely to be used as control 
channels on the selected network. For a normal hunt, the radio will undergo 
registration on a new control channel, if necessary.

The channels that will be searched as part of the normal hunt procedure are 
defined in the Normal Hunt Channels array (Hunting Parameters form). If 
the radio fails to find a suitable control channel among these channels, it 
will, if programmed, carry out a comprehensive hunt.

number presets Number presets is a dialling scheme based on the MPT 1343 dialling scheme. 
Number presets, however, limits the calls a radio can make to those pro-
grammed as preset calls at radio programming time. The calls programmed 
can be any number the radio user would normally be able to dial using MPT 
1343 numbering.
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off-air The term off-air is used to describe the call setup procedure used when the 
channels are setup and allocated even though the called party has not yet 
answered. This usually occurs when it is known that the called party is avail-
able.

on/off/volume 
control

The on/off/volume control is the smaller of the two switches on the top of 
each radio.

Orca 5030

16-Way Selector

On/Off/Volume 
Control

Handset Microphone

PTT Key

Function 
Keys 1 
and 2

LED 
Indicator
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Orca 5035

Orca 5040

Orca Elan

16-Way Selector

On/Off/Volume 
Control

Handset Microphone

PTT Key

Function 
Keys 1 
and 2

Speaker/
Microphone

LED 
Indicator

Display

Keypad
Function 
Key 3

16-Way Selector

On/Off/Volume 
Control

Handset Microphone

PTT Key

Function 
Keys 1 
and 2

Speaker/
Microphone

LED 
Indicator

Display

Keypad

Function 
Key 3
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Orca Excel

PABX PABX stands for private automatic branch exchange. A trunking system can 
be connected to a PABX and so radios using that system can make calls to 
and receive calls from PABX extensions.

PABX extension A PABX extension is a line on a PABX system.

16-Way Selector

On/Off/Volume 
Control

Handset Microphone

PTT 
Key

Function 
Keys

Speaker/
Microphone

LED 
Indicator

16-Way Selector

On/Off/Volume 
Control

Handset Microphone

PTT Key

Function 
Keys Speaker/

Microphone

LED 
Indicator

Display

Keypad
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power-up 
message

The power-up message is the message displayed after the radio is turned on. 

The power-up message is programmable (Short Data Messages Form fields, 
User Selectable Parameters form).

preferential 
hunt

A preferential hunt is carried out as part of the control channel acquisition pro-
cedure. A preferential hunt covers all channel numbers likely to be used as 
control channels on the selected network. For a preferential hunt, the radio will 
only acquire a control channel for which a preference exists. 

Preference data is defined in the Acquisition Data form.

prefix In MPT 1327, radios are identified by a three-digit prefix and a four-digit 
ident. Radio units in a fleet usually have the same prefix.

preset call A preset call is a call sequence defined at radio programming time. 

priority call A priority call is a call that pre-empts other calls on the trunking system when 
there are no free channels. Priority calls do not, however, pre-empt emer-
gency calls.

programming 
database

The programming database is the information that is altered using the 
Trunked Programming Application. Each programming database consists 
of separate network, fleet and radio information. When the Radio>Read 
command is selected, the radio’s programming database is read and the 
information in it is loaded into the fields and forms in the programming 
application. When the Radio>Program command is selected, the radio’s 
programming database is overwritten with the information altered in the 
programming application.

PSTN PSTN stands for public switched telephone network, the public telephone 
network on which subscribers own or rent tethered communications 
devices (telephones, facsimiles, modems) as opposed to untethered commu-
nications devices (radio telephones, cellular phones). A trunking system can 
be connected to the PSTN and so radios using that system can make calls 
to and receive calls from PSTN numbers.

PTT key The PTT (press-to-talk) key is the key pressed to transmit. The radio can-
not receive while the PTT is pressed.

PTT as shift key The PTT as shift key feature is part of the DTMF overdialling feature. If the 
user wishes to dial tones A to D or a pause, the PTT can be used as a “shift” 
key in conjunction with the numeric keypad. For example, on the Orca 
Excel:

PTT +  = A

PTT +  = B

PTT +  = C

PTT +  = D
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PTT +  = pause

So pressing the PTT key, holding it, then pressing the  key enters tone 
A in the DTMF string. Pressing the PTT, holding it, and then pressing the 

 key enters a pause in the string. A hyphen is entered in the display to 
indicate the pause.

PTT as shift key is enabled in the DTMF Parameters form.

quiet state Quiet state is the state the radio is in when monitor is inactive, and the radio 
user does not have to listen to traffic that is not intended for them.

radio identity Each radio operating on a trunking system is assigned its own unique identity. 
How that identity is assigned depends on the dialling scheme. In MPT 1327, 
a radio’s identity is made up of a three-digit prefix and a four-digit ident.

receive (Rx) 
frequency

The receive frequency is the frequency that a radio is currently tuned to.

The receive frequency for each channel is set in the Trunked Channel 
Blocks form and the Conventional Channels form.

receive 
signalling

The receive signalling is the signalling that must accompany incoming trans-
missions in order for the radio to recognise the signal as valid and so open 
the radio’s mute.

The receive signalling for each channel is set in the Conventional Channels 
form.

registration A radio unit must let the trunking system know its current location, especially 
if the radio unit roams throughout the network. Knowledge of its location 
allows for an efficient call setup process when the radio unit is called. A 
radio unit will attempt to register if the area code of the new site’s system 
identity code is different to that of the previous site.

repeater A repeater receives a radio signal and retransmits it. Use of a repeater 
increases the coverage area of a two-way radio system and ensures more 
reliable performance in areas where signals are reflected or attenuated by 
buildings or terrain.

In a repeater-based system, the radio’s transmit frequency is the frequency 
the repeater is listening on, and the radio’s receive frequency is the fre-
quency the repeater rebroadcasts signals on.

resuming hunt A resuming hunt is carried out as part of the control channel acquisition proce-
dure. When a call is cleared down and a radio leaves a traffic channel, a resum-
ing hunt allows the radio to resume the control channel on which it was last 
confirmed prior to going to the traffic channel.

reverse tone 
burst

Reverse tone bursts can be used when CTCSS subaudible signalling is used. 
When reverse tone bursts are enabled, the phase of the generated tones is 
reversed for a number of cycles just before transmission ceases, which can 
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increase the speed of receiver shutdown in some repeaters and associated 
equipment.

The reverse tone burst duration is set in the Conventional Channels form.

roaming When a radio unit moves around the network, it reaches a point where the 
signal strength is approaching the preprogrammed lower limit. At this point 
it will automatically search for a better signal. Once it has received a suitable 
signal from a valid site, it will register on the new site.

RSSI indicator The bars on the display ( ) indicate the received signal strength (RSSI), 
which is displayed whenever the radio is idle. If signal strength is low, calls 
may not get through.

RU RU stands for radio unit.

Rx Rx is an abbreviation for receive.

SDM A short data message is a message that carries more data than a status message 
but still does not require an audio channel. The user data is contained in the 
signalling between the site and the radio unit. 

Orca Excel, Orca 5035 and Orca 5040 radios can display received SDMs on 
the radio display. Orca 5035 and Orca 5040 radios can view, edit and send 
SDM Presets via the user defined menu. 

SDM entry mode SDM entry mode is the mode in which short data messages are received and 
sent.

security PIN A security PIN (personal identification number) is a number up to five dig-
its long the user is required to enter when the radio first powers up. When 
a security PIN is required, the radio displays the message ENTER CODE 
and then waits for the correct PIN to be entered before displaying the 
power-up message.The radio cannot be used until the correct PIN has been 
entered.

The security PIN is set in the  Specifications form.

Selcall Selcall stands for “selective calling”, which is a signalling system that uses 
sequences of audible tones to isolate calls intended for specific radios. 

selective scan Selective Scan is a feature for Orca 5030, 5035 and 5040 radios. It enables 
a number of groups (scan group) to be selected and collectively scanned for 
activity. The selective scan group must be added to a preset call using a call 
string of ***1 to ***4, and cannot be dialled directly from the keypad. 
Each of the 4 scan groups can contain from 2 to 16 groups.

Selective scan groups are set in the Radio Identity and Selective Scan forms.
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short form 
numbers

Short form numbers are numbers that allows radio unit users to access 
PSTN numbers without having to enter the whole number. Each radio unit 
can be associated with a PABX/PSTN table that specifies up to 15 short 
form numbers for that radio unit.

signalling Signalling is non-voice coding on a channel for the purpose of identifying 
parties and segregating groups of users. If a radio receives signalling that 
matches that programmed for the radio, the signalling is said to be valid and 
the radio’s mute opens. Otherwise, the transmission is ignored and the radio 
remains silent, although the radio’s channel busy indicator is activated. See 
CTCSS and DCS.

single channel 
hunt

A single channel hunt is carried out as part of the control channel acquisition 
procedure. A single channel hunt occurs when the trunking system controller 
directs a radio to a specific control channel.

site A site consists of a control unit, a control channel and one or more traffic chan-
nels. A number of connected sites make up a trunking system.

site select The site select feature allows the radio user to specify the control channel the 
radio must acquire. The site select feature overrides the radio’s normal acqui-
sition processes.

SOS call An SOS call can be assigned to a function key or assigned automatically to 
the lone worker feature. When an SOS call is initiated, the radio sends a call 
to a pre-programmed call string, and cycles between receiving and trans-
mitting so that the called party can hear activity near the radio and so decide 
how to respond. The radio can be programmed so that all indicators remain 
unchanged when sending the SOS call and when cycling between Tx and 
Rx mode. 

SOS mode will always end when the radio is turned off then on again. If 
Silent SOS Calls is unchecked, SOS mode will also end when the Call Time 
Limit is reached.

If an SOS Call is initiated in conventional mode, then the radio will revert 
to trunked mode to make the call, and remain in trunked mode when the 
SOS call has ended.

SOS call options are set in the SOS Options form. 

squelch The squelch feature ensures that the radio’s speaker only unmutes when an 
intelligible signal is received. A signal is considered intelligible when it is 
strong enough to exceed a predetermined squelch threshold.

squelch override Squelch override allows the user to disable the radio’s squelch and so hear all 
activity on a channel, including noise.
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squelch 
threshold

The squelch threshold is the level the signal must reach before it is regarded 
as intelligible and the radio’s mute is opened. Tait Orca radios can operate 
at two different squelch thresholds: city and country squelch.

status Status is the current activity of the radio user, which can be represented by 
a status message.

status label A status label is a label that is associated with a particular status message.

If a receiving radio has been programmed with a status label that corre-
sponds to the message transmitted, it displays that label, which is why it is 
important that all radios in a fleet are programmed with the  same status 
labels.

status message A status message is a short signalling message that carries only a number 
between 1 and 30. Because of the brevity of the message, no audio channel 
is used. All the required information can be transferred in the signalling 
between the network and the radio unit.

stun and revive A “stun” message can be sent from the network to a radio and will render 
the radio inoperable. The radio remains in communication with the trunk-
ing system controller but cannot be used to send or receive calls. A “revive” 
message sent by the network will return the radio to normal operation.

subaudible 
signalling

Subaudible signalling is signalling that is at the bottom end of the range of  
audible frequencies. Tait Orca radios support CTCSS and DCS subaudible 
signalling.

SYNC In MPT 1327 and MPT 1343, SYNC refers to the control channel codeword 
synchronisation sequence.

SYS In MPT 1327 and MPT 1343, SYS refers to the system identity code of the 
transmitting system. Values of SYS which result in the production of the 
control channel codeword synchronisation sequence, SYNC, in any part of 
the 48 information bits of the CCSC are not permitted.

time-out Time-out is when a time limit has been reached and the active call is ter-
minated as a result.

toggle The term toggle is used to describe the switching between two states.

tone A tone is a sound wave of a particular frequency.

For CTCSS and DCS, the tone is transmitted continuously as long as the 
radio is transmitting. For DTMF strings, the transmit time of each tone is 
programmable (see tone duration).
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When defining DTMF strings, the different tones are represented by the 
characters 0-9, A-D, * and #. The frequencies used are determined by an 
internationally accepted standard.

tone duration The tone duration is how long a DTMF tone is transmitted. Tone duration 
is set in the DTMF Parameters form.

tone set The tone set is the set of confidence indicators a radio will use.

traffic Traffic is an intelligible signal on a channel that exceeds the radio’s squelch 
threshold.

traffic channel The traffic channel is the channel on a trunking system to which parties par-
ticipating in a call are directed for the duration of the call. When the call 
ends, the traffic channel is returned to the pool of channels for use in a new 
call.

transmit (Tx) 
frequency

The transmit frequency is the frequency that all outgoing transmissions are 
made on.

The transmit frequency for each channel is set in the Trunked Channel 
Blocks form and the Conventional Channels form.

transmit inhibit The transmit inhibit feature determines under what conditions a press of the 
PTT results in the radio not transmitting.

The radio can be prevented from transmitting whenever there is activity on 
the channel, whether it is valid or invalid (Busy option), or invalid activity 
only (Mute option). Note that if the Mute option is selected and the radio 
user has activated monitor, the radio transmits when the PTT is pressed, even 
if there is valid activity on the channel. The conditions under which trans-
mission is inhibited during conventional channel operation are set in the Con-
ventional Channels form (Tx Inhibit On Busy field).

transmit 
signalling

The transmit signalling is the signalling that accompanies all outgoing trans-
missions made.

The transmit signalling for each channel is set in the Conventional Channels 
form.

transmit timer The transmit timer determines the longest continuous transmission permit-
ted by a radio. When the transmit timer expires, the radio emits a series of 
warning tones before returning to the receive state.

trunked channel 
block

A trunked channel block is a set of equally spaced channels on which a 
trunking system operates.

trunking Trunking is a radio communications system that dynamically shares a 
number of communications channels among a large number of users. This 
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ensures equal channel loading and permits significantly higher loading per 
channel than found in conventional systems.

trunking system The term trunking system refers to the equipment required to provide the 
trunking communication facilities at one location.

TSC See trunking system controller.

trunking system 
controller

In MPT 1327 the trunking system controller (TSC) is the central intelli-
gence necessary to enable the trunking system to function. The TSC com-
municates with all radios on the network via the control channel.

Tx Tx is an abbreviation for transmit.

user function 
menu entry 
mode

User function menu entry mode is available on Orca 5035 and Orca 5040 
radios.

In user function menu entry mode, the user can customise radio options. 
For Orca 5030 and Orca 5040 radios, the user defined menu is set up in the 
User Defined Menu Form.

valid activity Valid activity is traffic on a channel that carries signalling that matches that 
programmed for the receiving radio. The radio’s mute opens upon detecting 
valid activity.

vote now Vote now is carried out as part of the control channel acquisition procedure. 
Some trunking systems use a vote now BCAST codeword to help the radio 
find the best control channel. When the radio receives a vote now BCAST 
codeword, the radio will switch to the channel specified by the system and 
monitor its RSSI level. If the RSSI on the new channel is not greater than 
the current control channel by a particular value, the radio will return to 
the current control channel. Otherwise it will switch to the control channel 
specified by the trunking system.

ZVEI ZVEI is a dialling scheme based on the MPT 1343 dialling scheme. The 
ZVEI dialling scheme is used on Regionet 43 networks.
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